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Classification of Safety-Related Notices

> P

This manual contains notices which you should observe to ensure your own perso-
nal safety, as well as to protect the product and connected equipment. These noti-
ces are highlighted in the manual by a warning triangle and are marked as follows

according to the level of danger:

Danger

indicates that death or severe personal injury will result if proper precautions are
not taken.

Warning

indicates that death or severe personal injury can result if proper precautions are
not taken.

Caution

with warning triangle indicates that minor personal injury can result if proper
precautions are not taken.

Caution

without warning triangle indicates that damage to property can result if proper
precautions are not taken.

Notice

indicates that an undesirable result or status can result if the relevant notice is
ignored.

Note

highlights important information on the product, using the product, or part of the
documentation that is of particular importance and that will be of benefit to the
user.
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Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of
SIEMENS AG.

Third parties using for their own purposes any other names in this document which
refer to trademarks might infringe upon the rights of the trademark owners.

Safety Instructions Regarding your Product:
Before you use the product described here, read the safety instructions below tho-
roughly.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment.
Qualified persons are defined as persons who are authorized to commission, to
ground, and to tag circuits, equipment, and systems in accordance with establis-
hed safety practices and standards.

Correct Usage of Hardware Products
Note the following:

ii Warning
This device and its components may only be used for the applications described in
the catalog or the technical description, and only in connection with devices or
components from other manufacturers which have been approved or
recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set
up, and installed correctly, and operated and maintained as recommended.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.

EU Directive: Do not start up until you have established that the machine on which
you intend to run this component complies with the directive 89/392/EEC.

Correct Usage of Software Products
Note the following:

ii Warning
This software may only be used for the applications described in the catalog or the
technical description, and only in connection with software products, devices, or
components from other manufacturers which have been approved or
recommended by Siemens.

Before you use the supplied sample programs or programs you have written
yourself, make certain that no injury to persons nor damage to equipment can
result in your plant or process.
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Prior to Startup
Prior to startup, note the following:

Caution

Prior to startup, note the information and follow the instructions in the latest docu-
mentation. You will find the ordering data for this documentation in the relevant
catalogs or contact your local Siemens office.

Copyright © Siemens AG 2001-2009 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for
damages. Al rights, including rights created by patent grant or registration of
a utility model or design, are reserved.

Siemens AG

Industry Automation

Industrial Communication

Postfach 4848, 90327 Nirnberg Germany

Disclaimer of Liability

We have checked the contents of this manual for agreement with the hard-
ware and software described. Since deviations cannot be precluded entirely,
we cannot guarantee full agreement. However, the data in this manual are
reviewed regularly and any necessary corrections included in subsequent
editions. Suggestions for improvement are welcomed.

Technical data subject to change.

Siemens Aktiengesellschaft
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This manual...

... supports you when commissioning your SIMATIC NET CP modules in an S7
station.

... supports you so that your applications can communicate successfully and
efficiently over the SIMATIC NET CPs.

... in tandem with the “Primer” description, provides you with all the information you
require to implement your communications tasks:

Description Manual

“Primer”
Operating S7 CPs with
NCM §7 » Part A

* CP overviews

* Communication services
* Network attachment

* Configuration

* Program interface

* Familiarization « Diagnostics
¢ Testing interfaces « Learning from the
example

* Commissioning
Installation / Part B
commissioning » e Characteristics

® Operator controls/
displays

® Operating instructions

* Technical specifications

The examples described in “Primer” can also be found in the project folder for
sample programs after you have installed STEP 7.

S7-CPs for PROFIBUS Configuring and Commissioning
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This manual...

Audience

This manual is intended for installation personnel, programmers of STEP 7
programs and service personnel.

Scope of this Manual

This manual applies to version V5.1 SP2 and higher of the STEP 7 configuration
software.

This manual is valid for the product versions of the SIMATIC NET PROFIBUS CPs
with the following order numbers:

e CP 342-5/342-5 FO:

- 6 GK7 342-5DA03-0XEQ

- 6 GK7 342-5DA02-0XEQ

- 6 GK7 342-5DF00-0XEQ
e CP 343-5:

- 6 GK7 343-5FA01-0XEO
e CP 443-5 Basic:

- 6 GK7 443-5FX02-0XEQ
e CP 443-5 Extended:

- 6 GK7 443-5DX04-0XEQ

Notice

If functions are described that require higher versions, this is indicated by an addi-
tional icon.

Example:

S7-CPs for PROFIBUS Configuring and Commissioning
A-6 Release 09/2011
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This manual...

New in this version
This version of the manual contains additional information and corrections.
e CP342-5
New version of the module: 6GK7 342-5DA03-0XEO
¢ Description of DP operation with S7-300

As of this release, the sections of the manual relating to DP operation, take into
account only the functionality according to the range of validity above.

e Description of initialization for DP master mode, see Section 4.7

o Effect of initialization of the DP master when reading out the DP station list; see
Section 5.3.2

* Reference to entries on the Internet were updated where necessary.

Notice

Please note that the availability of new functions depends on the device type you
are using. You can check which functions your module supports in the description
in the Properties dialog of the module in STEP 7 and in the catalog in HW Config.

S7-CPs for PROFIBUS Configuring and Commissioning
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This manual...

The Documentation in the “S7-CPs / NCM S7” Documentation Package and on

the Internet

The following table provides you with an overview of the content and the
addresses for downloading from the Web.

Title

Content / Web Addresses

Configuring and
Commissioning S7-CPs
for PROFIBUS

Configuration Manual
Part A

Configuring and
Commissioning S7-CPs
for PROFIBUS

Manual Part B

This is available on the Web at:

* General part:

http://support.automation.siemens.com/WW/view/en/1158693

Device descriptions:

® (CP 342-5/342-5 FO:
http://support.automation.

e CP 343-5:
http://support.automation.

* CP 443-5 Basic:
http://support.automation.

® (CP 443-5 Extended:
http://support.automation.

siemens.com/WW/view/en/8773570

siemens.com/WW/view/en/8778841

siemens.com/WW/view/en/8776422

siemens.com/WW/view/en/8777196

Functions (FC) and
Function Blocks (FB) for
SIMATIC NET S7 CPs

Programming manual

This is available on the Web at:
http://support.automation.siemens.com/WW/view/en/30564821

NCM S7 for
PROFIBUS/FMS

This is available on the Web at:
http://support.automation.siemens.com/WW/view/en/1158418

NCM S7 for SIMATIC

This is available on the Web at:

NET S7-CPs http://support.automation.siemens.com/WW/view/en/1157760
Primer
Gateways * |E/PB Link:

http://support.automation.siemens.com/WW/view/en/7851748

* |E/PB Link PN 10:
http://support.automation.siemens.com/WW/view/en/19299692

* |WLAN/PB Link PN 10:
http://support.automation.siemens.com/WW/view/en/21379908

Commissioning PC
Stations

Manual and Quick Start

The manual supports you and helps you to make efficient use of
communications with your PC applications in conjunction with the SIMATIC
NET modules. It shows you how to configure PC modules and the steps
required in project engineering with NCM S7.

This is available on the Web at:
http://support.automation.siemens.com/WW/view//en/13542666

S7-CPs for PROFIBUS Configuring and Commissioning
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This manual...

CP documentation in the Manual Collection (order no. ASE00069051)

o i The SIMATIC NET Manual Collection ships with each S7-CP. This DVD is
S updated at regular intervals and contains the latest device manuals and
t descriptions available at the time the DVD was written.

Version History/Current Downloads for the SIMATIC NET S7-CPs

In the “Version History/Current Downloads for the SIMATIC NET S7-CPs”, you will
find information on all previously available CPs for SIMATIC S7 (Ind. Ethernet,
PROFIBUS and IE/PB-Link).

You will find the latest release of these documents at:

-
-
=
=

http://support.automation.siemens.com/WW/view/en/9836605

Information on the Current Block Versions (FCs/FBs)

For new user programs, please make sure that you use the latest block versions.
You will find information on the current block versions and the current blocks to
download from the Internet at:

http://support.automation.siemens.com/WW/view/en/8797900

If you require replacements, please follow the instructions in the device-specific
Part B of this manual.

SIMATIC NET Quick Start CD: Samples Covering all Aspects of Communication

The Quick Start CD that can be ordered separately is a treasure-trove of
sample programs and configurations.

You can order this directly over the Internet at:

http://support.automation.siemens.com/WW/view/en/21827955

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-9
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This manual...

Additional Information on SIMATIC S7 and STEP 7

The additional documentation on the basic software STEP 7 of the SIMATIC
programmable controllers is included in electronic format in your STEP 7
installation.

You will also find information on SIMATIC programmable controllers on the Quick
Start CD and from the Customer Support Online services at:

http://www.automation.siemens.com/net/index 00.htm

(General information

or

http://support.automation.siemens.com/WW/view/en

(Product information and downloads)

Symbols Used in this Manual

This symbol indicates functions requiring STEP 7 version V5.2.

This symbol appears in the margin to draw your attention to useful tips.

This symbol indicates recommended documentation.

Where you see this symbol, you should also refer to additional information in the
basic help system of STEP 7.

This symbol indicates where detailed context-sensitive help is available. You can
display these help texts with the F1 key or by clicking on the “Help” button in the
relevant dialog.

Conventions

References to other manuals and documentation are indicated by numbers in
slashes /.../. These numbers refer to the titles of manuals listed in the References
section of the Appendix.

S7-CPs for PROFIBUS Configuring and Commissioning
A-10 Release 09/2011
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This manual...

SIMATIC NET glossary

Explanations of the specialist terms used in this documentation can be found in the
SIMATIC NET glossary.

You will find the SIMATIC NET glossary here:

e SIMATIC NET Manual DVD
The DVD ships with most SIMATIC NET products.

¢ On the Internet under the following entry ID:

http://support.automation.siemens.com/WW/view/en/50305045

S7-CPs for PROFIBUS Configuring and Commissioning
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1

Communication via PROFIBUS CPs in S7
Stations

The PROFIBUS CPs for SIMATIC S7 (simply known as PROFIBUS CP) provide a
series of communications services for different tasks.

This chapter explains the following:
¢ The types of communication possible with a PROFIBUS CP on PROFIBUS
¢ The tasks handled by the PROFIBUS CP for the various services

¢ How to create the conditions for your communications requirements

You will find further information in the following sources:

¢ When installing the PROFIBUS CP, please refer to the instructions in the
documentation /2/ supplied with the PROFIBUS CP. This also contains further
information about the performance of the PROFIBUS CP.

¢ For the functions and use of the STEP 7 configuration software, some of which

is used to configure the CP (such as hardware configuration), please refer to /9/
and /10/

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011
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1 Communication via PROFIBUS CPs in S7 Stations

1.1 PROFIBUS

Definition

PROFIBUS is the network for the cell and field area in the open, heterogeneous
SIMATIC NET communications system.

Physically, PROFIBUS is an electrical network based on a shielded twisted pair or
an optical network using fiber optic cable.

Standardized Transmission

The PROFIBUS network corresponds to the European Process and Fieldbus
standard PROFIBUS EN 50170 Vol. 2.

All-Round Communication in the Industrial Sector

PROFIBUS is integrated in the SIMATIC NET concept that allows comprehensive
networking of the management, cell and field levels along with Industrial Ethernet
and the AS-Interface (AS-i).

Ethernet
(ETHERNET,
IEEE 802.3)

PROFIBUS
(EN 50170, PROFIBUS, Vol. 2)

AS-Interface
(AS-i, Actuator-Sensor Interface)

Figure 1-1 PROFIBUS in the SIMATIC NET Concept

Network Access Techniques
Network access in PROFIBUS uses the methods specified in EN 50170 Vol. 2.
e Token bus for access to the bus by active stations

e Master-slave for communication with passive stations

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-17
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1 Communication via PROFIBUS CPs in S7 Stations

1.2

1.2.1

SIMATIC S7 Communication With a PROFIBUS CP

Type of Communication

The PROFIBUS CP supports the following types of communication (depending on
the CP being used):

PROFIBUS C
%
S7/M7-400 |
: ! S7-300
i

Interfaces / Services /

Possible types of communication Protocols
PG/OP communication OVET
$7 communication - S7 Protocol (Application Layer)
S5-compatible communication with the SEND / RECEIVE interface over
- FDL layer
Standard communication over the FMS interface
DP mode alternatively in the

- DP master mode
or
- DP slave mode (with S7-300)

¢ PG/OP communication

PG/OP communication is used to download programs and configuration data,
to run tests and diagnostic functions, and to control and monitor a plant from
OPs.

¢ S7 communication

The S7 communication forms a simple and efficient interface between SIMATIC
S7 stations and PGs/PCs using communication function blocks.

e S5-compatible Communication (SEND/RECEIVE Interface)

The SEND/RECEIVE interface allows program-controlled communication on a
configured connection from a SIMATIC S7 PLC to another SIMATIC S7 PLC, a
SIMATIC S5 PLC and to PCs/PGs.

S7-CPs for PROFIBUS Configuring and Commissioning
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1 Communication via PROFIBUS CPs in S7 Stations

e Standard Communication (FMS Interface)
(complying with EN 50170 Vol. 2 /14/; FMS Client and Server Function)

The FMS interface allows the program-controlled, neutral transmission of
structured data over a configured connection from SIMATIC S7 PLCs to
devices that support the FMS protocol (for more detailed information, refer
to Volume 2 of this manual).

« PROFIBUS DP
(complying with EN 50170 Vol. 2 /14/; DP Master or DP Slave)

The distributed peripheral I/Os (DP) allow you to use a large number of analog
and digital input/output modules in the immediate vicinity of the process in a
distributed configuration.

1.2.2 The Communication Services of the PROFIBUS CPs

Depending on the module type, the S7-CPs support the following communication

options:
Programmable Controller Functions Supported
Module PG/OP S7 S5- Standard DP Mode
comp. (FMS) Master | Slave
S7/C7-300 CP 342-5 o o () o) @)
CP 342-5 FO [ J [ ) [ ) [ ) [ )
-DUD[ ) )
CP 343-5 [ ) [ ) ] ]
S7-400/S7-400H CP 443-5 o o o ]
u ] BaS|C
I CP 443-5 [ [ [ [ ]
Extended

1) DP mode: either DP master or DP slave
2) DP mode: DPV1

S7-CPs for PROFIBUS Configuring and Commissioning
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1 Communication via PROFIBUS CPs in S7 Stations

Possibilities for Communication between Device Types

The following table shows the communication options between the device types
with the various types of communication:

S5-115U to -155U/H PC
S7-300 u O | II I Field device
= N
| | M | | |
- S5-95U/DP Master —_
S5-95U/DP Slave
S7 communication?) S7 communication S5-95U with PROFIBUS PG/OP DP PROTOCOL
interface: communication 1)
SEND/RECEIVE SEND/RECEIVE SEND/RECEIVE 7 el FMS PROTOCOL
ABFOCTL FMS PROTOCOL $5-95U/DP master/slave: FMS PROTOCOL
S7-300 DP PROTOCOL
= DP PROTOCOL DP PROTOCOL 0TOCO SEND/RECEIVE
$5-115U to -155U/H:
[ | SEND/RECEIVE DP PROTOCOL
DP PROTOCOL
FMS PROTOCOL
S7 communication S7 communication S5-95U with PROFIBUS PG/OP DP PROTOCOL
interface: communication 1)
FMS PROTOCOL FMS PROTOCOL SEND/RECEIVE S7 communication?) FMS PROTOCOL
FMS PROTOCOL
S7-400 SEND/RECEIVE SEND/RECEIVE S5-95U/DP master/slave:
AEEEEE .-
1 DP PROTOCOL
u DP PROTOCOL SEND/RECEIVE
| §5-115U to -155U/H: P FEOTEEEL
I 1 SEND/RECEIVE

1) PC only as client

DP PROTOCOL
FMS PROTOCOL

2) If you also want the S7-300 to be a client (possible with the CP 342-5), you will require communication blocks and a connection

configuration.
1.2.3 Configuration and Diagnostics
To connect and configure the PROFIBUS CP, you require the STEP 7 project
engineering software.
STEP S7 for PROFIBUS also provides a wide range of diagnostic functions for the
various types of communication.
S7-CPs for PROFIBUS Configuring and Commissioning
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1 Communication via PROFIBUS CPs in S7 Stations

1.3 PG/OP Communication on PROFIBUS

Application

PG/OP communication provides functions that are already integrated in every
SIMATIC S7/M7/C7 device.

A distinction must be made between the following two types of function:
¢ PG Operation
PG operation with STEP 7 PLCs on PROFIBUS means the following:
- You can use the complete range of functions of STEP 7 on PROFIBUS.

— You can use programming, diagnostic, operating and monitoring functions on
all modules in the SIMATIC S7 PLC via PROFIBUS.

e OP Operation

PG/OP communication on PROFIBUS allows the operation and monitoring of
all modules in a SIMATIC S7 PLC using operator interface systems (TD/OP).

The PROFIBUS CP acts as a “communications relay” that relays the PG/OP
communication via PROFIBUS.

Operator
interface

oooooooo
oooooooo - O

MPI

S7 - 400

Z PROFIBUS

PROFIBUS CP

Figure 1-2  Configuration for PG/OP Operation
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1 Communication via PROFIBUS CPs in S7 Stations

1.3.1 PG Communication with STEP 7 over PROFIBUS

Requirements for PG Communication
PG communication is possible when the following requirements are met:
e« A PROFIBUS CP must be installed in the PG.

e The CPs in the S7 stations have a PROFIBUS address (node initialization -
see Section 3.3.8).

Networking the PG / Engineering Station

Depending on the configuration of the PG or Engineering Station, the following two
situations are possible when using PG communication:

e PG/ Engineering Station in the Configured Mode

If you select this configuration when you commission the PG / engineering
station, the interfaces of the communication modules you are using are already
known. The option in “Set PG/PC Interface” is automatically set to
“PC-internal’”.

Once you have downloaded this configuration to your PG / engineering station,
you can exchange PG functions with the accessible nodes in the network with
STEP 7 without requiring any further settings.

e PG / Engineering Station in PG Operation

If your PG or engineering station is configured for this mode, you must specify the
interface on the PG or engineering station explicitly with “Set PG/PC Interface”.

Follow the steps outlined below:
1. Open the “Set PG/PC Interface” dialog box in the Windows Control Panel.

2. Set the PG/PC interface according to the CPs available on your PG and
according to the bus attachment (interface parameter assignment used).

For more detailed information on the topic of PG operation and engineering station,
refer to /7/.
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1 Communication via PROFIBUS CPs in S7 Stations

1.3.2 OP Operation: Connecting Operator Interface Devices via
PROFIBUS

Requirements

Operation allowing operator interface functions is possible when the following
conditions are met:

A PROFIBUS CP is installed in the operator interface device.

e The CPs in the S7 stations have a PROFIBUS address (node initialization -
see Section 3.3.8).

Procedure

To use the S7 communication, you address the required module in the SIMATIC
S7 PLC from your operator interface device. For more detailed information, refer to
the description of your operator interface device.
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1 Communication via PROFIBUS CPs in S7 Stations

14 S7 Communication on PROFIBUS

Application

S7 communication via PROFIBUS allows program-controlled communication using
communication SFBs/FBs and configured S7 connections. Per job, up to 64
Kbytes of user data can be transmitted.

The CP acts as an “S7 communications relay” that relays the communications
functions via PROFIBUS

From the perspective of the user, S7 communication is identical over PROFIBUS
and Industrial Ethernet.

Stations

Two situations must be distinguished depending on device type and plant
configuration:

¢ Client and server functionality at both ends (S7 connections configured
at both ends)

S7 connections can be operated between the following nodes with the entire
functionality of S7 communication:

- between S7-300 and S7-400 S7 stations (and also between each other);
- between S7 stations and PG/PC stations with a PROFIBUS CP.

S7 - 400

57 _ 300 <_PROFIBUS CP

M7

PROFIBUS
PUT / GET
BSEND / BRCV
USEND / URCV

" PG/PC with PROFIBUS CP
Figure 1-3  Nodes Communicating on S7 Connections over PROFIBUS
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1 Communication via PROFIBUS CPs in S7 Stations

¢ Client and server functionality at one end only (S7 connections
configured at one end)

In the following situations, write and read functions can be implemented with
PUT / GET on single-ended S7 connections:

- 87 communication with connectivity devices:

between PG/PC stations (client) and S7 stations if the PG/PC stations are
connected to a different subnet (PROFIBUS / Ethernet) via gateways (for
example, an IE/PB Link or PROFIBUS CPs in an S7 station); in this case,
S7 stations are servers.

S7 communication is possible over a gateway.

PROFIBUS CP S7 - 300
I D

PUT / GET

S7 - 400

u
{
I

PROFIBUS

PG/PC Station

1
IS

Ethernet |

IE/PB Link
PG/PC Station Simss

PROFIBUS

u

I[
1

Figure 1-4  PG/PC Station Communicates with S7 Stations on an Underlying PROFIBUS or Ethernet
Network via a Gateway

1 &

For more detailed information on the features supported by your PROFIBUS CP,
refer to the manual /2/.
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1 Communication via PROFIBUS CPs in S7 Stations

Configuring S7 Connections

Create S7 connections to use S7 communication for data exchange between two
SIMATIC S7 stations.

For more detailed information, refer to the STEP 7 Description /10/.

Interface in the User Program of the S7 Station
You use SFBs (for S7-400) and FBs (for S7-300) in the user program.

A-26

Block type 1) Client Server Described in
SFB/FB12 BSEND X - STEP 7
SFB/FB13 BRCV X Documentation /11/
SFB/FB15 PUT X -1
SFB/FB14 GET X -1
SFB/FB8 USEND X -
SFB/FB9 URCV - X
SFC / FC62 CONTROL (S7-400) / X x 2

C_CNTRL (S7-300)

1) you do not need to configure a connection on the server

2) for S7-300

Notice

Please remember the following points regarding data consistency in your user pro-

gram:

In the CPU of the S7 station, the read or written information is taken from the S7
user program into the operating system or copied from the operating system to the
S7 user program in blocks of 8 or 32 bytes (depending on the firmware version).

If information in the word or double-word format is located across such bounda-
ries, data inconsistency may arise during transmission using S7 communication!

For more detailed information, refer to the STEP 7 documentation /9/.
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1 Communication via PROFIBUS CPs in S7 Stations

Notes on S7 communication between PG/PC station and S7 station

Applications in a PG/PC station communicate with the S7 station over an OPC
interface or SAPI-S7 interface for operator intervention, monitoring and control.

The S7 stations use the integrated communication SFBs/FBs (client and server
functionality at both ends).

The following general requirements must be met by a PC/PG station for S7
communication:

¢ On the PC/PG:
- A PROFIBUS CP must be installed

— there is an interface for S7 communication installed: SOFTNET S7 for
PROFIBUS or S7-5613.

To use S7 communication with a SIMATIC S7 PLC from a PC, address the
required CPU module in the SIMATIC S7 PLC that you want to reach via the
PROFIBUS CP in your PC application.

S$7 communication over routers (one-ended client and server functionality)

It is possible to reach the S7 station from a PG/PC station that is attached to

' 2 another subnet. The subnets must be connected over a gateway such as the

*= IE/PB Link. An S7 station or a PC connected to both subnets can also serve as a
gateway.

In this configuration, the S7 station can only be addressed by the PG/PC station as
a communications server on S7 connections configured at one end.

The requirements for configuring the PG/PC station are identical to those for
operating in the same subnet (see above).

In this situation, configure a one-ended S7 connection to the S7 station in the
other subnet for the PG/PC station in STEP 7 NetPro. You can then access data in
the S7 station in your user program using the functions PUT or Write (writing) and
GET or Read (reading).
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1 Communication via PROFIBUS CPs in S7 Stations

1.5

S5-compatible Communication (SEND/RECEIVE
Interface)!

Application

Data transmission on a configured FDL connection is suitable for the transmission
of related blocks of data between two or more PROFIBUS stations.

The following must be distinguished:

Specified FDL connection
The communications nodes are specified by configuring connections.
Unspecified FDL connection (free layer 2 access)

The communications nodes are identified by address information in the
communication job of the user program. This means that up to 126 nodes can
be reached via one configured unspecified FDL connection providing they
support FDL connections.

Broadcast

All the nodes ready to receive broadcast messages can be reached on
PROFIBUS.

Multicast
All the nodes belonging to the multicast group can be reached on PROFIBUS.

SEND/RECEIVE Interface in the User Program

Data transfer is triggered by the user program. The interface to the user program in
the SIMATIC S7 is formed by special SIMATIC S7 blocks of the type FC
(functions).

1) The previous name of the SEND/RECEIVE interface on FDL connections was $5S5 connections

A-28
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1 Communication via PROFIBUS CPs in S7 Stations

Stations

FDL connections allow program-controlled communication on PROFIBUS between
a SIMATIC S7 PLC and the following:

» SIMATIC S7 PLC with PROFIBUS CP

* SIMATIC S5 PLC with PROFIBUS CP (for example CP 5430/31)
« SIMATIC S5-95U with PROFIBUS interface

e PC stations with PROFIBUS CP (for example CP 5613)

S7 - 400 S7 - 300

ROFIBUS CP.

H

(I J
PROFIBUS
=
o o0 [ ] o o0
NURVIRERY
0|0
RUANRNIAN
I | 1
SIMATIC S5 SIMATIC _

Figure 1-5  SIMATIC S7 PLC with Possible Communication Partners on FDL Connections
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1 Communication via PROFIBUS CPs in S7 Stations

1.6

PROFIBUS DP

Application

Method

Data transmission on PROFIBUS DP provides a standardized interface (EN 50170
Vol. 2) for the transfer of process input data and process output data between a
SIMATIC S7 PLC and field devices (DP slaves).

The data exchange on PROFIBUS DP is characterized by the fast cyclic data
exchange between the DP master and DP slaves.

The user program in the SIMATIC S7 PLC controls and monitors communication
over PROFIBUS-DP using special SIMATIC S7 blocks of the type FC (functions -
S7-300 only V). The FCs handle the following tasks:

e The transfer of process output data from a specified data area on the S7 CPU
to the field device

e The entry of process input data read from the field device into a specified data
area on the S7-CPU

¢ The handling of monitoring and diagnostic jobs

Stations in the DP System

According to the PROFIBUS DP standard (EN 50170 Vol. 2), a DP system
consists of the following stations:

e DP master (class 1)
A device in this function class handles the actual control task. It sends and
receives process input and output signals (for example SIMATIC S7-PLC with a
PROFIBUS CP, SIMATIC S5 PLC with a CP 5430/31).

e DP slave
This is a device in the field area that reads in or outputs process signals. The
devices can be modular (for example the Siemens ET 200 U) or compact (for
example the ET 200 B/C).

e DP master (class 2) — optional
This is a programming device, diagnostic unit, or management device that
provides diagnostic and service functions.

1) with an S7-400, there is direct I/O access and for special tasks there are SFCs.
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1 Communication via PROFIBUS CPs in S7 Stations

- PG/PC as
DP master S7 - 300 PROFIBUS CP
(class 1) A DP master (class 2)
PROFIBUS
[ »
e.g. e.g. e.g.

ET 200 B ET 200 C ET 200 M S5-95U/DP
sla DP slaves

) - | from other
o A

vendor

1...1

DP slaves
according to the
DP standard

Figure 1-6  PROFIBUS DP System with Possible DP Slaves from Siemens or other Vendors

DP Modes with the PROFIBUS CP in an S7-300

The PROFIBUS CP in an S7-300 station can be operated in one of the two
following modes:

e DP master mode
PROFIBUS DP allows the attachment of all PROFIBUS DP nodes (for
example, ET 200) to the S7-300. The PROFIBUS CP functions as the DP
master.

e DP slave mode
With the PROFIBUS CP functioning as a slave, the SIMATIC S7-300 can be
operated as an intelligent slave station, for example belonging to a SIMATIC S5
control system or with a different DP master.

/0 Systems from Siemens
Depending on the area of application, various versions of I/O devices are available.

You will find more detailed information on the devices currently available in the
SIMATIC ET 200 family, the areas of application, and possible attachments in the
catalog IK PI.
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1 Communication via PROFIBUS CPs in S7 Stations

1.6.1 Network Configuration with One DP Master

Characteristics

In a network configuration with one master, one DP master (active station) and no
further active station can be operated on the PROFIBUS.

Network Configuration

The following diagram illustrates a possible network configuration with one
PROFIBUS CP as the DP master.

S7 - 300 C_pRroFIBUS CP

DP master =
(class 1) |
23

PROFIBUS

DP Slave

l...l

Process inputs/outputs

Figure 1-7  Bus Configuration with one PROFIBUS CP as DP master
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1 Communication via PROFIBUS CPs in S7 Stations

1.6.2 DP Multimaster Network Configuration

Characteristics

A multimaster configuration with DP masters means the operation of more than
one DP master each with its own DP master system on one PROFIBUS bus.

Network Configuration

The following diagram illustrates a possible network configuration with more than
one PROFIBUS CP as the DP master.

DP master DP master for DP master system A DP master for DP master system B
(class 1)
S7 - 300 PROFIBUS CP

S7 - 300 PROFIBUS CP

\|

PROFIBUS

DP Slave DP Slave

l...l 1...1

Process inputs/outputs

Figure 1-8  Bus Configuration with PROFIBUS CPs (DP Multimaster)
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1 Communication via PROFIBUS CPs in S7 Stations

1.6.3 Multimaster Network Configuration

Characteristics

In this situation, the multimaster configuration means the simultaneous operation of
a DP master system and other master-slave systems, for example FMS, on the
same PROFIBUS.

FMS Master

An FMS master (for example SIMATIC S5 PLC with a CP 5431 or SIMATIC
S7-400 with CP 443-5 Basic / SIMATIC S7-300 with CP 343-5) communicates with
the FMS slaves assigned to it according to the field bus standard PROFIBUS EN
50170 Vol. 2 /14/.

Possible Network Configuration with DP Master and “Non-DP” Masters

The following diagram is an example illustrating a possible mode for the
PROFIBUS CP in a multimaster configuration.

In this example, a SIMATIC S5 system communicates with the connected FMS
slaves using FMS services.

DP master ~ DP master for DP master system A SIMATIC S5 with CP 5431 as
(class 1) S7 - 300 FMS master
ROFIBUS CP T
- el I
| L L HpoD
.
- [ J0J0mor 7

PROFIBUS

DP,

DP Slave FMS

l...l

Process inputs/outputs

Figure 1-9  Bus Configuration with PROFIBUS DP and FMS (More than One Master)
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1 Communication via PROFIBUS CPs in S7 Stations

1.6.4 DP Slave Mode

Application

The SIMATIC S7-300 with the PROFIBUS CP in the DP slave mode is suitable for
applications in which local intelligent preprocessing of signals is required.

Network Configuration

The following diagram illustrates the PROFIBUS CP as a DP slave along with
devices that can be operated as DP masters.

DP master
complying with
EN 50170 Vol. 2

e.g. IM 308 B/C PC with CP 5412

SIMATIC S7-300 /400
with PROFIBUS CP

SIMATIC S5
with CP 5431

g~ 0

PROFIBUS

DP slaves: S7 - 300
S$7-300 with
PROFIBUS CP in DP
slave mode

ROFIBUS CP S7 - 300
T 00

Process inputs/outputs

Figure 1-10  Network Configuration with SIMATIC S7-300 as DP Slave

DP Slave Mode and Simultaneously Active Node on PROFIBUS

The PROFIBUS CP 342-5 / CP 342-5 FO can also be operated as an active node
on PROFIBUS. This means that S7 communication and S5-compatible
communication is possible alongside the DP mode.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-35

C79000-G8976-C181-05



1 Communication via PROFIBUS CPs in S7 Stations

1.7 Networking Stations with STEP 7

Configuring

To allow SIMATIC stations and “other stations” to communicate with each other,
the networks must be configured in the STEP 7 projects.

Configuring a network or subnet involves the following:
1. You create one or more subnets of the required subnet type in the project.

2. You select the properties of the subnet. Normally the default settings are
adequate.

3. You connect the station “logically” to the subnet.

4. You set up connections for communication.

Networking in a Multiproject
STEP 7 as of Version V5.2 supports configuration in a multiproject.

2 Using a multiproject, for example, you can create a project for distributed editing by
various editors and distribute the stations to the projects according to their editors.
To allow this, functions are available for branching and merging (sub) projects.

Interproject subnets and connections can be created.

Notice

FMS connections between stations in different projects are not supported in
a multiproject.
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1 Communication via PROFIBUS CPs in S7 Stations

Tools

The SIMATIC Manager provides convenient tools for configuring and documenting
networks (also graphically with NetPro).

i‘}_%NETPHI]: Configuring Networks - [Network To Project 'D:\siemens\5TEP7Y402\E xamples\EXPB’] M= E3 ’

%@ﬂetwork Edit Inset PLC View DOptions “Window Help -|ﬁ'|£|

z(ala| sle| &l = 512 Bl x|

WP (1)
MRl

| »

PROFIBIS (1)
PROFIBLIS

|

Fiis-Cliert 57 400-Stat SIMATIC 300-Station(1) [SIMATIC 300-Station3)
CPUICP CPUICP CPU(CP
EMI 4 (443 i 314 [342 i B4 |42
(=) O @ g =
i 14

[ 1 [ 1

22 o8

(m (s

AR}

FMS-Server 57 400-Stat. SIMATIC 300 DP-Slave SIMATIC 300-Station(2) —

ﬂl]l CRUJCP i [cPUTCR g [cPufce SIMATIC 55017 | ]
LR 4 |42 214 (342 [
o = 0 = T S

4

oz I

The chapter describing network configuration in /9/ and the online help system also
contain information about configuring SIMATIC S7 networks.

HLP
Variants

Before configuring networks with STEP 7, you should be aware of the various
configurations possible in the STEP 7 project. The following configurations are
typical for stations networked with CPs:

Variant (examples)

Characteristics/Configuration

1

1 subnet - 1 project

Additional SIMATIC S5 stations and stations with equipment of other vendors

2 or more subnets - 1 project

a| | WOWMN

1 subnet — more than one project

More than one subnet - more than one project

These variants will be used as a basis to illustrate how real configurations can be
created in STEP 7 projects.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011

C79000-G8976-C181-05

A-37



1 Communication via PROFIBUS CPs in S7 Stations

1.7.1 Network/Project Variant: One Subnet - One Project

Configuration of the System

In the simplest case, your system consists of SIMATIC S7 stations connected by
one subnet, for example of the type PROFIBUS subnet.

S7-400/1 $7-300/1

%I]![I

System

“Production” u
|
i

PROFIBUS subnet 1

él]![l

S7-300/2

View in a STEP 7 Project

You create a PROFIBUS subnet object in the STEP 7 project. Stations created
in the same project refer to this object as soon as they are configured as
network nodes.

'Ei‘: Production [Component view) -- C:A\SIEMENS\S TEP7\S 7proj\Producti (_ O] ]

Project N

E@ I II: 40001]

SIMATIC 300(1) SIMATIC 400[1)  SIMATIC 300(1)  SIMATIC 200(2)
SIMATIC 200(2)
MPI[1) PROFIEUIS(1)

Network objects——
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1.7.2 Network/Project Variant: SIMATIC S5 and Other Devices on the
Subnet

Configuration of the System

In addition to SIMATIC S7 stations, SIMATIC S5 stations and non-SIMATIC
devices can be included in your system.

S7-400/1
System S7-300/1

“Production” u -] -]l] Non-SIMATIC
It =

PROFIBUS

subnet 1 = -:,
I]-l] AL SIMATIC

Lo S5
S7-300/2 I

View in a STEP 7 Project

SIMATIC S5 stations and other devices you intend to include in the
communication must be entered in the configuration as S5 stations or other
stations.

'E"" Production [Component view] —- C:ASIEMENSAS TEPZAS 7prof\Producti =] [E3

Project

2423 Producti
“H SMATIC 4001

SIMATIC 300(1) SIMATIC 400[1]  SIMETIC 300[1]  SIMATIC 30002
“oEl SIMATIC 300(2)

5=

Other station1]  SIMATIC S5(1)

=

PROFIEUS(]

Network objects
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1.7.3 Network/Project Variant: Two or More Subnets - One Project

Configuration of the System

Due to the different tasks of the stations or due to the extent of the system it may
be necessary to operate more than one network.

u
IS

System Ethernet subnet 1
“Production and @
Management Level” S7-400/2 u

IH ﬁ %ROFIBUS cP>

PROFIBUS
subnet 1

S7-400/1

I]i[l !h]![l

S7-300/1 S7-300/2

View in a STEP 7 Project
You can create the subnets in one STEP 7 project and configure the stations for
communication.

[T | =% Production [Component view) -- C:\SIEMENS\S TEP7AS 7proj\Producti [E[=] [E3
=423 Production . . 7
= SIMATIC 40001) = i i
SIMATIC 400[2) SIMATIC 400(1]  SIMATIC 40002]  SIMATIC 300(1]

A8 SIMATIC 30001
- SIMATIC 30002

5
i

I =%

SIMATIC 300(2) HPIT] PROFIEUS(T)

Network objects —

This representation illustrates the following:
¢ More than one subnet can be managed in one project.
e Each station is created once in the project.

e Each station can be assigned to more than one subnet by assigning its CPs
suitably.
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1.7.4 Network/Project Variant: One Subnet - Several Projects

Configuration of the System

In complex networked systems, during configuration it is sometimes more efficient
to manage plant sections in different (sub) projects.

The situation can arise that communication takes place over an interproject subnet
and that interproject connections must then also be created.

| 1
IS N
I I

S7 400/1 S7 - 400/2

System section

System section
“Production 2”

“Production 1”

\
PROFIBUS
subnet 1

!Iﬁ[l

S7 - 300/3

I]i[l I]i[l

S7 300/1 S7 - 300/

Organization in a Multiproject

User-friendly and consistent configuration of such communication is supported in
[ 2 STEP 7 as of Version V5.2 with the multiproject.

The functions for multiprojects in STEP 7 allow the following:

e Several projects can be managed in one multiproject and edited separately
¢ Projects can be branched and merged
Two different strategies can be distinguished in a multiproject:

e Several employees work at the same time on a multiproject in a networked
environment. The projects of the multiproject are in different network folders. In
this case, all connection partners are available for configuring connections.

¢ One employee manages the multiproject centrally. This person creates the
structures for projects (when necessary locally) and contracts individual projects
out for external editing. The central configuration engineer then returns these
projects to the multiproject and synchronizes the interproject data with system
support and where necessary with the required interproject functions.

In this case, agreement is necessary, for example, regarding the assignment of
connection names (reference) because it will be far easier when synchronizing
the projects to bring connections with identical connection names together.
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1 Communication via PROFIBUS CPs in S7 Stations

HLP

The topic of multiprojects is dealt with in detail in the STEP 7 basic help.

Here, you will find information on the following topics:

Requirements for interproject functions

How to create multiprojects

How to create a new project in a multiproject
How to separate a project from a multiproject
How to include projects in the multiproject
How to synchronize projects in a multiproject

Moving stations within a multiproject (when a station is moved from one project
of a multiproject to another project of the same multiproject (for example using
drag & drop), the interproject connections are retained).

Possible problems in distributed projects and tips on how to avoid them

Possibilities for stations outside the current project

A-42

The addition of the multiproject functionality means that the following situations can
arise:

Connection to a partner in an unknown project

The new multiproject functionality allows you to create a connection to a partner
in an unknown project. In this case, you can specify a connection name as a
reference in the properties dialog of the connection. When the projects are
merged, STEP 7 then supports you with automatic synchronization of the
separately configured connections.

The connection remains unspecified until the projects have been merged and
the connections synchronized. Only following this synchronization can the
configuration data be downloaded to the local station without inconsistencies.

You should therefore use this variant when you know that the projects will be
merged in a multiproject.

Specified connections with representative objects

To allow you to create specified connections to stations in a different project (for
example production 2) or that are not managed with STEP 7, you can configure
these stations as other stations (example in the project production 1).

This makes it possible to create consistent, fully specified configuration data
and to download it to the local station.

It is also possible to create specified connections between these stations in
different, independent projects. The stations can then communicate
immediately over the created connections after the configuration data have
been downloaded.

Use this variant when you want to operate projects separately due to the
complexity.

Stations of the type SIMATIC S5 function in just the same way as
representative objects.
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1 Communication via PROFIBUS CPs in S7 Stations

1.7.5 Network/Project Variant: Several Subnets in Several Projects

Configuration of the System

If several network types need to be used and if these need to be managed in
different projects due to the different tasks of the stations or due to the large span
of the plant, stations can be created as follows:

e Using (sub) projects in the “multiproject”
¢ by configuring ”Other stations / SIMATIC S5” in the other project.

Ethernet (1)

Cell level = (sub)project 1
87 _ 400/1 <Ethernet CP
I

‘

ROFIBUS CP

Field level = (sub)project 2

PROFIBUS (1)

EI]E[I EI]E[I

S7 - 300/1 S7 - 300/

Organization in a Multiproject

If you use a multiproject organization, follow the steps below to connect the
2 S7-400/1 station to the PROFIBUS (1) subnet:

Create a subnet of the type PROFIBUS in both subprojects and merge these two
subnets in NetPro.
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2 Characteristics of PROFIBUS CPs

2.1 Communications Processors for S7-300

The modules are designed to match the components of the S7-300/C7-300
programmable logic controller and have the following features:

e Compact modules (single-width) for simple installation on the S7 standard rail
e The operator controls and displays are all located on the front panel
¢ Direct backplane bus connection via the supplied bus connector

¢ 9-pin sub-D female connector or duplex sockets for connecting the CP to
PROFIBUS

¢ The modules can be configured via MPI or LAN/PROFIBUS.

CP 342-5
CP 343-5

CP 342-5 FO

(Duplex sockets for
(9-pin sub-D female optical connection)

connector)

Status and
error displays

Mode selector

Connection for power supply
and functional ground

Figure 2-1 Example: Front View of the CPs 342-5/342-5 FO / CP 343-5
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2 Characteristics of PROFIBUS CPs

Legend

a » O DN

9-pin D-sub female connector
Duplex sockets for optical connection
Status and error displays

Mode selector switch

Connection for power supply and functional ground
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2 Characteristics of PROFIBUS CPs

2.2 Communications Processors for S7-400

The modules are designed to match the components of the S7-400 / S7-400H
(redundant system) programmable logic controller and have the following features:

¢ Single-width module for simple installation in the S7-400 / S7-400H (redundant
system) rack

e The operator controls and displays are all located on the front panel
e Can be used in central or expansion racks

¢ No fan necessary

¢ 9-pin sub-D female connector for connecting the CP to PROFIBUS
e The modules can be configured via MPI or LAN/PROFIBUS.

Status and error displays

Mode selector

PROFIBUS interface

(9-pin sub-D female
connector)

Figure 2-2  Example: Front View of a CP 443-5 Basic / Extended
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2 Characteristics of PROFIBUS CPs

2.3 Attaching to PROFIBUS

Below, you will see several typical possible attachments.

For further information on attachment options and PROFIBUS structures, refer to
the PROFIBUS network manual /8/. For ordering data and information on further
components, please refer to the IK PI catalog or the CAO1 electronic ordering
catalog on CD, and on the Internet at:
http://www.automation.siemens.com/ik/html 00/ca0l.htm

2.3.1 Electrical Attachment

The following options are available for electrical attachment of the CPs to
PROFIBUS:

e Bus Connector (Fast-Connect)

The bus cable is led directly to the CP and attached to the CP using the bus
connector.

¢ Bus Terminal

The bus cable is connected at the bus terminal (6GK1 500-0AA10). The CP is
connected using the cable integrated in the bus terminal.

Bus connector

Bus cable

Bus cable

Figure 2-3  Electrical Attachment of the CPs to PROFIBUS
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2 Characteristics of PROFIBUS CPs

2.3.2 Optical Attachment

e Transition from Electrical to Optical Attachment

The optical link modules (OLM) or optical bus terminals (OBT) are available for
attaching to the optical version of PROFIBUS. The attachment depends on the
type of network components used: glass, plastic or PCF optical cable.

FO

f OBT

Bus cable

Figure 2-4  Transition from Electrical to Optical Attachment

Note

For data rates higher than 1.5 Mbps (12 Mbps), the optical link module approved
for higher data transmission rates must be used.
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2 Characteristics of PROFIBUS CPs

¢ Direct Optical Attachment

Modules such as the CP 342-5 FO allow direct fiber-optic cable attachment via
suitably assembled connectors.

FO cable: PROFIBUS
PCF or plastic FO cable

Figure 2-5 Direct Optical Attachment
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2 Characteristics of PROFIBUS CPs

2.4 Slot Rules and further Information on the SIMATIC
S7-300 Series

2.4.1 Permissible Slots

In the SIMATIC S7/M7-300 there is no set slot assignment for the SIMATIC NET
CPs. Slots 4 to 11 are permissible (1, 2 and 3 cannot be used for CPs).

The SIMATIC NET CPs can be installed both in the central rack and in an
extension rack, linked to the central rack via an IM 360/IM 361 (K-bus connection).

24.2 Number of SIMATIC NET CPs

In typical S7-300 configurations, the simultaneous operation of up to 4 CPs of the
same type has been tested successfully. The actual number of SIMATIC NET CPs
that can be operated at the same time is determined by the system (for example
by the CPU resources).

The connection resources available in the CPU can result in a further limitation.

The load on the CPU resulting from communication jobs may also represent a
further restriction. The following factors should be noted:

¢ Execution Time of the Blocks:

For communication between the S7-300 CPU and SIMATIC NET CPs, blocks
(FCs/FBs) are necessary. How often these blocks are called depends on the
number of connections or the number of SIMATIC NET CPs. Depending on the
amount of data transmitted, every block call extends the time required by the
user program.

¢ Data conversion:

It may also be necessary for the information to be converted before
transmission or after reception.

243 Multicomputing

This functionality is not supported by the SIMATIC S7/C7-300.
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2 Characteristics of PROFIBUS CPs

24.4

CPU Connection Resources and Optimized Utilization

Note that when using older S7-300 CPUs (up to September 1999), a maximum of
four S7 type connections for CP communication are supported. Of these four
connections, one is reserved for a PG and another for an OP (HMI = Human
Machine Interface). The newer CPUs (from 10/99 onwards) support up to 12 S7
connections, CPU 318-2DP supports 32 S7 connections.

As a result, the older S7-300 CPUs have only two “free” S7 connections available.
These two connections can be used for S7 communication, for PROFIBUS-FMS,
or for longer data with Industrial Ethernet.

If you use CPs that support multiplexing of OP connections and S7 communication
with loadable communication blocks, only one connection resource is occupied
when the multiplex channel is used.
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2 Characteristics of PROFIBUS CPs

2.5

2.5.1

2.5.2

253

A-52

Slot Rules and further Information on the SIMATIC
S7-400 Series

Permissible Slots

An S7-400 CP can be inserted both in the central rack and in the extension rack
with a K bus interface. For the total number of CPs you can install, please refer to
the information on the relevant CP in the “Properties” chapter.

In the SIMATIC S7/M7-400 there is no set slot assignment for the SIMATIC NET
CPs. Slots 2 to 18 are permissible. Note, however, that depending on the power
supply module installed, slot 1 may also occupy slots 2-3.

Note
PROFIBUS-DP cannot be used in the extension rack.

Note the following restrictions depending on the services being used:
« SEND/RECEIVE interface

See the CP-specific section of this manual
e S7 communication

The maximum number of modules that can be inserted is limited by the number
of S7 connections of the CPU; see the CP-specific section of this manual.

Number of SIMATIC NET CPs
The number of SIMATIC NET CPs that can be operated simultaneously is limited

by the specific characteristics of the CPU. The exact number can be found in the
CP-specific section of this manual.

Multicomputing

This functionality is supported by the SIMATIC S7-400 (see specific sections).
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2 Characteristics of PROFIBUS CPs

2.5.4 Note on the S7-400 CPU: Connection Resources

Note that in the S7-400 CPU, one S7 connection is reserved for a PG and a further
one for an OP (HMI = Human Machine Interface).

S7-CPs for PROFIBUS Configuring and Commissioning

Release 09/2011

PG connection via MPI/integrated PROFIBUS-DP interface:

To execute ONLINE functions (for example module diagnostics) from a PG on
an S7-400 CP via the MPI/integrated PROFIBUS-DP interface, two connection
resources are necessary on the S7-400 CPU. These two connection resources
should be taken into account in the number of S7 connections.

Example: The CPU 412-1 has sixteen free resources for S7 functions available.
If a PG is to be used for diagnostics on the S7-400 CP and is connected to the
MPI/PROFIBUS-DP interface, two connection resources are required on the
S7-400 CPU, so that 14 connection resources remain available.

PG connection via PROFIBUS or Industrial Ethernet

If the PG is connected to the LAN (PROFIBUS or Industrial Ethernet), in order
to execute PG functions on the S7-400 CPU only one connection resource on
the S7-400 CPU is necessary.
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3 Operating the PROFIBUS CP with STEP S7

To attach a SIMATIC station to a PROFIBUS subnet using a PROFIBUS CP, you
configure the CP with the STEP 7 configuration software. This chapter explains the
following:

¢ How the CP is configured in the STEP 7 project

¢ How the various network configurations are managed (setting up access to
other systems)

e How to control and supply the CP with data using STEP 7.

¢ When installing the PROFIBUS CP, please refer to the instructions in the
product information / manual /2/ supplied with the PROFIBUS CP. This also
contains further information about the performance of the PROFIBUS CP.

ﬂ You will find further information in the following sources:

* For more information about the functions and uses of STEP 7 in which the
NCM S7 option is integrated, please refer to the manuals /9/ and /10/.

You will find this information in the online help integrated in STEP 7 by selecting
Help » Contents.

HLP
¢ You will find examples of configurations in the “Primer” /5/.

S7-CPs for PROFIBUS Configuring and Commissioning
A-54 Release 09/2011

C79000-G8976-C181-05



3 Operating the PROFIBUS CP with STEP S7

3.1 How to Commission a PROFIBUS CP

The following overview shows the essential steps when commissioning a

PROFIBUS CP:

Notice

The chart below shows the basic steps. Please read the device-specific instruc-
tions in “Installation and Commissioning” in the description of your CP (Manual

Part B).

Installation and Commissioning

il T

Install the CP on the S7 standard rail
(S7-300) or in the S7 rack (S7-400).

'

Connect the power supply.

\ i

Connect the CP to PROFIBUS.

|

Turn on the S7 station.

Configuring / Programming

Install the STEP 7 configuration
software on a PG/PC.

Vi

Configure the Ethernet CP:

* Dby configuring in the
project engineering
see Section 3.3

Download the configuration data and the user programs to

the S7 station and/or CP.

Use the diagnostic functions during commissioning
and to analyze problems.

S7-CPs for PROFIBUS Configuring and Commissioning

Release 09/2011
C79000-G8976-C181-05

A-55



3 Operating the PROFIBUS CP with STEP S7

3.2

General Information on STEP 7

Installation

Functions

The functions for configuring a CP are available automatically after installing
STEP 7.

The functions for configuring a CP consists of the following:

e CP-specific index dialogs that you call using the properties dialog box of the
modules.

¢ Dialog functions for connection configuration.
¢ Diagnostics functions that you obtain as follows:
- Using the “Diagnostics” tab in the Properties dialog

- Using the standard Start menu of Windows with which you can call the
SIMATIC program group

e Functions displayed with SIMATIC » STEP 7 » NCM S7... in the Start menu of
Windows:

- Diagnostics

- Firmware loader

Access to Online Help of STEP 7

HLP

A-56

With the online help, you can obtain the following information:

¢ You can display the contents of the STEP 7 basic help system with the menu
command Help -> Contents.

e Context-sensitive help on the selected object using the Help ->
Context-Sensitive Help menu command, the F1 key or the question mark in
toolbar.

You can then access further information relating to the current topic.
¢ Glossary for all STEP 7 applications by clicking the “Glossary” button.

Please note that each STEP 7 application has its own contents and
context-sensitive help.
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3 Operating the PROFIBUS CP with STEP S7

3.3 Configuring - Follow the steps below:

A CP is managed in an S7 project just as the other modules. You use STEP 7 to
configure the hardware and create and manage the user software (see /9/).

Configuring a CP involves the following basic steps (the broken lines indicate
options):

Create the PROFIBUS subnet;
Section 3.3.1

' Check or set the network properties; '
! Section 3.3.2 '

Enter the PROFIBUS CP in the hardware configuration;
Section 3.3.3

/
Attach the PROFIBUS CP to the PROFIBUS subnet;
Section 3.3.3

' Display the network attachment of a station; '
' Section 3.3.4 '

' Make further CP settings; '
' Section 3.3.5 '

Configure the communication services (Section 3.3.7)
- §7 homogeneous connections

- FDL connections

— DP mode

Completed configuration
data in the STEP 7 proje

Download the configuration to the PLC; Section 3.3.8

necessary steps

optional steps
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3 Operating the PROFIBUS CP with STEP S7

3.3.1 Creating a PROFIBUS Subnet

Aims

To be able to attach the SIMATIC stations to a subnet, you create the subnet in
your project. This means that all the parameters for the entire subnet are managed

centrally.

Procedure

It is advisable to create the subnet before you configure the stations since the
assignment of the SIMATIC stations is then performed largely automatically.

It is also possible to create the subnet at a later point in time when configuring a
CP. This is explained in more detail later in the chapter.

Follow the steps outlined below:

1. Select the project in the SIMATIC Manager.
2. Select Insert »Subnet »PROFIBUS.

Result: An object of the type network is created in the project. This allows all
the SIMATIC stations created in the project to be attached to this subnet.

Ed SIMATIC Manager - PROJECT-PROFIBUS =] B3

File Edit |nset PLC Yiew Options

Help

) = = Y g e

Whiricl o

=] v

=28 PROJECT-PROFIBUS
w- il SIMATIC 300 DP-Master
=il SIMATIC 300 DP-Slave
=il SIMATIC 300-Station(1)
=il SIMATIC 300-Station(2)
w-fll) SIMATIC 300-Station(3)

& PRO.JECT-PROFIBUS - <Standard Hierarchy. Offline> (Project) — G:ANCM____ [Hi[=] E3

SIMATIC 300
DP-tdaster

SIMATIC
300-Station(2)  300-Station(3)

ik SIMATIC S5(1)

SIMATIC 300 SIMATIC
DP-Slawve 300-Station(1)

B 5

SIkATIC kA1 (1)

Press F1 for help.

Figure 3-1 Project With Assigned PROFIBUS Subnet
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3 Operating the PROFIBUS CP with STEP S7

3. If you prefer a NetPro graphic network display, select the network object
"PROFIBUS” and confirm with Edit » Open Object.

&NETPRD: Configuring Networks - [Network To Project ‘D:\siemens\STEP7V402\E xamples\EXPB']

%Bﬂetwmk Edit Inset PLC ‘“iew Options ‘Window Help =

zlBls| Ble &l +f 512 Bla x|

| »

WP (1)
WP

PROFIEUS (1)
PROFIELS

[ | [ ]

[SIMATIC 300-Station(1) SIMATIC 300-Station(3)
Hi [SRUjCE [ |CPUICR

214 |2d2 314 |42
[m] [=] [m] [=]

12 o8

[ 1

FMS-Clisnt 57 400-Stat.
I]]]I [
dHa |ad3
(m] [=]
T 14

414 443 314 [342 314 (342
o |m 0 m o o 3

Fris-Server 57 400-tat. SMATIC 300 DP-Slave SIMATIC 300-Station(2) —
EI]]I T 4] [FOTET iy PO SMaTIC S51) |
]

T 16 T 12 T 6
i
q | v

Figure 3-2  Graphical Network Representation — here with stations already networked

From this graphical representation, you can also access all the functions for
networking and configuring connections with PROFIBUS CPs.

You can also create the subnets in NetPro! Open the catalog using the menu
command Insert » Network Objects.

Organization in a Multiproject

If you use the multiproject form of organization, this has the following effects when
' 2 creating subnets.

You create subnets initially in the subprojects as described above. To be able to
network S7 stations, you will, for example, need to create a suitable subnet of the
type Industrial Ethernet in each subproject.

If this is physically a subnet that extends beyond the boundaries of the subproject,
you should first merge the subnets before configuring the communication
connections between the S7 stations.

If you do not merge the subnets, NetPro assumes that you are connecting the
subnets via routers and displays warning messages to this effect.
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3 Operating the PROFIBUS CP with STEP S7

Properties of Merged Subnets (Multiproject)

A-60

When you merge subnets, transferable subnet properties such as the subnet ID of
the master subnet will be transferred to the other subnets of the group.

Some parameters relate specifically to a subproject and remain unchanged; these
include, for example, descriptive parameters such as the name, author, and any
comments.

Notice
Preserving Consistency in Merged Subnets

After merging the subnets, you should check the consistency throughout the multi-
project using the menu command Network > Check Interproject Consistency in
NetPro to make sure that there is consistency throughout the multiproject. This
check detects, for example, S7 subnet IDs that are not unique within the multipro-
ject.
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3 Operating the PROFIBUS CP with STEP S7

3.3.2 Checking and Setting Network Properties

Procedure

The parameters that describe the properties of the PROFIBUS subnet generally
have default values. Using the procedure described below, you can check the
settings and adapt them to your situation.

1. Select the network object in NetPro and select the menu option Edit »Object
Properties.

Result: The “General” tab is opened in the “Properties PROFIBUS” dialog.

2. Enter a suitable subnet name in the “General” tab and if required any further
information to describe the subnet.

3. Check the entries in the “Network Settings” tab.

Properties - PROFIBUS |

General Mebwork Settings |

Highest PROFIEUS . . Optiors... |
Addrezs: 126 - r LChange

Tranzmizsion Fate: 45 45 [31.25] kbit/s
932.75 khitéz
187.5 khitéz
500 khitds

BEEE

2 bA kit d

Profile:

Standard

Uriversal [DP/FMS] Bus Parameters. . |

Uszer-Defined

Cancel Help

Settings

The values in the dialog box are used as basic values for the subsequent
calculation of the bus parameters.

You can see the results of this calculation in the next dialog box. After entering or
checking the values, simply click the “Bus Parameters” button.
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3 Operating the PROFIBUS CP with STEP S7

Table 3-1 Basic Values for Bus Parameters

Parameter Meaning
Highest PROFIBUS This specifies the highest PROFIBUS address of an active station on the
Address (HSA) bus system. Passive stations can have addresses higher than the highest
station address (possible values: highest active address in the network ...
126).
Transmission Rate Transmission rate on the bus. (Values depending on profile, see below:

9.6 Kbps, 19.2 Kbps, 45.45 (31.25) Kbps, 93.75 Kbps, 187.5 Kbps, 500
Kbps, 1.5 Mbps, 3 Mbps, 6 Mbps, 12 Mbps).

For the permitted transmission rates, please refer to the information in the
relevant manual /2/ for your particular CP.

Profile Here you can decide on the method (algorithm) used to calculate the
fundamental bus parameters for PROFIBUS operation.

Various algorithms are available that have been optimized for the particular
mode of the subnet. These algorithms result in stable network operation.
e DP
You can operate a homogeneous DP network with a maximum of one
DP master class 1 and no further DP masters (an additional PG is
possible). This algorithm must be used exclusively for the DP protocol.
e Standard
This is for the multiprotocol and multimaster mode with fast stations. The
stations in this case are equipped with newer ASICs such as ASPC2,
SPC2 etc. This includes all SIMATIC S7 PROFIBUS CPs.
* Universal (default setting)
This is for CPs that cannot be operated in the DP or standard categories.
® User-defined
In this case, you yourself define the bus parameters.

Notice

If you are operating subnets to which SIMATIC S5 components are attached by
means of the CP 5430/5431, please use the universal profile.

ij Caution
Only trained specialists should use the user-defined algorithm.
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3 Operating the PROFIBUS CP with STEP S7

Setting or Checking Further Bus Parameters

By clicking the "Bus Parameters” button, you open the Bus Parameters” tab. This
displays the calculated or default values for the bus parameters.

For more information about the meaning and effects of the parameters in the “Bus
Parameters” tab, please use the integrated help system.

Depending on the algorithm you have selected, the values in this dialog box will be
displayed in one of two ways, as follows:

e User-defined
The default values are displayed and you can change them.

e DP, Standard, Universal
The calculated values are displayed. You cannot modify the displayed values.

Note on the “Bus Parameters” dialog

* Bit time:

This is the time required to send one bit (reciprocal of the transmission rate in bps). The advantage of using
the “bit time” is that the parameters are not dependent on the transmission rate.

To calculate the time in milliseconds from the number of bit time units, use the following formula:

Number of bit time units
transmission rate (in Kbps)

Time (in  miliseconds) =

Checking the Effects of the Network Configuration

To activate the calculation of the bus parameters for a network configuration that
differs from the current network configuration, select the “Options” button in the
“Properties PROFIBUS / Network Settings” tab.

Here, you define a network configuration for which the bus parameters will be
E recalculated. The online help explains the possible settings.

HLP
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3 Operating the PROFIBUS CP with STEP S7

3.33 Entering a PROFIBUS CP in the Hardware Configuration

Procedure

By inserting the PROFIBUS CP in the rack of a SIMATIC station and assigning it to
the station, you establish the logical attachment between the CP and subnet.

1. Place the station in your project that you want to attach to PROFIBUS using the
PROFIBUS CP.

2. Select the CP in the hardware configuration just like any other module by
selecting it in the hardware catalog and then selecting the slot in the rack.

You select CPs in the hardware catalog using a short text and the order
number.

Result: The CP is assigned to the SIMATIC station.

For information about the permitted slots, refer to /2/.
How to configure a module is described in detail in /9/.

Subnet Attachment

To allow you to activate the network attachment of the PROFIBUS CP, the
SIMATIC Manager displays the following dialog:

Properties - PROFIBUS interface CP 342-5 [R0/54] |

General Parameters |

Address: m -
Highest address: 126

Tranzmizssion rate: 1.5 khbitdz

Subnet;
--- ok retworked --- MHew... |
(PROFIBLIST
Properties... |
[elete |

Cancel Help
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3 Operating the PROFIBUS CP with STEP S7

Note

You can open the dialog for setting the interface at any time from the Properties
dialog of the CP in the “General” tab.

If you have not yet created a subnet in the project or have not yet created the
selected subnet, you can now create a subnet. To do this, select the “New”
button.

Result: An object of the type network is created in the project.
Now follow the steps as outlined in Section 3.3.2.

Check the PROFIBUS address and if necessary change it. The system first
enters the next free PROFIBUS address automatically as the PROFIBUS
address.

Further options for program-controlled address setting in Section 3.4.1

5. Select the required subnet type in the “Subnet” list box.

6. You can display the properties dialog box for the selected subnet by clicking the

Properties button. For more detailed information about the PROFIBUS network
properties dialog, refer to Section 3.3.2.

Enter information specific to the subnet node in the “General” tab.

You must finally confirm your input with OK, otherwise the networking is not
entered (refer to Point 6)

Result: The CP is now configured as a network node for the corresponding S7
station.

Automatic Check if Bus Parameters are Changed

If you change the assignment to the subnet, the system automatically checks
whether the CP mode is compatible with the profile of the newly selected subnet. If
they are not compatible, you will receive a message prompting you to set suitable
subnet parameters.
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3.3.4 Displaying the Network Attachments of a Station

Procedure

You can easily get an overview of the network attachment configurations of a
SIMATIC station in one of the following ways:

e A graphic overview in NetPro;

¢ An overview in table form in the Properties dialog of the station

Graphic Overview in NetPro
The NetPro view provides you with a good overview of the networked stations:
Follow the steps below:

1. Double-click one of the network objects, for example PROFIBUS in your project
in the SIMATIC Manager.

E—,}_;':r HetPro - [COLOR_414 (Network] - CASIEMENSASTEP/AS 7projsColor_41]

%@ﬂetwork Edit Inzert PLC Wiew Optionz “Window Help

= %) G| = [o] sl 5] 512 B 8

RAPIC )
MPI

PROFIBL=(1)
FROFIELS

|

SIMATIC 40001 ) SIMATIC PC1)
|SmaTiC 300017 =
1111 [ R
I TIC H1 o |m
m T — 2z {lnterface
" m 'm Type: PROFIBUS
FRE Address: 10

Figure 3-3  NetPro View of a PROFIBUS Subnet
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Overview in Table Form

The table view in the Properties dialog of the station provides a detailed overview

of the components used for network attachment.

Follow the steps below:

1. Using the SIMATIC Manager, select the station in your project that you want to

check.

2. Select the Object Properties using the menu option Edit » Object Properties

or by double-clicking the station symbol.

3. Select the "Interfaces” tab.

Result: The following dialog box is displayed.

Properties - SIMATIC 300 Station

General Interfaces |Settings|

Type I Addresz I M etworlk I Order Mumber

Pl 2 BESY 314-1AED1-04B0

PROFIBUS 10 PROFIEUS [1] CP 3425 BGR(G] BGKT 342-50400-0<E0

Pl 3 CP 3425BGR[5) BGKF 342-5DA00-0<E0

1 i

— Display interfaces by type ..

¥ MPI W EROFIBLS W Industrial Ethemet ¥ FIP

Cancel Help

In the displayed dialog, you can see the subnet attachments that were configured

for the SIMATIC station.

You can select what is displayed using the check box under “Display interfaces by

type”.
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3.3.5

Overview

Setting further CP Properties

In addition to the network attachment, you can also make further settings for the
specific module or you can call functions.

1. Select the PROFIBUS CP in the hardware configuration.

2. Select Edit » Object Properties. In the dialog, you will see further tabs in
addition to the “General” tab described in Section 3.3.3 depending on the type
and CP, some of which are shown in the example of a CP 342-5:

Properties - CP 342-5 - [R0/54) |
General |ﬂ«ddresses| Operating Mu:u:lel Dptiu:unsl Diagnu:ustiu:sl
Short Degignation: CF 3425
FROFIBUS CF: DF pratocoll with SyncdFreeze, SEND-RECEMNE ;I
interface, 57 functions, routing, module replacement without PG, 12
tbpz, firmmware .0 _I
Order Mo.: BGE.7 242-5DA02-0<ED
Mame:
— Interface B ackplane Connection
Tupe: FROFIBUS MPI Address: |3 vI
Address: 10
M etworked: Ter Froperties. .. |
LComment:
oo

Please read the description of the Properties dialog of the CP in the integrated
help. The functions are explained in detail there.

Addresses Tab

A-68

The “Addresses” tab displays the address at which the module can be addressed
by the user program. You require this address when calling the FCs for DP and for
FDL connections.

—> See /6/
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Notice
Please note the following information on S7-300 stations:

If you selected the option "Update OB1 process image cyclically” in the CPU confi-
guration, (default), make sure that the start address of the PROFIBUS CP is out-
side the process image area (start addresses in the "Addresses” tab).

Example: if the process image selected for the CPU = 1024 (0...1023), an address
>= 1024 must be selected for the PROFIBUS CP.

Operating Mode Tab

In this tab, you can activate the DP master mode if required for CPs with DP
functions. If the CP can also be operated as a DP slave (for example the
CP 342-5), the DP master or DP slave mode must be selected (see Table 3-2).

Note

When selecting the mode, please make sure you follow the instructions
—> in Section 4.6 Checking or Setting the CP Mode DP Master
—> in Section 6.3.2 Checking or Setting the CP Mode DP Slave

Table 3-2  Configurable CP Modes and Possible CP Functions

Configura Possible CP functions
ble ((1:P PG/OCM FDL/FMS | S7 comm. | DP Master | DP Slave
mode | PROFIBUS on Client /
PROFIBUS Server
No X X X - -
DP mode
DP master X X X X -
mode
DP slave X X X - X
active
DP slave - - - - X
passive
Refer to the CP Product Information for the protocols supported by the CP!
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Note

PG functions and test functions are always possible on the MPI regardless if the

selected mode.

In the “passive” mode, no PG functions are possible via PROFIBUS.

Options Tab

Depending on the CP type, the following settings can be made:

Table 3-3  Settings in the “Options” Tab

Option

Meaning / Effect

¢ Time-of-Day Synchronization

Here, you decide whether the CP forwards time-of-day frames or not.
You require this function if you have several CPs in a station since
only one CP is permitted to pass on the time synchronization
messages.

Note

The time-of-day synchronization function does not exist for all module
types.

* Replace Module without PG

With this option, you can have the configuration data of the CP stored
on the CPU. If you then replace CP, the configuration data for the
new CP are downloaded automatically from the CPU when the CP is
started up.

If you select this option, the configuration data are stored long-term
on the CPU instead of in the EEPROM of the CP. Remember,
however, that long-term storage on the CPU is only safe from power
outages if the CPU is protected by battery backup or by using an S7
Memory Card.

Notes

* If you store the configuration data on the CPU, please read the
note below.

The following functions do not modify the configuration data on
the CPU:

- Reset module memory
- Resetting to factory settings

If you subsequently upload the configuration data from the CPU
to a PG you will always object the configuration data that were
previously on the CP (with parameters, connections, IP address).

* On H systems you must activate the option.

* The CP 443-5 Extended can only be operated with the option (not
selectable).
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Table 3-3  Settings in the “Options” Tab , continued

Option

Meaning / Effect

* Resources Required on the CPU

If you select this option, you utilize additional resources on your
CPU. When you download the user programs and the
configuration data, you will be informed if there is not enough
memory. You can avoid problems arising from a lack of memory
by using an S7 memory card.

Tip:

If you find you have a lack of resources and do not want to use an
S7 memory card, you can also deselect the option and store the
configuration data on the CP. You can then later write the
configuration data to an S7 memory card so that the option
“replace module without PG” is activated. When you insert the S7
memory card in the CPU, you can then replace the CP at any
time. The configuration data are then automatically loaded from
the CPU or from the S7 memory card when the CP is started up.

¢ Field Device Parameter
Assignment (Data Record
Routing)

By selecting this option, you can use the CP as a router for data
records intended for field devices (DP slaves). The CP then passes
data records transferred by devices that are not directly attached to
PROFIBUS and do not therefore have direct access to the field
devices (DP slaves) on to the field devices.

One tool that creates such data records for assigning parameters to
field devices is SIMATIC PDM (Process Device Manager).

As default, the function is activated. Since the function requires
additional memory resources, you can deactivate this option if you
are utilizing a lot of memory resources on the CP (connections etc.)
and do not require the "data record routing” function.

* Multiplex OP Connections /
Reserve Internal CPU
Connection Resources

To attach TD/OPs or HMI devices, you can optimize the connection
resources on the S7-300 CPU by having up to 16 of these devices
communication on a single CPU connection resource (multiplex
mode).

If you do not use this option, the number of operable TD/OPs or HMI
devices depends on the number of available connection resources of
the CPU you are using.

As default, this option is deactivated. This means that a CPU
connection resource is used for multiplex only when necessary.

Configured S7 connections over the CP use the same multiplex
channel as you use for multiplexing the HMI connections. If you
configure S7 connections, this means that one CPU connection
resource is already used.

Please note: PG connections do not use the multiplexer; if you use a
PG, one connection resource is always occupied.

Note on Programming:

When you use the multiplex mode, you must specify the rack/slot
assignment of the CP for addressing on TD/OP/HMI connections
instead of the rack/slot assignment of the CPU!

Applications (for example ProAgent) that require block-related

messages (Alarm_S: SFC17-19) are not supported in the multiplex
mode.

S7-CPs for PROFIBUS Configuring and Commissioning
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Communication Variables Tab

In this tab, you can make the settings required for the communications variables
on FMS connections.

Diagnostics Tab
In the “Diagnostics” tab, you can start NCM S7 PROFIBUS diagnostics.

-> see Chapter 8 Diagnostics for a description
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3.3.6

Overview

Plant

S7

Substitute Objects in the STEP 7 Project

Communication connections can be configured fully when the communications
partners are available in the current project. For the stations on the PROFIBUS
subnet, whose configuration data were not created in STEP 7 or whose
configuration data are not managed in the currently active project, the following
substitute objects can be created in the project:

e SIMATIC S5 stations
 PG/PC
¢ Other stations
- for devices of other manufacturers

- for SIMATIC S7 stations in another project (not necessary in a multiproject)

Note

Instead of creating substitute objects, you can also configure unspecified
connections for connections to the stations listed above.

In the Properties dialog of these connections, you must then specify the full
partner address. These partners do not appear in the NetPro plant view.

Plant

‘Production 1” “Production 2”

-400/1
S7 - 300/3

S7-300/1

-] -] Non-SIMATIC -] -]I]
] |

PROFIBUS subnetj.x

I
1

]
$7-400/5

L 0000C g

SIMATIC
S5

S7-300/2
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Procedure
To enter a substitute in the project, following the steps below:
1. Select the project in the SIMATIC Manager.
2. Select the station type with the menu option Insert »Station »...

Result: An object of the type “Other Station” or “SIMATIC S5” is created in the

project.

EJ SIMATIC Manager - PROJECT-PROFIBUS =] E3
File Edit Insert PLC “iew Options MWindow Help

D875 &%) sl % [ t| =] n2|
&, PROJECT-PROFIBUS - <Standard Hierarchy, Offline> (Project) — G:ANCHM____ [H[=] E3
=28 PROJECT-FROFIBUS @ @ @

=il SIMATIC 300 DP-Master

i] SIMATIC 300 DP-Slawve SIMATIC 300 SIMATIC 300 SIMMATIC

i] SIMATIC 300-Station(1) DP-tdaster DP-Slawve 300-Station(1)
B SIMATIC 300-Station(2)

H SIMATIC 300-Station(3) @ @

SIMATIC SIMATIC
300-Station(2)  300-Station(3)

= 5

KF1 (1) FROFIBUS (1) SIMATIC S5(1)

Fress F1 for help. [ [ [ i

Figure 3-4  Project with Substitute Objects Configured

Attaching Non-S7 Stations to the Subnet

The next step is to assign the substitute object to the subnet, as follows:

1. Select the object.in the project and select Edit » Object Properties.

2. Select the “New” button in the “Interfaces” tab of the “Properties” dialog.
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Result: opens the "New Interface - Type Selection” dialog box.

Properties - Other station E

General Interfaces |

Mame | Tupe | Address | Subnet |

Mew Interface - Type Selection

Type: Ethemet interface

IP interface

WPl interface
PROFIEUS interface
PTP interface

MNew... [Nelete |
0K I Cancel Help |

QK | Cancel Help

Figure 3-5  Selecting the Subnet Type for Other Stations

3. Select a subnet for the station.

Result:
The "Properties - PROFIBUS Interface”, “Parameters” tab is displayed.

4. Check the PROFIBUS address and if necessary change it. The system first
enters the next free PROFIBUS address automatically as the PROFIBUS
address.

Notice

The PROFIBUS address configured here and the bus parameters must actually be
set on the relevant station! Use the appropriate software tool (for example COM
5431).

5. Select the subnet to which you want to attach the station and confirm with OK.

Result: The CP is assigned to the first subnet displayed in the subnet table. If
you have created more than one subnet, you can select the required subnet
here.

6. You can display the properties dialog box for the selected subnet by clicking the
Properties button. For more detailed information about the PROFIBUS
properties dialog, refer to Section 3.3.2.

7. Enter information specific to the subnet node in the “General” tab.
Result: You have created a network node and attached the station to the subnet.
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All the SIMATIC stations in the project can establish communication relationships
to this station.

The station is now also included in the calculation of the bus parameters.

Modifications

If you want to change the address or any other settings for the SIMATIC S5 or
other station, select the node name again in the node list and click the “Properties”
button.

Multiple Assignment

The station can also be assigned to more than one subnet node providing there
are enough possible attachments. To do this, repeat the procedure for attaching
“Other Stations” to the subnet.

3.3.7 Configuring Communication Services

Setting Up Connections

You must set up connections for the connection-oriented services supported by the
PROFIBUS CP, see also Table in Section 1.2.

¢ S7 connections
see the STEP 7 user manual /9/;

¢ FDL connections
see Chapter 7;

¢ FMS connections
see Volume 2 of this manual

The procedure described in the STEP 7 User Manual /9/ in the Section
"Configuring Connections” also applies to the additional connection types possible
with the CP.

Configuring the DP Mode
If you use the CP for DP communication, you must configure the required mode.

e DP master mode
Configuring and programming the DP master system, see Chapter 4 and the
STEP 7 user manual /9/.

e DP slave mode
Configuring and programming the DP slave mode, see Chapter 6
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3.3.8

Principle

Downloading the Configuration to the PLC

The configuration data of the PROFIBUS CP are downloaded from the hardware
configuration. All the configuration data of the S7 station are downloaded including
the central configuration, all relevant DP master systems and all the selected
parameters.

The data of the configured connections must also be downloaded, see below.

Type of Interface

Procedure

You can download the configuration data to the S7 station on the following paths
(interfaces):

¢ MPI Interface

You always use this interface when you download the configuration data for the
first time (node initialization).

During the so-called “Node Initialization”, you supply the PROFIBUS CP with a
PROFIBUS address and with bus parameters for the first time. You have then
configured the CP so that further configuration is possible working on the PG
connected to the PROFIBUS. You download the configuration data either via
MPI or via a different CP that already has an address.

 PROFIBUS

Here, you use the PG mode of the PROFIBUS CP in the S7 station (see also
Section 1.3). The node must previously have been initialized via the MPI
interface (see above).

To download the configuration data to the S7 station, follow the steps outlined
below:

1. Open the "Set PG/PC Interface” dialog box, for example, using the Start menu
SIMATIC » STEP 7

2. Set the PG/PC interface according to the CPs available on your PG and
according to the bus attachment (interface parameter assignment used). Make
sure that you set consistent bus parameters.

For more detailed information, refer to the integrated help system.
3. Select the menu command PLC » Download to Module.
STEP 7 then guides you through dialog boxes.

Refer to the other information available in Help » Contents... in STEP 7 or in the
STEP 7 manual, in the section "Configuring and Assigning Parameters to Modules”
in/9/.
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Saving the Configuration Data in Non-Volatile Memory

You can download the configuration data step-by-step or all at once. If you
download step-by-step, you will be prompted to start the download function
separately for each module. You must select this method if you want to save the
configuration data in non-volatile memory on the PROFIBUS CP.

Downloading the Configured Connections

To download configured connections, you use a corresponding download function
in the connection configuration.

Notice

If you have assigned a new PROFIBUS address to the PROFIBUS CP and have
also configured connections (S7, FDL, or FMS connections), you must always
download the connection configuration again.

Remember that you also make suitable address adaptations for the other stations
or “substitute objects”.

Relocating the CP in the Hardware Configuration

A-78

If you are using communication services with configured connections, the
connection IDs also identify the slot of the CP. If you “drag” a CP you have already
configured to a different slot, note the following:

Note

If you drag the CP to a different slot, the data of the connection configuration are
automatically updated. The data of the connection configuration must, however, be
downloaded again!
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3.4 Additional Functions

3.4.1 Changing the Mode and PROFIBUS Address with the User
Program

Note the information in the manual for your PROFIBUS CP.

By transferring data record 3 to the PROFIBUS CP using the "Write data record”
function (SFC 58), you can modify the configured mode and PROFIBUS address
of the module from the user program of the CPU. For more detailed information on
SFC 58, refer to the SIMATIC S7 documentation /11/.

The data record is made up of the following three bytes:

Table 3-4  Structure of Data Record 3

Parameter Type Possible Meaning
Values
1. Ctrl-Type Byte 0,1 0: no change

1: allow change

A change to the mode and/or the PROFIBUS
address of the module is only made when this
byte is set to "1”.

2. Mode Byte 0.3 0: no DP

1: DP master

2: passive DP slave
3: active DP slave

Specifies the new mode in which the module will

operate.
3. PROFIBUS Byte 0..HSA New address of the module on PROFIBUS
Address Specifies the new PROFIBUS address. This

address can be between 0 and the HSA specified
in the configuration.
Note:

If you do not want to change the PROFIBUS
address, simply transfer the first two bytes of data
record 3.

Example: Sending data record 3 to the CP 342-5

The following example shows how to set parameters for SFC 58 to allow you to
change both the configured mode and the PROFIBUS address.
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Table 3-5 CALL SFC 58 "WR_REC” (write data record)

RET_VAL :=MW12

RECORD :=P#DB45.DBX 0.0 BYTE 3 //

BUSY :=M10.1 //

Table 3-6 DB 45

STL Explanation

REQ :=M10.0 // Trigger bit for the job

I0ID :=B#16#54 // Module base address of the PROFIBUS CP is in the
// input area (PI)

LADDR :=W#16#100 // Module base address of the PROFIBUS CP

RECNUM :=B#16#3 // Select data record 3

Data area for data record 3 - data in DB 45
Return value of block in memory word 12
SFC returns code: job active (1),

Job done (0)

(Relative)
Address

Parameter / Name

Type

Comment

0

Ctrl-Type

Byte

0: no change
1: allow change

Mode

Byte

New mode

PROFIBUS
address

Byte

New PROFIBUS address

Notice
The module can then only be operated in the DP master mode if it was
configured in the hardware configuration as DP master.

If an invalid mode (>3) or an invalid PROFIBUS address (> HSA) is specified,
no change is made. SFC 58 does not, however, signal an error to the user

program.

Caution
The change is retained until power off/on on the station or until it is
reconfigured using data record 3.

After power off/on, the CP returns to the configured mode and PROFIBUS

address (default).
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4 DP Master Mode with a PROFIBUS CP in a
SIMATIC S7-300

To use the PROFIBUS CP in a SIMATIC S7-300 in the DP master mode, you
configure a DP master system in your project with STEP 7. In principle, this is the
same procedure as described in the STEP 7 manual /9/. Please refer to the
sections describing the configuration examples for the distributed I/Os.

This chapter contains additional information you will require for the following:
e Addressing DP data areas in the user program

¢ Using control mechanisms to adapt the communication to the requirements of
your automation task. This includes mechanisms for synchronizing data input
and data output.

e Using the SIMATIC S7 programmable controller as a DP master (class 2).

¢ If you want to use the PROFIBUS CP in the DP slave mode, refer to Chapter 6

ﬂ You will find further information in the following sources:
in this manual.

e DP diagnostics in the user program is discussed in Chapter 5 in this manual.

¢ The use of the FCs DP_SEND, DP_RECV, DP_DIAG and DP_CTRL is
explained in /6/.

* NCM diagnostics with special functions for the DP master mode is described in
Chapter 8.

Please read the information in the manual. Depending on the version, the available
8 CPU types may react slightly differently. This symbol draws your attention to such
differences!
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4.1 Overview

Differences Compared with the Integrated DP Interface

When using the PROFIBUS CP, note the following differences compared with the
integrated DP interfaces in the CPU:

¢ In the configuration:

— The DP master system is created when the CP is configured and not when
the CPU is configured.

¢ In the programming:

- Reading and writing process and diagnostic data must be started using an
FC.

- In addition to the process image, memory bits or data blocks can also be
used as peripheral data areas.

¢ |n the use of the variable table VAT:

- Direct enabling of the process image Pl is not supported since the outputs of
the peripheral I/Os are set by blocks (FCs).
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4.2 Procedure

Steps
Programming and configuring the DP master system involves the following steps:
Configuring Programming
1. Configure the DP master system 3. Using DP in the user program
see Section 4.4 see Section 4.7

2. Assign parameters to the DP master
system
see Section 4.5

Installation and Commissioning

4. Start up the DP master and DP
slaves on the PROFIBUS and test

them.

5 If errors occur in the DP master
system, run diagnostic checks.
See Chapter 8

Figure 4-1 Operating the DP Master With a PROFIBUS CP

Configuring
Configuration allows the DP slaves to be installed regardless of the program. Two
steps are necessary, as follows:
- Configuring the DP master system
You specify the DP master and corresponding DP slave in the configuration
table.
— Assigning parameters to the DP master system
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Programming

You program the following in the user program of the CPU, for example with
Ladder Logic or Statement List:

1. Access to the process data. This involves the following:

- The evaluation of a DP input signal (analog or binary signal) in the specified
DP input area.

- Setting or deleting a binary output signal or the value of an analog signal in
the specified DP output area.

2. The DP communication in the program execution on the CPU. This involves the
following:

- The process data transfer or acceptance within the CPU cycle using FCs
(DP_SEND or DP_RECV).

- The querying and evaluation of diagnostic information using an FC
(DP_DIAG).

— Controlling the distributed peripheral I/Os using control jobs, for example
with synchronization instructions using an FC (DP_CTRL).

How you use the functions (FCs) in your user program for the DP master mode is
described in the following sections of this chapter. The exact syntax of the FCs and
the meaning of the block parameters is described in /6/.

Obtaining the Functions (FCs)

A-84

The functions described here (blocks of the type FC) are supplied with STEP 7.
For further information, refer to /6/

For new user programs, always use the latest block versions. You will find
information on the latest block versions and the blocks themselves as downloads
on the Internet at:

http://support.automation.siemens.com/WW/view/en/8797900
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4.3 The SIMATIC S7-300 in the DP Master Mode with the
PROFIBUS CP

Characteristics of the PROFIBUS CP

The PROFIBUS CP operates as a DP master class 1. The PROFIBUS CP can
also support services of the DP master (class 2) (please refer to the information in
the CP product information bulletin /2/).

The PROFIBUS CP can be operated as the only DP master or as a DP master in a
multimaster configuration as illustrated in Figures 1-7 and 1-8.

Tasks of the PROFIBUS CP

During the operating phase of a DP master system, the PROFIBUS CP has the
following tasks when acting as the DP master:

¢ Initialization of the DP system

The PROFIBUS CP checks that the DP slaves are ready for operation by
fetching diagnostic data. With this function, the PROFIBUS CP can, for
example, determine whether another DP master has already configured and
assigned parameters to the DP slave.

e Assigning parameters to the DP slaves

The DP slaves are supplied with the parameter data configured on the DP
master.

¢ Checking the configuration of the DP slaves

The configurations of the DP slaves stored on the DP master are compared
with the current DP configurations of the DP slaves.

e Cyclic data transfer to the DP slaves

The values of the process inputs are read into the DP input area and the values
in the DP output area are written to the process outputs.

¢ Monitoring the DP slaves
Unobtainable DP slaves are detected and signaled.
¢ Acquiring and preparing diagnostic information

Diagnostic information can be collected using the user program or using
diagnostic devices operating as DP masters class 2. The latter also includes a
PG operating with DP diagnostics under NCM S7 for PROFIBUS.
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¢ Processing control requests from the user program
— Synchronization of the inputs/outputs
- Starting/stopping the DP master
— Setting the DP status for PLC or CP stop

¢ Reading inputs or outputs of a DP slave that is assigned to another DP master
class 1 (shared input or shared output).

¢ Bringing the DP system to a safe status if the CPU or CP stops.

e Further DP master special functions (for example activating/deactivating DP
slaves).

Bus Parameters

The transmission rate, the PROFIBUS address and the mode (DP master, DP
slave active, DP slave passive, no DP mode, see Section 4.6) can be selected
when configuring with STEP 7.

The CP adopts these settings after the configured data have been downloaded.

The PROFIBUS address and the mode (DP master, DP slave active, DP slave
passive, no DP mode, see Section 4.6) can be set as follows:

e By configuring;

The CP adopts this setting after the configured data have been downloaded.
This variant is described for setting the mode in this chapter. This is the
standard situation for a fixed setting.

e Using a job in the user program;
For an example, refer to Section 3.4
e Using a DP master (class 2) job.

For more detailed information, refer to Section 4.6.
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4.3.1

Principle of Data Exchange

Cyclic Data Exchange between DP Master and DP Slave

Data exchange between the DP master and DP slave is cyclic (DP polling cycle)
and uses send and receive buffers on the PROFIBUS CP (DP data buffers). The
data exchange is started by the DP master which sends output data to the DP

slave and fetches input data from the DP slave.

Functions

For the data exchange using the STEP 7 user program, two FCs are available:
e DP_SEND

This FC transfers the data of a specified DP data area on the CPU to the send
buffer of the PROFIBUS CP for transmission to the DP slaves.

« DP_RECV

This FC takes the data read from the DP slaves from the receive buffer of the
PROFIBUS CP and enters it in the specified DP data area of the CPU.

STEP 7
user program

DP Master

CPU

DP

data areas

DP_SEND

DP_RECV

PROFIBUS CP

CP

database

DP
dat;

send

— receive

a buffer

D

Figure 4-2

CPU cycle

Interaction of the CPU and PROFIBUS CP in the DP Master Mode

r el
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CPU Cycle and DP Polling Cycle

The CPU cycle and the DP cycle are independent of each other. The CPU-CP
interface that can be addressed by the user program with the functions DP_SEND
and DP_RECYV is designed so that complete data transfer is ensured when
handled correctly.

Handling correctly means that the data transfer with DP_SEND and the reception
with DP_RECYV requires evaluation of the block status codes in the user program.

For a detailed description of the data exchange with flow charts, refer to the
description of the FCs in /6/.

To ensure that data is transferred completely when the CPU cycle time is short
compared with the DP polling cycle time, the following procedure is used:

DP_SEND:

No new data are transferred to the PROFIBUS CP until the data have been
transferred completely to the send buffer of the PROFIBUS CP. The user program
must evaluate the status codes of the FC and can only update the data in the DP
data area after this has been enabled.

DP_RECV:

New data are only transferred to the DP data area of the CPU after the user
program has been informed of a complete data transfer and when DP_RECYV is
called again.

Note

The data (received data) in the DP data buffer of the PROFIBUS CP are updated
regardless of whether or not the user program in the CPU has fetched data from
the DP data buffer (receive buffer). This means that data can be overwritten.
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4.3.2 The DP States of the DP Masters

Overview

Communication between the DP master and DP slaves can be divided into four
modes:

e OFFLINE
e STOP

« CLEAR

* RUN

Each of these modes is characterized by defined actions between the DP master
and the DP slaves.

Mode Meaning Priority 1)

OFFLINE There is no communication whatsoever between the DP master 1
and the DP slaves. This is the initial status of the DP master.

If an assignment to a master was saved on the DP slave, this is
cleared when the slave enters the offline mode so that the DP
slave can then have parameters assigned and be configured by
other DP masters.

STOP 2 There is also no communication between the DP master and DP 2
slaves in this mode.

If an assignment to a master was saved on the DP slave, this is
not cleared when the slave enters the stop mode so that the DP
slave cannot have parameters assigned and be configured by
other DP masters.

CLEAR In this mode, the master configures and assigns parameters to all 3
DP slaves entered in the CP database and activated. Following
this, the cyclic data exchange between the DP master and DP
slaves begins. In the CLEAR mode, the value OH or configured
substitute values is sent to the slaves with process output or an
empty frame, in other words,. process output is deactivated.

Process inputs remain active.

RUN 3) The cyclic data transfer to the DP slaves takes place in the RUN 4
mode. This is the productive phase. In this mode, the DP slaves
are addressed one after the other by the DP master. The call
frame contains the current output data and the corresponding
response frame contains the current input data.

1 If different modes are requested by the DP system (for example by the CPU or a master class 2), the mode
with the highest priority is adopted (1 = highest; 4 = lowest).

Note: With newer modules (refer to the information in the manual /2/), the STOP mode is now
the OFFLINE mode.

3) Corresponds to OPERATE in the DP standard.
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Sequence of the Modes

Initially, the DP master is in the OFFLINE or STOP mode. Starting from the
OFFLINE/STOP mode, the DP master changes to CLEAR/RUN and then
configures and assigns parameters to the DP slaves.

OFFLINE / STOP —> CLEAR -> RUN

Changing the Modes of the DP Master
The causes of a mode change on the DP master are explained in Section 4.8.
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4.3.3 DP Input Area and DP Output Area on the CPU

Concept

The distributed I/Os connected via PROFIBUS behave like local process signal
I/Os in terms of the user program. This means that no special access mechanisms
are necessary for the DP data area.

DP Input Area and DP Output Area in the CPU

The DP interface is so flexible that different data areas can be used on the CPU for
storing the DP process data. Which data area you assign for this purpose depends
on the CPU type and the particular task. The following options are available for the
DP input area and DP output area:

Process image

This assumed that a continuous input or output area can be reserved for
distributed 1/Os in the process image of the CPU. This can, however, be
restricted by the size of the process image and the number of signal modules
installed centrally.

Bit memory address area

Just like the process image, this area is also suitable for global storage of DP
signals. The bit memory address area can, for example, be used when the
space left free by central signal modules in the process image is too small.

Data block (DB)
Data blocks can also be used to store DP signals. This location is preferable
when the DP data area is processed by one program block.

The following diagram illustrates the assignment of the DP input and output area to
the various data areas of the CPU mentioned above.

Alternative DP data areas in the CPU DP Process

Data

data block. |

Bit memory

DP input area

Process
image

DP
output area

Process image for central signal modules

Figure 4-3  Assignment of the DP Process Image to the PLC Data Areas
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Examples

Depending on the location of the DP input / DP output area, the control program
also uses operations such as those shown below when accessing DP:

e Al20
to read data in the process image (Pll)

e ANM45
to read a memory bit.

Note

The DP input area and DP output area are both transferred into or from one of
these data areas on the CPU in their entirety.

Differences Compared With the Integrated DP Interface

With the DP interface integrated on the CPU, the DP input our output data are
always saved in the peripheral I/O area.

The data transfer procedure with the PROFIBUS CP using the FCs DP_SEND and
DP_RECYV allows data to be saved in the alternative areas listed above (process
image, bit memory area or in a data block).

When DP_SEND or DP_RECYV is called, the addresses of the continuous DP data
areas (inputs or outputs) must be specified. In contrast to the integrated DP
interface, during configuration you do not specify absolute addresses but
relative addresses known as the address offset.

Process image input table Handling in the user program:

0

i Specify the DP data area in the FC call

g ddesome | RECV 1= P#I10.0 BYTE 44;

10 0

12 2

DP data area

50 ;10 Example - access to byte 40 in the DP data

52 43 area (IB 10 + 40= 1B 50):

54

L IB 50
Figure 4-4  Specifying the DP Data Area as an Address Offset with the PROFIBUS CP
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4.4 Configuring the DP Master System

Procedure

Basically, you configure a DP master system in exactly the same way as a
centrally installed SIMATIC S7 station.

The chapter “Configuring a PROFIBUS DP Network” in the STEP 7 manual /9/
describes the following procedure:

Steps

Enter the PROFIBUS CP with the DP master function in the
hardware configuration

\]

Assign the DP master to a PROFIBUS network and assign the
PROFIBUS address (open the master system)

i |
For DP slave, modular: For DP slave, compact:

Enter the DP slave in the master system configuration table and
assign the PROFIBUS address

Y
Assign modules/IDs to the DP slave

1

Assign address offsets in the Assign address offsets in the DP
DP data area to the modules/IDs data area to the DP slave

' '

Save the master system configuration table

The steps marked in gray differ from the procedure described in /9/ and are
explained below.
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Assigning an Address Offset

Each input/output of a DP slave is assigned exactly one address offset in the DP
data area with which the input or output is addressed. You must therefore assign a
start address (address offset) to every module of a DP slave.

STEP 7 automatically assigns default addresses when the module is created. The
addresses are specified without gaps and without conflicts. The addresses and
their length are entered in the columns “l address” or “Q address” and “Length” in
the detailed view. The setting can be changed.

Note

When configuring the DP master system with the CP 342-5 as DP master in the
SIMATIC S7-300, note the CP type (order number) in the hardware catalog when
selecting DP slaves. For more detailed information, refer to the following section.

Slave Selection with the CP 342-5 as DP Master

When you select the DP slaves from the hardware catalog, there are two
possibilities when the CP 342-5 is used as the DP master in an S7-300 station.
Which variant you use depends on the module type that you can identify by its
order number.

¢ CP 342-5 with order number 6GK7 342-5DA00-0XEO

This CP type supports DPVO0 standard slaves; you must therefore use the DP
slaves available in the subcatalog “DPVO0”.

e CP 342-5 with order numbers:

6GK7 342-5DA01-0XEOQ

6GK7 342-5DA02-0XEOQ

6GK7 342-5DA03-0XEOQ

6GK7 342-5DF00-0XEO (CP 342-5 FO)

For this CP type, you can use the DP slaves available in the standard catalog.
This means that in the DP mode the additional functions of the DP slaves in the
SIMATIC family are available. These additional functions include the following:

- hardware interrupts
- diagnostic interrupts

— substitute values

Note

Please note any differences as explained in the product information bulletin /
manual of the CP type your are using!
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Configuration Table

The following figure shows an example of a configuration after configuring in the
“Master System Configuration Table” with the detailed view of a selected slave.

[ HW Config - [SIMATIC 300 DP-Master [Configuration] -- PROJECT-PROFIBUS]

Eﬂ] Station Edit Paste PLC “iew Options 'Window Help

D82 (%] & =2 salsl =@ 28 w2

== (0] UR
1 P5307 104
2 CPUZ140)
3
4 DI/0 16x24/0 54,
5 CF 3425 BGR(5)
5
7
5 PROFIBUS (1) (120)
5
10
11

1] |
ﬂ (12) CP 3425 BGR(4)

Slat Module £ 0. | Order number | Address [ Address Comment
0 25 Univerzal module |09

1 a1 Univerzal module 0.9

2

Prezz F1 to get Help.

Figure 4-5  “Master System Configuration Table” with Detailed View of a DP Slave

Size of the Total Area
The following limit applies to the entire DP data area:
¢ DP total input/output area; each max. 2160 bytes

The areas must always be continuous since only the start address and the length
of the DP process image is transferred on the DP transfer interface.

Note

Please note any differences as explained in the product information bulletin /
manual /2/ of the CP type your are using!
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DP Data Area in the Process Image

If the DP data area is located in the process image, the available area is not only
restricted by the values mentioned above but also by the following:

lengthppmax = leNgthprocess image — 1€NGthy/0s occupied centrally;

Note

Remember that the input and output addresses shown in the configuration table
are address offsets, in other words addresses relative to the DP data areas
specified in the FC call (see also Figure 4-4).
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4.5 Assigning Parameters for the DP Master System

Procedure
To assign parameters for a DP master system, follow the procedure described in
the “STEP 7 Manual” /9/ in the chapter “Configuring the Distributed 1/0 (DP)”.
Steps STEP 7 Dialog
Set the DP master parameters and bus parameters Properties
DP master
Set the DP slave parameters Properties
DP slave

\

Assign the modules/IDs of the DP slaves

l

Assign the DP slaves to SYNC/FREEZE groups Properties
DP master system

\

Save the parameter assignment

The steps marked in gray differ from the procedure described in /9/ and are
explained below in greater detail.

4.5.1 Synchronization of the Data Output

Synchronization of the Data Output Using Global Control SYNC / UNSYNC

By programming a global control job (SYNC) you can synchronize the updating of
the data at the process outputs.

Example of an application:

A manufacturing process must only be started by the output of several binary
signals when the required devices have indicated that they have completed
their start up. The signal output must be exactly synchronized.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-97

C79000-G8976-C181-05



4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

Global Control Job and Synchronization Frames

The PROFIBUS CP is instructed by the user program to send a synchronization
frame (global control frame) once acyclically by transferring a DP_CTRL function.

The synchronization frame is always sent to the DP slaves at the end of a transfer
cycle. This updates the process outputs on the DP slaves belonging to the
addressed slave group. The process outputs can then no longer be changed until a
further synchronization frame is sent.

Table 4-1  Overview of the Types of Synchronization for DP Data Output

Type of Procedure Application / Uses Configuration
Synchronization Parameter
and Global “Group
Control Identification”
No The DP slaves update the Fastest possible updating of the | not relevant
synchronization process outputs immediately process outputs.

after receiving an output frame.

Synchronization | As a result of the control job Controlled updating relevant and

of the data output | from the user program, one * To achieve synchronization | €an be

with SYNC synchronization frame is sent at at a specific point in time. referenced in
the end of the transfer cycle. the control call

* To update the data of a
group of slaves at the same
time providing that all DP
slaves are in the data
transfer phase.

The updating of the process
outputs is then synchronized.

Requirements for the Synchronous Mode

The PROFIBUS CP only accepts the synchronization frame job when all the DP
slaves to be addressed with the control job are in the data transfer phase. If this is
not the case, the control job is not processed.

The DP slaves only accept synchronization if they support the synchronization
mode. If a group of DP slaves is addressed, the synchronization mode must be
supported by all the DP slaves in the group.

You can configure the system so that when the DP slave starts up it is checked to
establish whether or not it supports the SYNC mode (see also the STEP 7 User
Manual /9/).

Switching the SYNC Mode On/Off

The synchronization mode is switched on when the first SYNC synchronization
frame is sent to the DP slaves.

The synchronization mode is switched off when the UNSYNC synchronization
frame is sent to the DP slaves.
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4.5.2

Synchronization (Freezing) of the Data Input

Synchronization of the Data Input Using Global Control FREEZE/ UNFREEZE

Using the global control jobs FREEZE/UNFREEZE, you can make sure that the
process inputs on the DP slaves are read in once. The data that have been read
remain “frozen” until a further FREEZE command allows them to be updated
again.

Example of application:

Time-controlled logging of process values.

Control Job and Synchronization Frame

Synchronization frames (global control frame with the job parameter FREEZE) are
sent by the PROFIBUS CP to the DP slaves once. The PROFIBUS CP must first
be instructed to send a synchronization frame by the user program transferring the
DP_CTRL function.

The process inputs on the DP slave are then protected from any further change
until a further synchronization frame (global control job with job parameter
FREEZE/UNFREEZE) is sent.

Table 4-2  Overview of the Types of Synchronization for DP Data Input

Type of Procedure Application / Uses Configuration
Synchronization Parameter
and Global “Group
Control Identification”
No The DP slaves update the Fastest possible updating of the | not relevant
synchronization process inputs immediately process inputs.
when they receive an input
frame.
Synchronization | As a result of the control job Controlled, simultaneous relevant and
of data input with | from the user program, one scanning of process signals. can be
FREEZE synchronization frame is sent at referenced in
the end of the transfer cycle. the control call
The process inputs are then
frozen.
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Requirements for the FREEZE Mode

The PROFIBUS CP only accepts the synchronization frame job when all the DP
slaves to be addressed with the control job are in the data transfer phase. If this is
not the case, the control job is not processed.

The DP slaves only accept the FREEZE mode if they support the FREEZE mode.
If a group of DP slaves is addressed, the FREEZE mode must be supported by all
the DP slaves in the group.

You can configure the system so that when the DP slave starts up it is checked to
establish whether or not it supports the FREEZE mode (see also the STEP 7 User
Manual /9/).

Switching the FREEZE Mode On/Off

A-100

The synchronization mode is switched on when the first FREEZE synchronization
frame is sent to the DP slaves.

The synchronization mode is switched off when the UNFREEZE synchronization
frame is sent to the DP slaves.
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4.6 Checking or Setting the CP Mode DP Master

Overview

When you create a DP master system by entering the PROFIBUS CP in the
configuration table as described in Section 4.4 and in /9/, the CP is configured
automatically for the DP master mode.

Checking the Setting - Procedure

To check the mode setting in the “Operating Mode” tab in the properties dialog,
follow the steps outlined below:

1. Select the PROFIBUS CP in the hardware configuration.

2. Select Edit » Object Properties. Select the “Operating Mode” tab in the dialog
as shown below:

Properties - CP 342-5 - [R0/55]) |

Generall Addrezzes  Dperating Mode | Dptionsl Diagnusticsl

DP delay time [ms]: IEI.EI

" DP glave
¥ The module is an activenede an the EREEEUE subnet

I &ster: Shatiar:
el s
e [ A e [
|rtertare madile st

DP mode: I 57-compatible j

Cancel Help

Figure 4-6  Example of the Properties Dialog for a PROFIBUS CP with the DP Master Function

You will see that the DP master mode is already activated in the properties dialog.
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Note

If you change the mode from DP master to DP slave and confirm the change, the
DP master configuration is deleted!

Other Possibilities

There are other ways of setting or changing the mode
e Using a job in the user program of local CPU;

Using the job in the user program, you can adapt both the CP mode and the
PROFIBUS address dynamically to the situation in your plant.

For an example, refer to Section 3.4.1

Reaction Time of the Master

The PROFIBUS CP processes the pending communication jobs cyclically. You can
determine the time response using the parameters used below.

To allow parallel operation of DP and other protocols, the time response of the
PROFIBUS CP must be adapted using the DP delay time setting (Tagqon)- With
this setting you can delay the DP protocol to make sure that there is time available
for handling other jobs (for example FDL connections).

The “DP Reaction Time” field always contains the value of the expected polling
cycle time (Tpo) + DP delay time (Tagdon), in other words if the delay is changed,
the reaction time will be recalculated immediately and displayed.

Remember that an estimated DP reaction time is displayed. The real DP reaction
time can be displayed in the diagnostic buffer when using diagnostic functions.

Table 4-3 Parameters for the “DP Reaction Time” Dialog Box

Parameter 1/0 Explanation Possible Values
[Default]
DP Delay | Here, you can set an additional waiting time that Depending on CP type:
Time must elapse after the polling list has been in 1 ms steps:
processed until it is processed again. 0to 100 ms
Once all the jobs in the DP polling list have been . or
processed, the processing of the DP polling list only in 100 us steps:
starts again after the DP delay time has elapsed. 0.0t0 100.0 ms
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Note

It is important to remember that if you are using a mixed mode, the token rotation
time (TTR) plays an important role in the calculation of the DP reaction time. If the
actual token rotation time is much shorter than the configured TTR, the actual
reaction time is very much shorter.
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4.7 Programming DP Communication

Updating DP Data Areas

Programmed FC calls in the user program of the CPU trigger the transfer of the
DP data areas to the PROFIBUS CP and monitor the transfer. The location of the
DP data area is specified in the call parameters of the FC.

Functions

To activate DP in the control program, there are four functions (FCs) available, as
follows:

e DP_SEND
This block transfers the data of a specified DP output area to the PROFIBUS
CP for output to the distributed I/Os.

e DP_RECV
This block receives the processed data of the distributed 1/0Os and status
information in a specified DP input area.

e DP_CTRL
This block executes control functions for the distributed 1/Os.

« DP_DIAG
This block queries diagnostic data on the DP master and DP slaves.

Initializing a DP Master

The DP master must be initialized with an initial block call. You can either use the
first call of FC DP-SEND or FC DP-RECV.

At the first call, the response is as follows depending on the FC used:
e DP-SEND

If DP-SEND is used for initialization, the data area transferred is not adopted
and the output value "0” is sent to the DP slaves.

The next DP-SEND call sends the transferred user data.

e DP-RECV
If DP-RECV is used for initialization, the received data is not adopted.
The next DP-RECYV call returns the received user data.

A typical sequence for the end of the initialization is outlined below.

CPU Cycle

One possible sequence in which the DP functions (FCs) can be used in
conjunction with organization and program blocks in the CPU cycle is shown
below.
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The example illustrates a situation in which process data are read in at the
beginning of the CPU cycle and the output data generated after the user programs

have been run are output to the process 1/Os.

A separate diagnostic program is included for monitoring the DP slaves.

One of the user programs also sends a control job, for example a synchronization
job for output data. This synchronization job could, for example, apply to the group
of slaves whose process variables are processed by this user program.

v

\
Lol ':H oP_FECY

* Diagnostic

program

DP_DIAG

DP_CTRL

User
program 2

T

4 ;_T DP_SEND

Write PIQ

Legend: = sequence of the CPU
cycle

Figure 4-7  Typical Sequence of DP Function Calls in the CPU Cycle
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Examples

Examples of calls and a detailed explanation of the call parameters for the FCs can
be found in the following:

¢ in the programming manual /6/;
e and the NCM S7 “Primer” /5/.

S7-CPs for PROFIBUS Configuring and Commissioning
A-106 Release 09/2011

C79000-G8976-C181-05



4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

4.8 Changing the Mode of the DP Master

DP Modes

The following modes of the DP master are described in greater detail in
Section 4.3.2:

« OFFLINE
. STOP%
. CLEAR
« RUN

... ) Note: With newer modules (refer to the information in the manual), the STOP
#° mode is now the OFFLINE mode.

Changing DP Modes
The mode of the DP master can be changed as follows:
e By system events or user intervention:
- Switch setting on the PROFIBUS CP or CPU or using the PG functions
- Other disturbances (for example problems on the bus)
e By a DP Start/Stop control job in the user program.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-107

C79000-G8976-C181-05



4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

4.8.1

DP Mode Changes Caused by System Events or
User Intervention

PG Function or Switch Setting

The following table describes the mode changes that can be caused by system
events or user interventions.

Table 4-4  Reactions to PG Functions or Changed Switch Settings on the CP or CPU
Event Initial Mode Resulting Change in the Behavior of the DP Master
on the DP | Mode on the
Master DP Master
CPU RUN CLEAR - sends DP status “Clear”
Run->Stop (default mode) | - sends ’0’ to all slaves with process output
CPU CLEAR RUN - sends process values to all slaves with process
Stop—>Run | (default mode) output
CP RUN, OFFLINE - stops cyclic updating and releases the DP slaves for
Run->Stop (default mode) | other DP masters.
CpP OFFLINE RUN - startup
Stop—>Run | (default mode)

Resulting Mode

The resulting mode is the default mode shown in the table. Depending on the
system status and on the defaults selected with DP_CTRL, other modes are
possible (for the priority of the modes refer to Section 4.3.2).

Changing the Default Mode

A-108

Using a control job DP_CTRL, a different default mode resulting from CPU run ->
stop or CPU run -> stop/stop —> run can be selected.
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4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

4.8.2 Control Job in the User Program

Control Job with DP_CTRL

The DP_CTRL function (see /6/) provides you, among other things, with the DP
start-stop job type. This allows you to influence the operation of the DP system
directly, in other words you can request the RUN, STOP, OFFLINE, CLEAR modes
directly.

Whether or not the job can be executed as specified, depends on the current
system status.
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4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

4.9 Reading Input/Output Data as DP Master (Class 2)

A DP Master (Class 2) Can only “Read”

The PROFIBUS CP acting as a DP master class 2, can read the input and output
data of any DP slave not assigned to it.

This function, for example, allows a process signal to be acquired by several DP
masters and can save sensors in the field (shared input/shared output).

Programming devices, diagnostic or management devices typically operate in the
role of DP master (class 2).

Reading Input/Output Data

The reading of input/output data of a “third—party” DP slave is achieved with the
DP-DIAG FC. The data read is then available directly in the received data area of
the FC.
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4 DP Master Mode with a PROFIBUS CP in a SIMATIC S7-300

4.10 Activating/Deactivating DP Slaves

Application and Uses

To be able to activate or deactivate individual DP slaves on PROFIBUS DP during
operation, there are suitable job types available in the DP-CTRL FC.

This means that all the DP slaves that might be used can already be included in
the configuration of the system. DP slaves that have been configured, but do not
yet exist, can be deactivated. This reduces the numbers of frames on the network.

If configured slaves are physically added later, they simply need to be activated.

This function can also be extremely useful in applications in which mobile DP
slaves dock on or off on PROFIBUS DP (for example in transport systems)).

S7 -300 PROFIBUS CP

DP master (class 1)

PROFIBUS

Configured DP Actlvgte /
subsystem with deactivate
DP Slave

activated and
deactivated DP slaves

Figure 4-8  Example of a DP Master System with Activated and Deactivated DP Slaves

Using FC DP-CTRL

You activate or deactivate a DP slave by triggering a DP-CTRL job once (CTYPE 9
and 10; see /6/).

Tip:

For more information on this topic, refer to the samples and explanations on the
SIMATIC NET CD-ROM “Quick Start”. [
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5 DP Diagnostics from the User Program of a
SIMATIC S7-300

The DP diagnostics described in this chapter are programmed in the user program.
Diagnostics are intended primarily to increase the operating reliability of a DP
master system by detecting the statuses of the DP slaves.

DP diagnostics is a powerful aid to troubleshooting during installation and operation
of DP stations on PROFIBUS.

Note

The user program interface for DP diagnostics described here is only available
for the SIMATIC S7 DP master with PROFIBUS CP.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

5.1 DP Diagnostic Options

Diagnostic Aims

The main aim of the diagnostic functions is to check that the connected DP slaves

are ready for operation and to obtain information about the causes of any problems
that may occur.

Diagnostic Functions
The DP diagnostic functions allow you to determine the following aspects:
¢ Which of the connected DP slave stations is not responding on PROFIBUS?
¢ Which of the connected DP slave stations has diagnostic data available?
e Which problems are affecting specific stations?

In addition to these functions, there are further functions that depend on the

diagnostic path and diagnostic tool such as status queries started by the user
program.

Diagnostic Options and Tools

The diagnostic functions can be operated in the following ways with the following
tools:

¢ In conjunction with the user program in the CPU
e With the diagnostic tool on the PG (dealt with in Chapter 8);

e By activating diagnostic functions on masters (class 2).

Application

The functions are designed so that the different diagnostic strategies can be
combined and tailored to your needs. It is also possible to use the individual
functions completely separately from each other.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-113

C79000-G8976-C181-05



5 DP Diagnostics from the User Program of a SIMATIC S7-300

5.2 Calling Diagnostic Functions in the User Program

Overview

By including diagnostic functions in the user program, you can achieve continuous
monitoring of the DP slaves and their modules.

Integration in the User Program

Diagnostic functions are started in the user program by calling the DP_DIAG
function. The actual diagnostics is achieved by evaluating the diagnostic values
transferred to the diagnostic lists by the FC.

You can make the DP_DIAG call and the evaluation of the diagnostic lists
dependent on status bits in the DPSTATUS status byte of the DP_RECV function
(FC).

Diagnostic Sequence

The following diagram illustrates the decisions you can make when implementing
diagnostic functions.

Query DPSTATUS status byte
(parameter in FC DP_RECV)

Evaluation of station list useful Evaluation of diagnostic list
useful

Read station list Read diagnostic list

(FC DP_DIAG) (FC DP_DIAG)

Detect stations with new
diagnostic data

Single
diagnostics
(FC DP_DIAG)

Figure 5-1 Decision Paths for Conditional Diagnostics
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Integration in the CPU Cycle

One possible method of integrating the FCs in the CPU cycle for diagnostic
purposes using organization and function blocks of the user program is shown

below:
OB DP_RECV
Diagnostic
processing
DP_DIAG
—>
DP_DIAG
B
DP_DIAG
User
programs
DP_SEND

<G=2 ReadDP input

Read status byte

@ Read DP station list
@ Read DP diagnostic list

Read DP single diagnostic
data

@ Write DP output

Figure 5-2  Typical Sequence of DP Function Block Calls in the CPU Cycle with Diagnostic Processing

Structure of the Status Byte (see also /6/)

The DPSTATUS status byte transferred to the DP_RECV function for a conditional

diagnostic data query has the following structure:

76 5 43 2 1 0
LI T I I [ [ Jof
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Table 5-1  Meaning of the DPSTATUS Bits Relevant for Diagnostics (extract from Table 5-1
in /6/)

Bit Meaning

2 0: no new diagnostic data exist

1: evaluation of DP diagnostic list useful; at least one station has new
diagnostic data

1 0: all DP slaves in the data transfer phase
1: evaluation of the DP station list useful
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

5.3 The DP Station List

The DP station list provides information about the status and availability of all the
DP slaves assigned to the DP master during the configuration phase.

The station list is kept on the PROFIBUS CP and updated continuously in the CP
polling cycle. The list is enabled once the DP_RECYV function has been run through

without an error occurring. After it has been read out, the station list is then
disabled again.

5.3.1 Structure of the Station List

Relationship Between DP_RECV and DP_DIAG

The station list read in always matches the last input data read with DP_RECYV,

regardless of the number of polling cycles run through between the DP_RECYV call
and the DP_DIAG call.

Format of the Station List

The DP station list has a length of 16 bytes or 128 bits. Each bit of the DP station

list corresponds to a PROFIBUS address and therefore to a potential DP slave
station.

Byte 0 1 2-14 15
Status 7 6 5 43 2107 6 543 210 7 6 5 43 210

it [ [T TP TP T RTTTTI]] HEEEEEE

Station 0 1 2 3 4 5 6 7|8 9 10 11 12 13 14 15 120 127
address*)

*) The bit for the station address 127 is irrelevant since the permitted range for DP slave addresses on the
PROFIBUS bus is between 0 and 126.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Meaning of the Status Bits

The coding of the status bits has the following meaning:

Table 5-2  Coding of the DP Station List

Bit Coding Meaning

0 The following meanings are possible:
* The configured slave station is in the cyclic data transfer phase.
or

* The station was configured with input/output data length “0”, in other words, the
station is not processed cyclically by the DP master.

or
® The station address is not used.

1 The station is not in the cyclic data transfer phase.
The following reasons are possible:

* The configured slave station does not exist on the bus or is not responding on the
bus.

* The configured slave station is incorrectly configured.

* The configured slave station is not ready for data transfer with the DP master (still in
the startup phase).

5.3.2 Read out DP Station List

Evaluating the Status Byte

With the group message “DP station list evaluation useful” the DPSTATUS status
byte indicates that at least one of the configured DP slave stations is not in the
data transfer phase. To identify such stations, the DP station list must be
requested and evaluated.

Call in the user program

The DP_DIAG function is used to read out the DP station list. The necessary
parameters are explained in the description of the block. DP_DIAG is described in
/6].

The DP station list can be read out once after each successfully completed
DP-RECV call regardless of the status byte.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Behavior after intitialization of the DP master

If you use FC DP-RECYV to initialize the DP master, you should not read out the
station list immediately afterwards. The DP master remains in the startup phase for
some time. During this phase, the station list does not yet match the actual plant

situation.

Saving the Station List

The station list can be read into a data block or a bit memory area on the CPU.
The address must be specified in the DP-DIAG block call.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

5.4

DP Single Diagnostics

Purpose of Single Diagnostics

Overview

5.4.1

Purpose

DP single diagnostics allows diagnostic data to be fetched from specific slaves.
These diagnostic data are encoded according to the DP standard with
supplementary information in the third status byte (see Table 5-6).

DP single diagnostics is generally triggered depending on the result of the
diagnostic list evaluation. It is, however, possible to start a single diagnostic job
regardless of other statuses.

The DP Diagnostic List

The DP diagnostic list provides information about the DP slaves with changed
diagnostic data. The diagnostic data themselves must be fetched with the single
diagnostics function.

The diagnostic list is kept on the PROFIBUS CP and constantly updated in the DP
polling cycle. The updating is achieved by high-priority messages from the DP
slaves as soon as the diagnostic information has changed on one of the slaves.
Entries can also be made by the DP master.

After the user program has read out the diagnostic list once, the diagnostic list is
disabled. The diagnostic list can only be enabled again when at least one new
entry exists. Reading single diagnostics is possible at any time.

Format of the Diagnostic List

A-120

The DP diagnostic list has a length of 16 bytes or 128 bits. Each bit in the DP
diagnostic list corresponds to a PROFIBUS address and therefore to a possible
DP slave station.

Byte 0 1 2-14 15
Diagnostic 7 6 5 4 3 2 1 07 6 5 4 3 2 10 7 6 5 4 3 2 10
bit HEEEEEEEEEREEN [ [T T]
Station 0 1 2 3 4 5 6 7|8 9 10 11 12 13 14 15 120 127
address”

*) The bit for the station address 127 is irrelevant since the permitted range for DP slave addresses on the
PROFIBUS bus is between 0 and 126.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Meaning of the Diagnostic Bits

Table 5-3  Coding of the DP Diagnostic List

Bit Coding Meaning

The following meanings are possible (one excludes the other):
* The configured DP slave station has no new diagnostic data,
* The station address is not used.

The configured DP slave station has new diagnostic data. These can be fetched
with the single diagnostics function.

Initialization Phase

5.4.2

During the initialization phase of the master (parameter assignment, configuration),
the diagnostic messages in the diagnostic list are ignored (the diagnostic bits are
initialized with 0). If an error occurs during the initialization phase of a DP slave,
the diagnostic bit of this station is set to 1.

Reading out the DP Diagnostic List

Evaluating the Status Byte

With the group message “DP station list evaluation useful” the status byte indicates
that diagnostic data have changed on at least one of the configured DP slave
stations. To identify such stations, the DP station list must be requested and
evaluated.

User program

The DP_DIAG function is used to read out the DP station list. The necessary
parameters are explained in the description of the block. DP_DIAG is described in
/6].

The DP diagnostic list can only be read out when there are new diagnostic data for
at least one station.

Saving the Diagnostic List

The station list can be read into a data block or a bit memory area on the CPU.
The address must be specified in the DP-DIAG block call.

Note: Reading into the process image (PI) is possible but achieves nothing.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Response

Note the following response during execution and on the interface to your user
program:

¢ The status “Evaluation of DP diagnostic list useful” in DPSTATUS is reset by
reading the diagnostic list.

¢ The station-related bits in the diagnostic list stored on the CP are reset after
reading out the relevant single diagnostics information.

Note

If the single diagnostics information is read before the diagnostic list is evaluated,
neither the bits in DPSTATUS nor the bits in the diagnostic list will be reset!

5.4.3 Reading out DP Single Diagnostics

Application Program

The DP_DIAG function is used to read out the DP single diagnostic data. The
necessary parameters are explained in the description of the block. DP_DIAG is
described in /6/.

Saving the Diagnostic Data

The DP diagnostic data can be read into a data block or a bit memory area on the
CPU. The address must be specified in the DP-DIAG block call.
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5 DP Diagnostics from the User Program of a SIMATIC S7-300

Structure of the Diagnostic Data

The following diagram provides an overview of the structure. A more detailed
representation of the diagnostic information with the extended DP slave
diagnostics can be found in Table 5-4.

1st byte Station status byte 1

2nd byte Station status byte 2 Station status bytes

3rd byte Station status byte 3 PROFIBUS address of DP master that assigned
parameters to the DP slave (FFy = no parameters

4th byte Master address } yet; FEH = not yet obtained on PROFIBUS)

5th byte (high byte) Ident_number

6th byte (low byte) Vendor ID dependent on slave type

7th byte Extended DP slave diagnostics,

specifically for the addressed DP slave.
The list can contain the following
elements:
} - Device-related diagnostic data
- ID-related diagnostic data Module
- Channel-related diagnostic data statuses

Diagnostic information

max. 240th byte /

Figure 5-3 Basic Structure of the Single Diagnostic Data

Note

The total length of the data record is 4 bytes shorter than the length in the DP
standard. Instead of the maximum possible 244 bytes, only 240 bytes are
permitted for operation with the PROFIBUS CP in a SIMATIC S7-300.

Structure of the Station Status Bytes

The coding of the station status bytes is explained in the following tables.

Table 5-4  Structure of the Station Status Bytes - Station Status Byte 1

Bit No. Meaning Explanation
7 MasterLock The DP slave has been assigned parameters by a different DP
master, in other words, the DP slave can only be read by the local
DP master.

This bit is set by the CP (DP master), when the master address is
not FFy and is different from the CP bus address.

6 ParameterFault The last parameter assignment frame received was incorrect or
not permitted.

Remedy:

Check the parameter assignment for illegal parameters.
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Table 5-4  Structure of the Station Status Bytes - Station Status Byte 1

Bit No. Meaning Explanation

5 InvalidSlaveResponse This bit is set by the CP (DP master) when no plausible response
has been received from the DP slave.
(Various causes possible).

4 ServiceNotSupported The requested functions (for example, SYNC mode, FREEZE
mode) are not supported by the DP slave.
Remedy:
For example, switch off the SYNC/FREEZE check or do not send
any SYNC/FREEZE jobs.

3 ExtDiagMessage Bit = 1 (Ext_Diag) means: Important slave-specific diagnostic
data exist. The module statuses/device-related diagnostics

ExtStatusMessage should be evaluated.

Bit = 0 (Ext_Status_Message) means: Information or a message
may exist. The additional information (module
statuses/device-related diagnostics) can be evaluated.

2 SlaveConfigCheckFault Configuration data received from the DP master are rejected by
the DP slave.
Cause/remedy:
For example, incorrect module configuration -> check the
diagnostic buffer in NCM S7 for PROFIBUS.

1 StationNotReady The DP slave is not yet ready for parameter assignment and data
exchange.
Remedy:
Temporary status, this cannot be influenced by the DP master.

0 StationNonExistent The DP slave is not responding on the bus. This bit is set by the
CP (DP master 1).

Table 5-5  Structure of the Station Status Bytes - Station Status Byte 2
Bit No. Meaning Explanation

7 Deactivated The DP slave is not being polled by its own DP master 1. Cyclic
reading is possible.

6 Reserved -

SyncMode The DP slave is in the SYNC mode

4 FreezeMode The DP slave is in the FREEZE mode

3 WatchdogOn The watchdog is activated on the DP slave.

2 StatusFromSlave Bit = 1: the diagnostic data is from a DP slave.
Bit = 0: the diagnostic data is from DP master 1
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Table 5-5  Structure of the Station Status Bytes - Station Status Byte 2

Bit No. Meaning Explanation
1 StaticDiag Static diagnostics
The DP slave cannot transfer data at present.If this bit is set, the
DP master must fetch diagnostic data from the DP slave until the
bit is reset by the DP slave.
0 ParameterRequest This bit is set by the DP slave when it requires a new parameter
assignment or must be configured.

Table 5-6  Structure of the Station Status Bytes - Station Status Byte 3

Bit No. Meaning Explanation

7 ExtDataOverflow If this bit is set, there is more diagnostic information available than
can be displayed in the extended diagnostic data. You cannot,
however, display this data.

This bit is set by the DP slave or CP (DP master 1).

6 -5 | DP_Station_State Status of the DP master

00 RUN
01 CLEAR
10 STOP
11 OFFLINE

This bit is set by the CP (DP master 1).

4 Polling_By_Master The DP slave is polled by its own DP master.

This bit is set by the CP (DP master 1).

3 More_Ext_Dia_Data_Exist | During the data transfer phase, the DP slaves send more
diagnostic data than the DP master class 1 (= parameter
assignment master) can evaluate. This diagnostic frame is then
ignored by the DP master class 1 but can be read by the CPU
acting as DP master class 2.

The maximum diagnostic data length that can be evaluated in the
DP master class 1 is 244 bytes
This bit is set by the CP (DP master 1).
2 Master_Not_In_Ring The DP master is not on the bus.
This bit is set by the CP (DP master 1).
1 MasterConfigCheckFault | The DP master rejects the configured slave module list as
incorrect.
Cause / Remedy:
For example, incorrect module configuration (number, order) —>
check the diagnostic buffer in NCM S7.
This bit is set by the CP (DP master 1).
0 Actual_Diagnose The diagnostic data are up-to-date (1) or are older stored

diagnostic data (0).
(Older, stored diagnostic data are read out according to the
principle last in first out —> see /6/.)

This bit is set by the CP (DP master 1).
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6 Configuring and Programming the DP Slave
Mode with an S7-300 System

A SIMATIC S7 PLC with a PROFIBUS CP in the DP slave mode is suitable for
applications in which intelligent preprocessing of process signals is required locally.

This chapter explains the following:

e Which data areas in the CPU are addressed as DP data areas by the CPU user
program.

¢ What you need to do to trigger and monitor communication.

¢ What you need to program in the user program and what you need to configure
with STEP 7.

Please check the documentation /2/ accompanying your CP to find out whether
your PROFIBUS CP supports the DP slave mode.

Further information is available from the following sources:
ﬂ ¢ For other topics involving the DP slave mode with the PROFIBUS CP, such as:
- integrating the PROFIBUS CP in PROFIBUS
- programming functions (FCs) for DP
- DP diagnostics
- the use of the NCM S7 for PROFIBUS configuration software
- configuring the PROFIBUS CP as DP master in an S7-300
refer to the other chapters in this manual.

¢ For configuring and programming DP masters (for example SIMATIC S5 PLC
with CP 5430/5431, PC with CP 5613/5614 or IM 308-B/C) read the relevant
user manual.
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6 Configuring and Programming the DP Slave Mode with an S7-300 System

6.1 Procedure
Steps
The following steps are necessary to allow you to operate a DP master system
with a SIMATIC S7 PLC acting as the DP slave:
Configuring Programming
Configure the PROFIBUS CP as a DP slave for Write the user program for the SIMATIC S7 DP
data exchange using PROFIBUS DP. Slave and download the program to the
See Section 6.3 SIMATIC S7 CPU. See Section 6.4
Commissioning
/
Start up and test the DP slave and
DP master during operation on the
PROFIBUS
If errors occur in the DP communication,
use diagnostic functions.
Configuring

The PROFIBUS CP must be supplied the following as a PROFIBUS node:
¢ A PROFIBUS address
e Bus parameters

This information is configured and downloaded to the PROFIBUS CP.
Configuring the bus parameters is described in Chapter 3.

Programming

By programming, you specify the sequence of the user program and access to the
I/O data. The following must be programmed on the CPU:

1. Writing or reading process data in the DP data buffer.

2. The DP communication in the CPU program. Here, you use the FCs
(DP_SEND or DP_RECV).

How you use the functions (FCs) for the DP slave mode in your user program is
described in the following sections of this chapter. The exact syntax of the FCs and
the meaning of the block parameters is described in /6/.

Note

If you are familiar with the functions of the PROFIBUS CP/DP slaves, you can skip
the next section and continue at Section 6.3.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-127

C79000-G8976-C181-05



6 Configuring and Programming the DP Slave Mode with an S7-300 System

6.2 How the SIMATIC S7 PLC Operates in the DP Slave Mode
with the PROFIBUS CP

Characteristics

The following features characterize the way in which the PROFIBUS CP transfers
data in the DP slave mode.

e The PROFIBUS-DP interface of the PROFIBUS CP operates in compliance
with PROFIBUS DP, EN 50170 Vol. 2.

¢ The DP slave mode allows process data that were preprocessed in the user
program of the DP slave to be transferred to the DP master. In the other
direction it allows data to be received from the DP master, further processed in
the user program of the DP slave and output to the process.

e The PROFIBUS CP operating as a DP slave cannot be activated as a DP
master at the same time.

Tasks of the PROFIBUS CP

The PROFIBUS CP performs the following tasks when handling the DP data
exchange with the DP master (see also Figure 6-1):

1. Receiving frames from the DP master
— used for parameter assignment and configuration
- that contain process output data and passing on the data to the CPU

- that set the PROFIBUS address and the mode (DP master, DP slave active,
DP slave passive, no DP mode, see Section 4.6);

2. Receiving input data from the DP data area of the CPU and preparing the data
for the DP master.

3. Preparing diagnostic data that can be fetched and evaluated by the DP master.

4. Preparing input and output data to be read by masters of class 2 (master class
2 services supported: “read input data RD_Inp” and “read output data
RD_Outp”).

Addressing an S7-300 as a DP Slave

A SIMATIC S7-300 operating with a PROFIBUS CP in the DP slave role, can be
addressed by the DP master as a compact or modular device. When configuring
on the DP master, the generic device description (GSD) is available.

Area of Consistency

The area of consistency is always the entire input and output data area of the DP
slave. This applies regardless of whether the DP master addresses the DP slave
as a compact or modular device.
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6 Configuring and Programming the DP Slave Mode with an S7-300 System

Note

Please note any differences as explained in the documentation /2/ of the CP type
your are using!

Active or Passive Station in the DP Slave Mode

The PLC operated with an PROFIBUS CP is normally also operated on the
PROFIBUS in the active DP slave mode. This makes it possible to use other
communications services such as FDL connections, S7 communication, or PG
functions in addition to the slave functions.

It is also possible, to configure the DP slave exclusively as a passive station on the
bus. This is necessary in system configurations in which only the DP master can
be an active station on the bus or when the number of active stations must be
limited. Remember that PG functions and other communication services are not
possible via a CP configured as passive.

PROFIBUS Address and Bus Parameters

The transmission rate and PROFIBUS address must be identical to those set on
the DP master.

The transmission rate, the PROFIBUS address and the mode (DP master, DP
slave active, DP slave passive, no DP mode, see Section 4.6) are set by
configuring in STEP 7 (see Chapter 3).

The PROFIBUS CP adopts these settings after the configured data have been
downloaded.

It is not possible to set these parameters using parameter assignment frames.

The PROFIBUS address and the mode (DP master, DP slave active, DP slave
passive, no DP mode, see Section 4.6) can be set as follows:

e By configuring;

The CP adopts this setting after the configured data have been downloaded.
This variant is described for setting the mode in this chapter. This is the
standard situation for a fixed setting.

e Using a job in the user program;

For an example, refer to Section 3.4.1
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6 Configuring and Programming the DP Slave Mode with an S7-300 System

6.2.1 Principle of Data Exchange

Cyclic Data Exchange between DP Master and DP Slave

Data exchange between the DP master and DP slave is cyclic (DP polling cycle)
and uses send and receive buffers on the PROFIBUS CP (DP data buffers). The
data exchange is started by the DP master that sends output data and fetches
input data.

Data Exchange between CPU and PROFIBUS CP

The data exchange between the CPU and PROFIBUS CP depends on the calls for
the DP_RECV and DP_SEND blocks (FCs) within the CPU cycle.

DP Slave 1 — DP Master —
PROFIBUS CP

CPU

STEP7
user program

CP
database

DP
data areas

DP
data buffer

DP
data areas

Outputs PROFIBUS

DP_RECV

DP_SEND

--a- -).
Inputs

|<— CPU cycle > | - DP polling >
cycle

Figure 6-1 Interaction between the CPU and PROFIBUS CP in the DP Slave Mode

Functions (FCs)
For the data exchange using the STEP 7 user program, two FCs are available:

e DP_RECV
This function takes the DP data transferred by the DP master from the receive
buffer of the PROFIBUS CP and enters them in a specified DP data area on the
CPU.

e DP_SEND
This function transfers the data of a specified DP data area on the CPU to the
send buffer of the PROFIBUS CP for transmission to the DP master.
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CPU Cycle and DP Polling Cycle

The CPU cycle and the DP cycle are independent of each other. The CPU-CP
interface that can be addressed by the user program with the functions DP_SEND
and DP_RECYV is designed so that complete data transfer is ensured when
handled correctly.

Handling correctly means that the data transfer with DP_SEND and the reception
with DP_RECYV requires evaluation of the block status bits in the user program.

For a detailed description of the data exchange with flow charts, refer to the
description of the FCs in /6/.

Area of Consistency

The entire DP input or output data area of the DP slave is included and
consistency during transmission is guaranteed. Here, it does not matter whether
the DP master addresses the DP data area in its entirety or divided into modules.

Note

Please note any differences as explained in the documentation of the CP type
your are using!

DP Data Area on the CPU

DP Data Areas on the CPU

On the CPU, various data areas can be used for communication with the DP
master. Which data area you use depends on the type of PLC and the task in
hand. The following areas are available:

e Process image
This assumed that a continuous input or output area can be reserved for
distributed 1/Os in the process image of the CPU. This can, however, be
restricted by the size of the process image and the number of signal modules
installed centrally.

¢ Bit memory address area
Just like the process image, this area is also suitable for global storage of DP
signals. The bit memory address area can, for example, be used when the
space left free by central signal modules in the process image is too small.

e Data block (DB)
Data blocks can also be used to store DP signals. This location is preferable
when the DP data area is processed by one program block.
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Note

The DP data area for input and output data is always transferred as the entire
area to or from the data areas on the CPU.

The following diagram illustrates the mapping of the DP data buffer of the
PROFIBUS CP on the alternative data areas in the CPU.

Alternative DP data areas in the CPU DP buffers in PROFIBUS CP

max. 240 bytes for input
data block |

max. 240 bytes for output

Bit memory DP buffer for
— input data
image
DP buffer
for output data

Process image for
central signal modules

Figure 6-2  Assignment of the DP Process Image to the CPU Data Areas
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6 Configuring and Programming the DP Slave Mode with an S7-300 System

6.2.3 Initialization and Data Transfer on PROFIBUS

Initialization
Initializing the DP slave mode involves the following:

e Parameter assignment
The parameter assignment specifies how the DP slave operates.

e Configuration
The configuration specifies the structure of the DP slave.

Parameter Assignment

The DP slave is assigned parameters by the DP master by configuring the bus
parameters and by the parameter assignment frame.

Configuration

As DP slave, the PROFIBUS CP requires the following information for the
configuration:

¢ Length of the input data
¢ Length of the output data

The DP slave is configured using the FC calls on the user program interface on the
CPU. The DP slave checks whether the total length contained in the configuration
frame of the DP master is identical to the lengths specified in the FCs. If the
lengths specified for input/output data are not identical, the slave does not change
to the data transfer phase.

Note

Remember that successful parameter assignment and configuration by the DP
master is only possible after local initialization by the DP_RECV FC call for the
output data and the DP_SEND FC call for the input data.
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Reasons for a Re-initialization

In the following situations, the PROFIBUS CP requests reassignment of
parameters/reconfiguration from the DP master:

¢ The length information about the DP data area transferred in the FCs does not
match the information saved on the PROFIBUS CP. A change in length in the
FC calls means a change in configuration. If the PROFIBUS CP is in the data
transfer phase, it changes to the parameter assignment phase. It only changes
back to the data transfer phase when the DP master sends a new parameter
assignment/configuration frame that matches the saved information.

¢ During the data transfer phase, an incorrect parameter assignment frame is
sent.

e The CPU or the PROFIBUS CP change to the STOP mode.

e The watchdog is exceeded (see below).

Note
Check the entries in the diagnostic buffer of the DP slave.

Watchdog

If the watchdog expires, the DP slave assumes that communication with the DP
master has broken down. If no frame is received from the DP master during the
watchdog time, the PROFIBUS CP reacts by resetting and starting up again.

Diagnostic Data

The PROFIBUS CP as DP slave prepares diagnostic data (6 bytes) for the DP
master.
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6.2.4 Global Control Jobs

Meaning

Using a global control frame, the DP master can send global commands to the DP
slave.

The following are defined:

e CLEAR
Control command to change the data output to a safe, defined state.

« SYNC V)
Control command for synchronizing data output.

+ FREEZE"
Control command to freeze data input.

CLEAR

The DP master can reset the outputs in the DP slave using the global control job
CLEAR.

The sequence in the DP slave is as follows:

The CLEAR command causes the DP master to set the outputs in the DP data
buffer area to 0 continuously. Data inputs continue to be read. The next time
DP_RECYV is run through on the DP slave, the reset DP output byte is transferred
to the DP data area of the CPU. The user program receives a message in the
status byte of the FC.

Synchronization SYNC / FREEZE ")

To find out whether the PROFIBUS CP supports the global control frames SYNC
and FREEZE, please refer to the CP documentation /2/.

) The information in the documentation of the PROFIBUS CP /2/ applies.
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6.3

Configuring and Starting the DP Slave Mode

Procedure

A-136

Enter the PROFIBUS CP of the DP slave in the hardware configuration and assign
the CP to the subnet as described in Chapter 3.

The rest of the procedure depends on the type of device and the configuration of
the DP master, as follows:

The DP master is a SIMATIC S7 station configured in the same project as the

DP slave

The DP master is any other type of device

Configure the PROFIBUS CP (assign it to the subnet)

see Chapter 3

DP master = S7 station
in the same project

Configure the DP master
system with STEP 7
see Section 6.3.1

I

Check the CP mode DP
slave
see Section 6.3.2

Other DP master

/

Set the CP mode DP slave
see Section 6.3.2

Specify the configuration of
the DP slave with the
appropriate configuration tool
in the DP master

see Section 6.3.3

\

-

“

_______

_______

optional step

mandatory step
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6.3.1 Assigning the “Intelligent” DP Slave to the DP Master System

Requirements

The procedure of assigning S7 stations with PROFIBUS CPs as intelligent DP
slaves to a DP master system, as described here, assumes the following:

The DP master is a SIMATIC S7 station that was configured in the same project
as the DP slave.

The PROFIBUS CP of the DP slave has been entered in the hardware
configuration and networked. This means that when the DP master system is
then configured, the PROFIBUS CP is configured automatically for the DP
slave mode.

Entering the DP Slave in the Configuration Table

Configure a DP subsystem (DP master system) as follows:

1.

Open the hardware configuration of the S7 station that will act as DP master.

Result: The connection symbol for the DP master system appears beside the
DP master module. —=———2

. Open the hardware catalog and select the entry “PROFIBUS DP/already

configured stations” for the DP slave with a PROFIBUS CP and drag the entry
“6GK...” to the connection symbol.

Result:If stations are configured in the project that can act as intelligent DP
slaves, a dialog “Properties DP Slave” is displayed.
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E{;HW Config - [SIMATIC 300 DP-Master [Configuration] -- PROJECT-PROFIBUS]

E“] Station Edit Paste PLC “iew Optionz Window Help

DlE’;lgml ||.1§'||1r||| @I |aﬁ ﬁln“fml ﬁl EI Hardware catalag

e — Brofile | Standard
1 — PS307 104 =1 Configured Stations
EN ]% CRUZ4(] PROFIBUS [1): (180) @ CPU2DP
EN { B8 PC-Station als [
4 D1A0 1 6u240 /0,54 ED 57-300 CP 342
L Ey BGKT 342
Properties - DP slave E3 Eﬁ EGET 342
. o Urivers

B
General Connection | B BGKT 342
— Configured Slave Controllers I—
42-80a00-0<E0

You can use the PROFIBUS master to connect configured slave contrallers.

Select a slave contraller, then click 'Connect'™ 2 el R Bl

Slawve Control PROFIBUS in Station Slot
Address
CF 342-5 BRG] g SIMATIC 300-5tabon 3] 045/
CP 342-5 BGR(1) 2 SIMATIC 300-Station(1] 045/
CP 342-5 BGR(Z2) B SIMATIC 300-Station(Z2] 045/

[Eormest |

—dctive Connection
<Mo Commection:

Wisconmect |
Cancel | Help |

3. Select the DP slave in question and confirm your selection with OK.

Result:
With this selection, the PROFIBUS CP of the DP slave is automatically
configured for the “DP Slave” mode.

4. As the next step, select one or more universal modules from the hardware
catalog and position it/them in the configuration table. This configures the data
areas of the DP slaves.

5. You must now specify the module or modules in terms of its data types
(input/output) data length and address assignment. You can enter values
directly in the table or select the module and open the object properties.
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6 Configuring and Programming the DP Slave Mode with an S7-300 System

The following figure shows the “Master System Configuration Table” (detailed view)
with one SIMATIC S7 PLC with a PROFIBUS CP as the DP slave. The standard
module was configured with two universal modules; the DP master is a SIMATIC
S7-300 station.

-J4 Hw Config - [SIMATIC 300 DP-M aster [Configuration] -- PROJECT-PROFIBUS]

E“] Station Edit Paste PLC “iew Optionz Window Help - |E Iil
1= T = e e 1 = T 4
= [0] UR Hardware catalog x| =
1 PS307 104 .
2 ]% CPUZTAM)] PROFIBUS (1} (180] Erofile | Standard [ |
3 = Configured Stations ;I
4 DI/0 1 Ex24/0.54 @ CPU 31x2DP J
E CP 342-5 BGR[5) B PC-Station als DP Slave
E =1 57300 CF 3425 DP
7 g BGKT 342-BDA02-0-E
8 EI E EGKT 3425040 0XE
g Universal module
10 P B ‘B GGK7 342- 50Fuuu>_<E|;|
11 1] (B
EGK7 342-E0A00-IXED
CP 3425 als PROFIBUS-DF Slave

-
1| | »

:I [12] CF 342-5BGR[4)

Slat todule £ D... | Order nurnber | Address | O Address Comment

i] 2h Uriverzal module |09 -

1 4 Univergal module 0.9

2 |

3

4

5

G

: -
Press F1 to get Help. ll:_hg
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6.3.2 Checking or Setting the CP Mode DP Slave

DP Slave Mode in the Properties Dialog

The PROFIBUS CP operates as a DP slave when this mode is set in the
“Operating Mode” tab of the properties dialog.

Automatic Recognition of the CP Mode

The DP slave mode to be set for the PROFIBUS CP is detected automatically from
the hardware configuration of the DP master system providing the PROFIBUS CP
is located in the same project and in the same subnet as the DP master.

This situation was described in Section 6.3.1. The properties dialog then indicates
that the DP slave mode has already been selected.

Note

PG functions and test functions via MPI are always possible regardless of the
selected mode.

PG functions and test functions via PROFIBUS are always possible regardless of
the selected mode (exception: DP slave passive).
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Procedure
Follow the steps outlined below to check or modify the setting:
1. Select the PROFIBUS CP in the configuration table.
2. Select Edit»Object Properties. The following dialog is displayed:

Properties - CP 342-5 - {R0{55) [<]
Generﬁll Addresses  Operating Mode |Diﬁgnmstics| Import I
[ B

= [P Ester
Estirmated DEEeactioniime el el e (el i
SO o e O i o = M Ll
B DGy Antae [e]: I

~® DPSlave

W The module is an active node on the PROFIBUS subnet

Iaster: Station: SIMATIC 300 DP-taster
hodule: CP 342-5
Fack (R] / Slot (S): (R0/S5)
Interface Module Slot: =
1 1

Figure 6-3  Example of the Properties Dialog for a PROFIBUS CP with the DP Slave Function

3. If the mode is not already set as a result of the automatic detection function,
click the DP Slave field.

4. If required, select the option “The module is a passive node on PROFIBUS”
- DP slave active (Default)

The PROFIBUS CP is an active node, in other words it can be used for
further communication services such as FDL connections, PG functions or
S7 Functions (passive).

- DP slave passive

The PROFIBUS CP operates exclusively as a DP slave. PG functions and
other protocols using PROFIBUS are not possible.

e Using a job in the user program of the local CPU;

Using the job in the user program, the PROFIBUS address can be adapted
dynamically to the situation in your plant.

This could, for example, be used in redundant systems, one station taking over
the tasks of another, failed station. The PROFIBUS address of the redundant
station is then changed to the address of the previously active station.

For an example, refer to Section 3.4.1
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6.3.3 Notes on Configuring on the DP Master

Basic Data of the DP Slave

From the point of view of the DP master, the following basic data of the
PROFIBUS CP in the role of DP slave must be taken into consideration:

e Standard device database file (GSD file)
The device master data are available in the GSD file for configuring and
assigning parameters.

These contain the following information
- Vendor ID

- Configuration of the DP data area

- Minimum slave interval

- SYNC / FREEZE;

- User-specific data

Obtaining the GSD and Type File

The GSD is supplied with STEP 7 or can be obtained from the Internet under the
following entry ID:

http://support.automation.siemens.com/WW/view/en/113652
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6.4 Programming the DP Slave Mode

Principle of Job and Data Transfer

The DP data area in the CPU is addressed by the user program in the slave CPU
using normal STEP 7 instructions.

In the user program, the transfer of the DP data areas is triggered and successful
execution is monitored. The connected PROFIBUS CP is informed about the
location of the DP data area by address parameters when the FCs are called.

Programming the DP Slave Mode
Use the two FCs on the interface on the user program as follows:
« DP_RECV to receive the DP data from the DP master
* DP_SEND to send the DP data to the DP master.

Purpose of the FC
The FC call has the following effects:
¢ The first time the block is called, the slave configuration is activated.

e The DP data area is transferred to the PROFIBUS CP (DP_SEND) or received
from the PROFIBUS CP (DP_RECV).

¢ The execution of the job is confirmed either positively or negatively in a status
message.

Note

The data area information (SEND parameter for DP_SEND and RECV parameter
for DP_RECV) must match the lengths configured on the DP master and
transferred as a configuration frame.

Evaluate the Code Bits

Evaluate the following bits in the FC blocks:

e in DP_SEND:
the parameters DONE, ERROR and STATUS
e inDP_RECV:

the parameters NDR, ERROR, STATUS and DPSTATUS

Refer to the block description and sample call in /6/.
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Structure of DPSTATUS
You can see the structure and meaning of the bits in DPSTATUS in /6/.

Calling FCs in the CPU Cycle

One possible sequence in which the DP functions can be used in conjunction with
organization and program blocks in the CPU cycle is shown below.

The example illustrates the situation where data transferred by the DP master are
read in at the start of each CPU cycle and the output data generated are output for
transmission to the DP master when the user programs are completed. Whether or
not both FCs are called, depends on the data areas used (inputs / outputs).

v

* OB

User programs

< : Read received

DP_RECV data of the DP
master

<=

® FEvaluate codes of DP-RECV

©® Read the output data sent by
the DP master and if
necessary prepare for
process output.

® (Pre)process the input data
read from the process inputs
and write them to the DP
data area for transfer to the
DP master.

DP SEND é Write send data for

* the DP master
' ® Evaluate codes of DP-SEND

Write PIQ

Legend: = sequence of the CPU
cycle

Figure 6-4  Typical Sequence of DP Function Calls in the CPU Cycle
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6.5 Starting Up a DP Slave

Steps for Startup

The following steps are necessary before a DP slave is ready to exchange data
with the DP master:

1. Download the configuration data to the PROFIBUS CP.
2. Download the user program to the CPU.

3. Start the CPU or make sure that the FCs are executed free of errors.

Result:

The DP slave is ready to be configured and have parameters assigned by the DP
master.

4
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7 Configuring FDL Connections / Programming
the SEND/RECEIVE Interface

FDL connections with the PROFIBUS CP allow program-controlled communication
on PROFIBUS between SIMATIC S7 PLCs and the following:

» SIMATIC S7 PLC with PROFIBUS CP
« SIMATIC S5 with PROFIBUS CP (for example 5430/31)
» SIMATIC S5-95 U with PROFIBUS interface
» PC/PG with PROFIBUS CP (CP 5613)
¢ Devices capable of the SDA and SDN service complying with EN 50170, Vol. 2
This chapter explains the following:
e The characteristics of an FDL connection.
¢ Which data areas can be used on the S7 CPU.
e How to program the SEND/RECEIVE interface in the user program.
ﬂ You will find further information in the following sources:

¢ You will find detailed explanations of how to configure connections in STEP 7:
Help » Contents.

¢ The FCs for programming FDL connections are described in /6/

¢ Inthe PROJECT_PROFIBUS sample project that you can start after installing
NCM S7; you will find a description of this in the primer “Getting Started” /5/.

e For programming and configuring stations for FDL connections (for example a
SIMATIC S5 PLC with the CP 5430/31, SIMATIC S5-95U with a PROFIBUS
interface, PCs with a CP CP 5613), please refer to the appropriate manuals.
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7.1 Procedure

Steps

The following steps are necessary to operate FDL connections in the SIMATIC S7

with the PROFIBUS CP:

Configuring

Configure any “other
stations” for FDL
connections with the

Create new FDL |
|
|
: appropriate
|
|

connections.

configuration tool.

- T T T T T T/ /1

| Configure FDL |
| connection properties. |
L—— 1

Programming

Program the FDL interface in
the user program.

(refer to the information in
Section 7.9.1 and the
detailed description in /6/).

Download FDL connection
configuration data to the CP

necessary steps

_____ optional steps

Figure 7-1 Operating FDL Connections with a PROFIBUS CP
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7.2 Possible Connection Configurations

Connections between Stations Inside and Outside the Project

Communication connections are possible between the communication partners
shown in the diagram below.

The communication partners can be in the same project or distributed in the
subprojects of a multiproject.

Connections to communication partners outside a project are configured using the
STEP 7 object “Partner in other project” or using substitute objects such as “Other
stations” or SIMATIC S5.

PROFIBUS CP
PROFIBUS CP

S7 - 300

PROFIBUS CP

Subnet 1

Subnet 2

C_PROFIBUS cp>

1
1y

e

1 o
o

I

. . L L IO0er |
PG/PC with PROFIBUS CP “Other station” /SIMATIC S5
Figure 7-2  Possible Connections

More than One Subnet

If you want to operate several subnets, then use the appropriate number of
PROFIBUS CPs within a station.

Organization in a Multiproject

If interproject subnets are configured, you can also configure connections over
[ 2 such subnets using STEP 7 V5.2. The endpoints of these connections can be
= located in different projects.
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STEP 7 supports you both when creating interproject connections within a
multiproject as well as when synchronizing connections that were configured
without a multiproject context.
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7.3 SIMATIC S7 PLC with FDL Connections

Application

Data transmission on a configured FDL connection is suitable for the transmission
of related blocks of data between two or more PROFIBUS stations.

The following must be distinguished:

e Specified FDL connection
The communications nodes are specified uniquely by configuring connections.
The connection partner can be within or outside the STEP 7 project.

¢ Unspecified FDL connection (free layer 2 access)

The address of the connection partner is not specified during configuration. The
communications nodes are identified by address information in the
communication job of the user program. This means that up to 126 nodes can
be reached via one configured unspecified FDL connection providing they
support FDL connections.

The connection partner can be within or outside the STEP 7 project.
¢ FDL connection with broadcast

All the nodes ready to receive broadcast messages can be reached on
PROFIBUS.

* FDL connection with multicast

All the nodes belonging to the multicast group can be reached on PROFIBUS.

Tasks of the PROFIBUS CP

The PROFIBUS CP handles the following tasks for data transfer on an FDL
connection:

¢ On specified connections
- When receiving

Receives data from the PROFIBUS and passes them on the user data area
in the CPU.

- When sending

Receives the data from the user data area of the CPU and sends them via
PROFIBUS.
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¢ Additional functions on unspecified connections
- When receiving
Enters the sender and the FDL service in the job header.
- When sending

Evaluates the job header and addresses the partner, executes the selected
FDL service,

Requirement for Configuration

The PROFIBUS CP of the local and remote station were entered in the hardware
configuration and networked with the subnet.

Notice

If you want to use FDL connections, the CP mode of the PROFIBUS CP must not
be set to DP slave passive!

All stations outside the project must be configured with substitute objects (for
example “S5” or “other station”).

Priority of the Frames

Remember that the PROFIBUS CPs for SIMATIC S7 send frames with “LOW”
priority.

Partner stations (SIMATIC S5 or non-SIMATIC stations) must also use the LOW
priority otherwise no connection can be established.
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7.3.1 Specified FDL Connection

Characteristics

A specified FDL connection allows program-controlled communication between two
stations on PROFIBUS with the following characteristics:

¢ The data transfer is bi-directional, in other words, it is possible to transmit and
receive on the FDL connection simultaneously.

¢ Both stations have the same rights, in other words, each station can trigger the
send and receive procedures in response to events.

¢ Sending and receiving data uses the SDA service (SendDataAcknowledge)
complying with EN 50170, Vol 2.

SIMATIC S7 station PROFIBUS
with PROFIBUS CP node
User data send receive
area FDL connection
receive send
PROFIBUS
node
User data
area
send receive
FDL connection
receive send

Figure 7-3  Sending and Receiving on One Specified FDL Connection - Configured Destination Address

Amounts of Data

Refer to the product information accompanying the PROFIBUS CP for the number
of FDL connections supported by the PROFIBUS CP /2/. The number of
connections per station can be increased by adding more CPs.

The maximum amount of data that can be sent or received by the PROFIBUS CP
on a specified FDL connection is as follows:

e 240 bytes sending
e 240 bytes receiving
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7.3.2 Unspecified FDL Connection (Free Layer 2 Access)

Characteristics

An unspecified FDL connection with open layer 2 access allows program-controlled
addressing of the communication partner and communication between nodes on
PROFIBUS has the following characteristics:

¢ The data transfer is bi-directional, in other words, it is possible to transmit and
receive on the FDL connection simultaneously.

e The local node is specified in the configuration. The remote node is entered in
the job header of the job buffer by the user program when it calls AG_SEND.
This means that every node on the PROFIBUS (PROFIBUS addresses 0 to
126) can be reached.

* The PB address, the LSAP and the service of the sender can be read from the
job header of AG_RECV.

M Somco o |
SIMATIC S7 station | PROFIBUS ‘
with PROFIBUS CP ‘ node 3 ‘
User data area | (unspecified) }
Job buffer send I:::> receive |
- unspecified | |

Job header FDL connection
receive <‘::I send }
User data | |
| |
| |
| |
| |
L |

Figure 7-4  Sending and Receiving via an unspecified FDL Connection — Programmed Addressing

Amounts of Data

For the number of FDL connections supported by the particular PROFIBUS CP,
please refer to the product information shipped with the PROFIBUS CP /2/. The
number of connections per station can be increased by adding more CPs.

Up to 236 bytes of user data can be transferred per job buffer. The job header
occupies an additional 4 bytes.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-153

C79000-G8976-C181-05



7 Configuring FDL Connections / Programming the SEND/RECEIVE Interface

7.3.3 FDL Connection with Broadcast

Characteristics

A broadcast connection allows a message to be sent to more than one receiver
with one job. This means that messages can be received on a broadcast
connection that are also received by other nodes on PROFIBUS at the same time.

The characteristics can be summarized as follows:

e Data transfer is bi-directional, in other words it is possible to send and receive
at the same time on the broadcast connection.

¢ Data is sent and received using the FDL service SDN (Send Data with No
Acknowledge).

¢ When sending, a job buffer must be specified with the AG_SEND call. The area
for the job header must be reserved; the content is, however, not relevant.

* The PB address, the LSAP and the service of the broadcast sender can be
read from the job header of AG_RECV.

¢ When sending, the LSAP range from 1 to 56 is used. For receiving, LSAP 63 is
reserved for all broadcast nodes.

SIMATIC S7 station
with PROFIBUS CP

User data area
Job buffer send [ _—> LSAP=1.56

Job header FDL connection
with broadcast

receive <<,‘:I LSAP = 63

User data

Figure 7-5  Sending and Receiving via an FDL Connection with Programmed Broadcast Addressing

Configuring an FDL Connection with Broadcast

When you create the FDL connection, select “All broadcast nodes” as the
connection partner/station.

Amounts of Data
The PROFIBUS CP supports one broadcast connection.

Up to 236 bytes of user data can be transferred per job buffer. The job header
occupies an additional 4 bytes.
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Notice

If you use an FDL connection with broadcast, you cannot receive messages on
any further broadcast connection on this CP, including FMS connections with
broadcast.

Reason:

The receive LSAP for broadcast (63) is occupied by the broadcast connection.
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7.3.4 FDL Connection with Multicast

Characteristics

An FDL connection with multicast allows the sending of a message to several
receivers belonging to a multicast group with one job.

The characteristics can be summarized as follows:

e Data transfer is bi-directional, in other words it is possible to send and receive
at the same time on the FDL connection with multicast.

¢ Data is sent and received using the FDL service SDN (Send Data with No
Acknowledge).

e A uniform LSAP is used to send to the multicast group (range 1 to 56).

¢ When sending, a job buffer must be specified with the AG_SEND call. The area
for the job header must be reserved; the content is, however, not relevant.

* The PB address, the LSAP and the service of the multicast sender can be read
from the job header of AG_RECV.

SIMATIC S7 station
with PROFIBUS CP

User data area

Job buffer el E:> FDL connection
Job header with multicast

LSAP|ocai=LSAPemote (1--56)

receive <<,‘:|

User data

Multicast
group

Figure 7-6  Sending and Receiving via an FDL Connection with Programmed Multicast Addressing

Configuring an FDL Connection with Multicast

When you create the FDL connection, select “All multicast nodes” as the
connection partner/station.
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Amounts of Data

For the number of FDL connections supported by the particular PROFIBUS CP,
please refer to the product information shipped with the PROFIBUS CP /2/. The
number of connections per station can be increased by adding more CPs.

Up to 236 bytes of user data can be transferred per job buffer. The job header
occupies an additional 4 bytes.
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7.4 Creating a New FDL Connection

Connections

When you create new connections, you start from entered and networked stations.
A connection is then configured starting from a station in the current S7 project and
then selecting a second station.

Due to the networking, the PROFIBUS address of the local station is already
decided. On a specified FDL connection, this also applies to the selected
destination station. The local and remote LSAPs (Link Service Access Point) at
both ends of the connection are automatically assigned default values.

The endpoint of the connection to a SIMATIC S7 station is always a CPU. A
separate connection table is created for each CPU and displays the connection
partner and types of connections.

New Connection

To configure a new connection, the stations and their CPs must be configured and
networked in the S7 project. To create a new connection, follow the steps below
starting in NetPro:

1. In NetPro, select the CPU in the station from which you want to establish the
connection.

2. Select the menu command Insert » New Connections (also available with the
right mouse button!).

Result: The following dialog appears on the screen.
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Inzert New Connection |

— Connection Partner

E--@ I the current project
E% FROJECT-PROFIBLIS
-{@ FMS-Server 57 400-Stat.
SIMATIC 300 DP aster
SIMATIC 300 DP-Slave
SIMATIC 300-5tatian(1)
SIMATIC 300-5tation(2)
SIMATIC 300-5tation(3)
£ SIMATIC 55[1)
- [Jnzpecified)
e | broadcast stations
(— All multicast stations
% In unknown project

: LY
Froject: |F'F|EIJEET-F'F|DFIBLIS —
Station: |SIM.&TIE 300-Station(1]
todule; |CPU 314(1)

— Connection
Type: IFDL conhection j

v Display properties before inserting

Ok I Apply Cancel | Help |

3. Select the partner station to which you want to establish a connection (if several
CPUs exist, please select the required CPU).

4. Select the connection type you want to use (for example FDL connection) in the
“Type” box

If you confirm your entries with Add, the new connection is created and the "New
Connection” remains open. This allows you to create further connections without
needing to reopen the dialog box. At the same time, the connection list is updated.

When you click OK, the connection is entered in the list, the dialog is terminated
and the display in the main dialog is updated.

If you click Cancel, the dialog is terminated and the connection is not entered in
the list.
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Notice

The number of connections possible per PROFIBUS CP can be found in the
product information /2/supplied with the CP. If several CPs are installed in one
station, the next CP is automatically selected if the limit is exceeded. You can
rearrange connections in the properties dialog.

Connections to “Other Stations” are generated as “incompletely specified
connections”, in other words the remote LSAP is empty. These connections must
be checked in the properties dialog and acknowledged with “OK”. To specify the
connection, the remote LSAP must be entered.

Connections to Non-S7 Stations using Substitute Objects

A-160

If you want to configure connections to devices or stations that are not S7 stations,
select a station of the type “SIMATIC S5, “PC/PG” or “Other Station” as the
destination station.

By creating these stations in NetPro and networking them, you have already
specified the PROFIBUS address of the local station and the remote station. The
local LSAP (Link Service Access Point) is automatically assigned a default value.
The remote LSAP remains empty and must be specified in the Properties dialog in
the “Addresses” tab.
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7.5 Connections to Partners in Other Projects

There are two ways of creating connections to partners configured in other STEP 7
projects or with other tools outside the current STEP 7 project:

Connections using substitute objects such as “SIMATIC S5”, “PC/PG” ,
“SIMATIC PC Station” or “Other Station”.

This method is described in the section above.
Unspecified connections

Connections to an as yet unknown device (for example a diagnostic unit) are
configured as “unspecified” connections. Unspecified FDL connections can be
used in two ways:

- Free layer 2 access (see also Section 7.3.2)
The communications partner is addressed by the user program.
— Connection to an unconfigured partner

You address an unconfigured communications partner in the current STEP 7
project in the Properties dialog of the connection.

You can create an unspecified connection simply by selecting station
“unspecified” for the connection partner when you create the connection.

STEP 7 Object “Partner in unknown project” (multiproject)

With this method, a connection is reserved in both subprojects that can be
synchronized later by the system when the partner project is included in the
multiproject.

In both projects, the same connection name must be configured in the
properties of the connection. The connection name is used as a textual
reference when the projects are merged. Based on the connection name, it is
possible to assign the connection partner and synchronize the connection
properties.

The connection configuration can be downloaded to the S7 station only after the
subprojects and therefore also the connections have been merged since neither
the partner address nor the remote LSAP is known prior to this.
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7.6 Configuring FDL Connection Properties

Introduction

As well as the entry in the connection table, you can also modify special properties
for each configured connection.

Here, you can change specific connection parameters that were entered as
defaults during the new connection dialog.

Opening the Dialog

To call the dialog for special connection properties, follow the steps outlined below:

1.

Select the required connection in the connection table.

2. Select the menu option Edit » Object Properties.

Result: The “Properties FDL Connection” dialog appears.

Tabs

The properties dialog takes the form of tabs containing groups of different types of
parameter.

The following tabs are available for FDL connections:

A-162

General

Displays the global parameters of the connection and the local name of the FDL
connection.

Addresses
Displays the local and remote address information.
Overview

This is an overview of all the configured FDL connections of the selected S7
station with their parameters (local and remote LSAPs).

Status Information

This tab displays the current status information for the connection (valid at the
time the dialog is opened). This information corresponds to that displayed by
NCM diagnostics.
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7.6.1 Specifying the FDL Connection Partner

General Tab

This tab in the properties dialog displays global parameters for the connection and
the local connection name of the FDL connection. The local ID is identical to the ID
in the connection list and is shown here to illustrate the assignment.

Propertiez - FDL Connection |
General | Addresses I I:Iptigngl Dwerview I Statuz |nformation I
— Connection Endpaint — Block Parameters

001 A000

Local 1D [hex):

1—qID

M arne: IFD L-werbindung-1
ViaCP:  |CF 3425 - [R0/S5]

WH1EH0110 —LADDR

Route. .. |

Cancel Help

Table 7-1

Local Endpoint

Attributes Description

Local ID Identical to the value from the connection list

Name Proposed name that can be changed by the user

Via CP If the station contains more than one CP of the same type connected to the same

subnet, you can select the connection route. —> “Route” button.

If no CP is assigned (for example because the CP was previously deleted) “none” is
displayed here.

If there is only one CP plugged into the station, no selection is possible.
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Table 7-1 , continued

Local Endpoint

Block Parameters

ID This value must be entered as a block call parameter ID in the user program to
identify the connection.

LADDR This decimal value must be entered as a block call parameter LADDR in the user
program to identify the CP (display in hexadecimal, 200y —> 512p).

Connection Name (Reference) - only in a multiproject

If you create a connection to a partner in another project, that has not yet been

2 merged with the current multiproject, you must enter a connection name as

*= reference. Interproject connections can then be joined up based on this reference.
As soon as the connections have been brought together, the connection name
(reference) can no longer be entered.

Routing to Distribute Load

If two or more CPs of the same type exist in a station and are connected to the
same subnet, you can select the route.

Click the “Route” button in the “General” tab to display the route dialog:

Local Partner
|SIM!—\TIE 300-Station[1WCPU3T4[T) |SIMATIE 300-Station[2WCPU3T4[T)
Wia CP: IEF‘ 3425 - [ROSSE) j CP 3435 - [RD/SE) j

Interface Type:  Prafibuz

Mode
Address: 2 18
Subnet : PROFIBUS (1]

Cancel Help

If you have configured load distribution at the local or remote end on two or more
PROFIBUS CPs, you can assign the connection to the required route via the CPs.
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7.6.2 Specifying Address Parameters

Address Parameters of an FDL Connection

A connection is specified by the local and remote connection endpoint: These

include:

« PROFIBUS address of the station to be contacted.

¢ Local LSAP (Link Service Access Point) :

The local LSAP controls the reception of data on the PROFIBUS CP. Receive
resources are made available for the LSAP on the PROFIBUS CP for receiving

data on the FDL connection
¢ Remote LSAP (Link Service Access Point):

The remote LSAP controls the sending of data on the PROFIBUS CP. The
PROFIBUS CP sends data to the station on the FDL connection using the
LSAP. The destination station must be ready to receive for this SAP.

Addresses Tab - Specified FDL Connection

For a specified FDL connection, the addresses tab displays the relevant local and
remote address information as proposed values. If necessary, you can set the

LSAP addresses individually.

The way in which the connection partners are shown in the Properties dialog is
illustrated in the following example of node A and its connection to node B.

PROFIBUS-
partner A

Application program

Local ID

PROFIBUS CP

Describes the address parameters of the local endpoint of an

FOL connection .

The LSAPs for all FOL connections are only walid in the range

from £ to 33.

Profibus- Address:

LSAP:

PROFIBUS
address local

FDL connection

PROFIBUS-
partner B

PROFIBUS
address
remote

apbrechen | Hilfe
Figure 7-7 Correlation between the Information in the “Addresses” Tab and the Endpoints of the FDL Connection
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Addresses Tab - Unspecified FDL Connection
An unspecified FDL connection can be used in two ways:
e Connection to a remote station in a different project

You can specify the remote PROFIBUS address and the LSAP for any
destination station. The destination station can be within or outside the current
STEP 7 project.

As long as the remote address is unspecified, no communication is possible on
the FDL connection.

e Free layer 2 access

To configure a free layer 2 access, click the appropriate button. The input boxes
for the remote PROFIBUS address and the remote LSAP can then no longer be
written to, since the destination addresses are now specified by the user

program.
Propertiez - FDL Connection |
General Addresszes | Dptiu:unsl Owerview I Statusz Information I

Dezcribes the address parameters of the local endpoint of a
Broadzazt-connection.

Local Remote

PROFIBLUS e I

addresz:

LSAP[1... 56): IE vI I vI

Cancel Help
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Addresses Tab - FDL Connection with Broadcast

For an FDL connection with broadcast, the remote address parameters are fixed.
All broadcast stations can be reached using the PROFIBUS address 127. Receive
data are accepted by all broadcast stations via LSAP 63.

The local address parameters are entered in the job header of the message for
sending and sent to the receiver. The user program on the remote partner can
therefore find out the sender of the broadcast frame.

Propertiez - FDL Connection |

General Addresszes |Elpti|:|ns| Owerview I Statuslnfurmatinnl

Dezcribes the address parameters of the local endpoint of a
Broadzazt-connection.

Local Remote
FPROFIBLIS 2 |1 27

addresz:

LSAP[1... 56): IE - I IEE ¥ I

Cancel Help

Notice

If you use an FDL connection with broadcast, you cannot use any other broadcast
connection, not even an FMS connection with broadcast.
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Caution

Please note the following information about activating cyclic distribution of the bus
parameters:

If you have activated this option in the "Properties PROFIBUS” dialog in the
"Network Settings” tab, the bus parameters are sent cyclically during operation as
broadcast frames. To avoid conflicts handling frames in the user program that
receives the broadcast frames, you must either:

ignore all frames sent with an LSAP >56 or
or

deactivate the function in the "Network Settings” tab.

Addresses - FDL Connection with Multicast Tab

For an FDL connection with multicast, the remote address parameters are fixed.
All multicast stations can be reached via the PROFIBUS address 127. Data is sent
and received by all stations in the multicast group using the same LSAP (range 1
to 56). The value of the LSAP can therefore only be selected locally and is
adopted automatically as the remote LSAP.

The local address parameters are entered in the job header of the message for
sending and sent to the receiver. The user program on the remote partner can
therefore find out the sender of the multicast message.

Propertiez - FDL Connection |

General Addresszes |Elpti|:|ns| Owerview I Statuslnfurmatinnl

Dezcribes the address parameters of the local endpoint of a
Multicast-connection.

Local Remote
FPROFIBLIS 2 |1 27

addresz:

LSAP[1... 56): I - I |2'I ¥ I

Cancel Help
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7.6.3 Checking the Configuration of the FDL Connections

Overview Tab

The overview tab displays all the previously configured FDL connections and their
parameters for this station (this is only for information and cannot be modified).
You can set the column width in the table individually.

Parameter

Description

Local ID

This is the connection ID of the FDL connection

Name (loc. endpoint)

Entered connection name. This identifies the FDL connection.

CPU / Applications

If you display all the FDL connections being operated in this station in the
multiprocessor mode (with PC stations: multiple applications), the
CPU/application that is the endpoint of the particular connection is specified
here.

R/S or via CP With S7-CPs: Rack/slot of the local CP via which the connection is
established.
With PC stations: Display of the CP over which the connection is
maintained.

Remote Specifies the remote PROFIBUS address of the partner.

address

Local LSAP Local link service access point.

Remote LSAP Remote link service access point.

Status The status displays the current configuration status of the connection.

“Connections without assignment” are indicated by “No local CP/No remote
CP” in the status column and a “!” character at the end of the“Local ID” (for
example: 0002 A000!).

Connections to “Other Stations” are generated as “incompletely specified
connections”, in other words the remote LSAP is empty. The user must
check these connections in the properties dialog. If you exit the properties
dialog with “OK”, the changes are entered and the identifier of the local ID (!)
and the status “Incomplete” are acknowledged.
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7.7 Further Functions in Connection Configuration

Toolbar

In the toolbar of the connection configuration dialog the following functions are
available:

Table 7-2  Important Functions for Configuring Connections

Save To save the configured connection, select the Save function or click the save
I!‘ button (diskette icon).
Print You can print the entire connection table or individual sections of it by selecting
the Print function or clicking the print button (printer icon).
g The following print options are available:

* Qverview of all connections (complete connection table)

* QOverview of the selected connections (selected area)

* Detailed printout of all connections (details of all connections)

* Detailed printout of the selected connections (details of the selected area)

Change Connection You assign a new partner station to the selected connection.
Partners Important!

Remember that this also changes the partner ID on connections of the
ﬁ SEND/RECEIVE interface.

Insert Connection You create a new entry in the connection table.

AN

Download You download the connection table to the PLC. For more detailed information
call up the integrated help function.

4

Help If you require help or more information, select the Help function or click the
) help button (? icon).
k 4 The help button provides you with context-sensitive help. Using the help

function you call a help dialog familiar from other Windows applications.

Print Function in the “Overview” Tab

An additional function for printing the configured connections and configuration
status is available in the “Overview” tab.
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7.8

Overview

Editing Connections without an Assignment

This section explains the actions that can lead to a configured connection losing its
assignment to the CP or being deleted.

Notice

Remember that in contrast to the S7 homogeneous connections, the connections
of the SEND/RECEIVE interface are assigned a CP-dependent ID. The actions
below may require the ID to be modified so that the interface information in the
user program must also be adapted.

Table 7-3  Actions That Can Cause Changes to Configured Connections

Action

Consequences for the
Connections

How to Establish the Connection
Again

The CP (module) is
moved to a different
location in the hardware
configuration

The connections are retained.

The connection IDs are
automatically updated.

. Adapt the module start address

LADDR in the user program.

Download the connection
configuration to the CP again.

The CP (module) is
deleted in the hardware
configuration.

You receive the message
“CP has n connections;
the assignment will be lost
in the connection table”.

The connections remain without
assignment to a CP in the
connection table. In the
“Overview” tab of the Properties
dialog, the connections are
identified with “I”.

Once you have placed a CP in the
hardware configuration and networked it:

1.

Assign the CP in the connection
properties dialog in the “Address”
tab.

or

Reassign the connection using the
Edit » Connection Partner..... menu
command.

Adapt the connection ID in the user
program.

Download the connection
configuration to the CP again.

Deleting the SIMATIC S7
station.

All the connections to this station
are deleted within the project.

Reconfigure the station and
connections.

S7-CPs for PROFIBUS Configuring and Commissioning
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Table 7-3  Actions That Can Cause Changes to Configured Connections, continued

Action

Consequences for the
Connections

How to Establish the Connection
Again

Deleting a remote station.

The connections of the stations
in the project to remote stations
remain without assignment in
the connection table. In the
“Overview” tab of the Properties
dialog, the connections are
identified with “I”.

Reassign a remote station (or even a
local station) to the connection using the
function Edit > Connection Partner...

Changing the subnet
assignment of the CP.

The connections that were
assigned via the CP remain
without an assignment in the
connection table. In the
“Overview” tab of the Properties
dialog, the connections are
identified with “I”.

Reassign the connections using the Edit
» Connection Partner... menu
command or in the “Address” tab of the
properties dialog for the connection.

Display

The status of the connection is displayed in the “Properties FDL Connection” dialog
in the “Overview” tab.

Vorsicht

If a CP is replaced by a different CP, this must provide at least the same services
and must be at least the same version.

A-172
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7.9 SEND/RECEIVE Interface in the User Program on the
CPU

Functions (FCs)

The following two blocks (FCs) are available for handling communication on FDL
connections:

e AG_SEND
This block takes the user data from the specified user data area and transfers it
to the PROFIBUS CP.

e AG_RECV
This block transfers received user data to the user data area specified in the
call.

The diagram below illustrates the situation. Using the FCs AG_SEND and
AG_RECV, the user program instructs the PROFIBUS CP to send or receive data
on the configured FDL connection.

With the connection types unspecified with free layer 2 access, broadcast and
multicast, the job buffer includes a further job header in the user data area for
address and service parameters.

FDL connection

PROFIBUS node SIMATIC S7 - o
CPU X PROFIBUS CP
‘| CP
STEP 7 1 | database
user program X
' FDL
' t ff
User data ' data bufer
areas .
————» send
)
)
)

receive

AG_REC~€——

I(—CPU cycle —_— |- Transmission time —

Figure 7-8 Interaction of the CPU and PROFIBUS CP when Using FDL Connections
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7.9.1 Writing the User Program for FDL Connections

Principle of Job and Data Transfer

With the FC calls, the CPU program triggers the transmission of the user data
areas and monitors successful execution.
Among others, the following parameters are transferred when the FCs are called:

e The number of the FDL connection (ID)
¢ The module address
* The location of the user data area in the CPU

For detailed information on the call interface, refer to /6/.

Function of the FCs (Functions)
Calling the function blocks has the following effects:

¢ The user data area is transferred to the PROFIBUS CP or received from the
PROFIBUS CP.

¢ The execution of the job is confirmed positively or negatively in a status
message.

Programming FDL Connections
Program the SEND/RECEIVE interface in the user program as follows:
1. Use the following functions (FCs) for data transmission on FDL connections:
- AG_SEND for transferring the user data area to the PROFIBUS CP

- AG_RECYV for entering data received from the PROFIBUS CP in the user
data area

2. Evaluate the following bits in the FCs:
- for AG_SEND the parameters DONE, ERROR, STATUS
- for AG_RECYV the parameters NDR, ERROR, STATUS

Calling FCs in the CPU Program

One possible sequence for FCs in conjunction with the organization and program
blocks in the CPU cycle is illustrated in the following diagram.

Notice

The blocks can be called more than once in a cycle for one communication
connection.
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Read PII Read in the received
data of the FDL

* connection
4 OB I | | User program
AG RECV = / /',:I
* — FDL connection
AG_RECV
FDL connection
AG_SEND ———
AG RECV e
FDL connection
AG_SEND (\
Transfer transmit
* data of the FDL
connection
4 *'I_T AG._SEND

Write PIQ
Legend: =jp-m— Sequence of the CPU cycle
:l:l:' The different shading shows which FDL connections

and FC blocks belong together.

Figure 7-9  Typical Sequence of FDL Function Calls in the CPU Cycle

The following points are illustrated by the diagram:

¢ The user program consisting of any number of blocks (OBs, FBs or FCs)
accesses several FDL connections. (Figure 7-9 illustrates three connections).

e At various points (event and program-controlled) the user program sends data
on an FDL connection using the AG-SEND call.

e At various points in the CPU cycle, the user program accepts the data received
on the FDL connection using an AG-RECYV call.
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7.9.2 Data transfer S7 CPU <-> PROFIBUS CP

Principle

The PROFIBUS CP processes the send and receive jobs independent of the CPU
cycle and requires one FDL transmission time. The interface to the user program
with the FCs is synchronized by an acknowledgment. Two situations must be
distinguished:

e The CPU cycle is faster than the transmission time.

¢ The CPU cycle is slower than the transmission time.

Note

Please refer to the sequence charts for the FCs in /6/. These charts show how to
handle the SEND/RECEIVE interface in the user program for problem-free data
exchange.

Remember the points below about the CPU cycle and transmission time.

CPU Cycle Faster than the Transmission Time

If a block is called before data were transferred or received, the procedure is as
follows on the interface of the FCs:

e AG-SEND:
No further job is accepted until the transmission of the data on the FDL
connection has been acknowledged by the PROFIBUS station. During this time,
the user program receives the message “job active” until the PROFIBUS CP
can accept the next job on the same FDL connection (the acknowledgment is in
one of the subsequent cycles).

e AG-RECV:

- On an S7-300:
The job is acknowledged with the message “Job active” if there are no
received data on the PROFIBUS CP. The user program receives this
message in the CPU cycle until the PROFIBUS CP has received data again
on the same FDL connection.

- On an S7-400:
The job is acknowledged with the message “no data available yet” if there
are no received data on the PROFIBUS CP. The user program must then
start a new job to receive data.
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CPU Cycle Slower than the Transmission Time

If a block is called again before the data were transferred or received, the
procedure is as follows on the interface of the FC blocks:

e AG-SEND:
The job is positively acknowledged. The PROFIBUS CP is ready to receive a
new send job (at the earliest however with the next call).

e AG-RECV:
The job is acknowledged with “new data received” if there are new data in the
user data area. Following this, you can transfer the data to the user program
and call AG-RECV again to be ready to receive data.

Until the PROFIBUS CP is ready to receive again, it sends a negative
acknowledgment to the other PROFIBUS nodes (senders) on the PROFIBUS.

Notice

Remember that resource shortages can occur if the processing speeds on the
sender and receiver are not the same (sender faster than receiver).

If this occurs, the sender receives a message from the FCs and must repeat the
send job at a later time. (“No resources on the destination station” see /6/).

4
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The NCM S7 Diagnostics described here provides dynamic information on the
operating state of the communication functions of online CPs.

This chapter provides a general overview of the individual diagnostic functions.

The following checklist will help you to recognize several typical problems and their
possible causes and shows how you can use the NCM S7 diagnostics tool to
remedy the situation.

ﬂ You will find further information in the following sources:

¢ When you are working with the diagnostic tool, the integrated help system
provides you with context-related support.

¢ You will find detailed information on working with STEP 7 programs in the Help
on STEP 7, which includes the topic “Diagnosing Hardware”.
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8.1 Overview

Diagnostic Options in STEP 7

STEP 7 provides you with a graded concept allowing you to query information
about the status of your SIMATIC S7 components and functions and to sort out
problems in a variety of different situations. These options cover the following:

Hardware Diagnostics and Troubleshooting with STEP 7

Hardware diagnostics provides dynamic information on the operating mode of
modules including CPs when the S7 station is online.

You can recognize the existence of diagnostic information for a module by the
diagnostics icon in the project window of the SIMATIC Manager. Diagnostic
icons show the status of the corresponding module and also the operating
mode of CPUs.

Detailed diagnostic information is displayed in the “module information” that you
can open by double-clicking a diagnostic icon in the quick view or the diagnostic
view.

Communication Diagnostics with NCM S7 Diagnostics

The NCM S7 Diagnostics described here provides dynamic information on the
operating state of the communication functions of online CPs.

HW Config Provides Static Information

Static information means the configured communication properties of an online
or offline CP and you can display this information at any time using HW Config.
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8 NCM S7 Diagnostics

8.2 Functions of NCM S7 Diagnostics

Functions
The diagnostic functions can be grouped as follows:
¢ General diagnostic and statistical functions

¢ Type and mode-dependent diagnostic functions

General Diagnostic and Statistical Functions

Regardless of the configured mode of the PROFIBUS CP, the following diagnostic
functions are possible:

¢ Querying the operating mode on PROFIBUS and the configured CP mode of
the PROFIBUS CP.

¢ Querying the current PROFIBUS bus parameters (including the real Ttr).
¢ Obtaining station-related statistical information.

e Querying the event messages recorded on the PROFIBUS CP (diagnostic
buffer)

¢ Displaying the PROFIBUS station overview

Mode-Dependent Functions

Depending on the configured mode of the PROFIBUS CP, the following diagnostic
functions are possible:

¢ DP master diagnostics:
Querying the status of the DP master and the communication status of all
configured slaves

It is possible to call DP slave diagnostic data for specific DP slaves.

e DP slave diagnostics

Note

Note that NCM S7 Diagnostics is not possible for a passive DP slave via
PROFIBUS.

¢ Diagnostics of FDL Connections

¢ Diagnostics of FMS connections; for detailed information, refer to Volume 2 of
this manual.
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8.2.1 Installing and Starting NCM S7 Diagnostics

Installation
Die NCM S7 Diagnostics is an integrated part of STEP 7.
There are several ways in which you can start the diagnostic tool, for example:
¢ From the standard START menu of Windows with the SIMATIC program
group.
Select this option if the STEP 7 project in which the CP was configured is not
available on your PC/PG (service situation).

e From the properties dialog of the relevant CP from your STEP 7 project.

* From the standard Start menu of * From the Properties dialog of the CP within
Windows (program group your STEP 7 project.
SIMATIC»...»NCM).
Use this method if the STEP 7 project ~ _—
in which the CP was configured is not
available on your PG (for service

purpoSeS) . Properties - CP 443-5 Ext - [RO/56]

General | Addresses | Operating Mode Diagnostics |
Module Diagnostics
[Slarl special diagnostics
— @ Docurnentation
HHH
@ Information

L4 @ License Management
7T SIMATIC NET

& sTER 7
M SIMATIC Manager

£3% NetPro - [COLOR_414 [Network) - C:ASIEMENSASTEP7\S 7proj‘Color_41]

FIJ;_: H%wf Config - [SIMATIC 400(1) [Configuration] - COLOR_414]

L4 W Diagniostics
PW Firmware Loader

‘Which module do vou want to access?

-~ Gateway

Gateway attachment:

I[None]
Wode address [gateway]| I
i subret | D ohdestination refuork: I -

r— Destination Station \
Destination station attachment \ \
—

[MPI/PROFIBUS /207D V =

For further information on the Startup options, refer to Section 8.3.
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8 NCM S7 Diagnostics

Structure

In the same way, for example, as the SIMATIC Manager, NCM S7 Diagnostics
appears as a separate two-part application window with a menu and toolbar:

0 [ el

3 CP Information
Diagrostic Buffer
Operating Maode
Modes
Bus Parameters
Stz
Cannections
I‘I‘ DP master

Navigation area with Content area with the
diagnostic objects diagnostic result

¢ Inthe navigation area on the left-hand side, you will find the hierarchically
arranged diagnostic objects.

You have an overview of the available diagnostic functions at all times. The
object structure displayed in the navigation area is adapted to the type of CP
you are currently checking and the functions and connections configured for the
CP.

« In the content area, on the right-hand side, you will see the result of the
diagnostic function you selected in the navigation area.

Operation

* By selecting a diagnostic object in the navigation area with the mouse, you
execute the diagnostic function.

e Using the menu bar and toolbar, you control the sequence of the diagnostics
with context-sensitive menu commands.
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8.2.2 General Menu Commands

Overview

When running diagnostic functions, the following menu commands have general
significance. Depending on the context, other functions may be available; for more
detailed information refer to the online help for NCM Diagnostics.

Table 8-1 Meaning of the Menu Commands

Menu

Meaning

Diagnostics™
Open Online Connection...
Diagnostics™
Close Online Connection...

With this menu command, you can establish a connection to a different CP
you want to check without having to quit and restart the diagnostic tool. The
current diagnostic connection is closed.

If you want to use more than one diagnostic connection at the same time,
you can start NCM S7 diagnostics more than once.

Operating Mode>

You can control the CP as follows:

Update Cyclically

Stop CP Stops the CP.

Start CP Starts the CP if the RUN/STOP switch is set to RUN.

Reset CP With certain CP types, for example the CP 443-5 Basic, you can reset the
CP memory. This function must be confirmed before it is executed.

View»Update Each time you activate this menu command, the displayed diagnostic and
status information is updated once.

View> Using this menu command, you activate and deactivate the automatic

(cyclic) updating of the displayed diagnostic and status information.

You can set the interval between update points with the menu command
Options>Customize.

Options>Customize

With this menu command, you set the general parameters for the diagnostic
session.

Help>

You display a help topic relating to the current diagnostic function As an
alternative, you can also press the F1 key.

Remember that you can also call up context-related help for some of the
diagnostic functions. To obtain help, position the cursor on the output field
and press the F1 key.

Note

If the connection to the CP is terminated during the diagnostic session, the
following message is displayed: “The online connection was terminated”.

You can reestablish the connection to the CP with the corresponding
acknowledgment in the dialog. The connection is then automatically reestablished
whenever possible.
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8 NCM S7 Diagnostics

8.3 Starting Diagnostics

8.3.1 Establishing a Connection to the PROFIBUS CP

Initial Situation

Establish the physical connection between the PG and the SIMATIC S7 Station.
There are two ways of doing this:

MPI

Industrial Ethernet (ISO protocol)
Industrial Ethernet TCP/IP (IP protocol)
PROFIBUS

Ways of Starting Diagnostics

You can start NCM Diagnostics from the following STEP 7 functions or dialogs:

CP properties dialog
Windows Start menu
Connections properties dialog (NetPro)

Hardware configuration HW Config

These possibilities are described below.

8.3.2 Starting Diagnostics from the CP Properties Dialog

If the project data are available on your PG/PC, follow the steps outlined below:

1.

2.
3.
4,

Select the S7 station in the project and open the hardware configuration (HW
Config).

Select the CP and open the Properties dialog.
Select the “Diagnostics” dialog.

Select the “Run” button.

Result:
NCM S7 Diagnostics is opened. The path is set automatically to match the current
connection in STEP 7.

A-184
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8.3.3

Starting Diagnostics from the Windows Start Menu

If there are no configuration data on your PG/PC, follow the steps outlined below to
start diagnostics with a connected CP:

1. Open the Windows Start menu and select the command SIMATIC » STEP 7 »
NCM S7 » Diagnostics

NCM S7 Diagnostics is started with the message “No online connection to the
CP” in the contents area.

2. Select the menu command Diagnostics » Open Online Connection...

3. In the displayed dialog “NCM S7 Diagnostics: Online Path”, select the interface
to match your hardware configuration.

Depending on the type of network attachment you have, you will be prompted
to specify an address:

Table 8-2 Possible Settings for the Online Paths — without Parameters for Internetworking

own MPI address.

Otherwise specify the MPI address of
the CPU.

Attachment on Node Address Location of the Module
Destination Station Rack / Slot
MPI MPI address of the CP if this has its Rack/slot no. of the CP to be

checked.

If you specify the MPI address of the
CP, you can simply use the default
setting “0/0”.

With this setting, the CP whose
address was specified as the node
address is accessed.

PROFIBUS

PROFIBUS address of the
PROFIBUS CP via which the S7
station is reached.

Rack/slot no. of the CP to be
checked.

Industrial Ethernet

MAC address of the Ethernet CP via
which the S7 station is reached.

Entered in hexadecimal.

Rack/slot no. of the CP to be
checked.

If you specify “0/0”, the CP specified
with the node address is accessed
directly.

Industrial Ethernet
TCP/IP

IP address of the Industrial Ethernet
CP via which the S7 station is
reached.

Entered in decimal.

Example:
IP address decimal 142.120.9.134

Rack/slot no. of the CP to be
checked.

If you specify “0/0”, the CP specified
with the node address is accessed
directly.
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8 NCM S7 Diagnostics

Examples of an Online Path without Gateway

Rack / slot : 0/4
PG/PC | S7 - 300
| B8l cr s .//
L ' Node address (MAC):
l 08-00-06-01-02-03
Attachment of target
station: Industrial Ethernet
Figure 8-1 CP requiring diagnostics can be reached directly
Rack / slot : 0/5
PG/PC S7-300 “
| L CP : c lc
00 v
Node address (MAC):
_ 08-00-06-01-02-03
Attachment of target *
station: Industrial Ethernet Network 2

Figure 8-2  The CP requiring diagnostics is accessible indirectly over another CP
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8.34 Using a Gateway

Case a: One gateway

If the CP you want to check with diagnostic functions can only be reached via a
gateway, you must select the device and specify its node address in the local
network.

You must also specify the S7 subnet ID of the destination network:
The subnet ID consists of two numbers separated by a dash:

— One number for the project

— One number for the subnet

You will find the subnet ID in the object properties of the subnet in the STEP 7
project. The subnet ID is also printed out with the network configuration.

Node address (gateway) (MAC):
08-00-06-01-02-03 Rack / slot : 0/5
PG/PC S7 - 300 /
[ |
| EElcr e ] 57 - 3007
oaQ il EElce : C
U
I e
> Node address:
— ‘ PROFIBUS address 9
Attachment of gateway:
Industrial Ethernet \
Attachment of target
station :
MPI/PROFIBUS/AUTO
S7 subnet ID of target network:
0001 0001

Figure 8-3 Example of the Parameter Settings for the Online Path with one Gateway
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Case b: Several Gateways

If the CP requiring diagnostics can only be reached over several gateways, you
only specify the first gateway.
Routing over the other gateways is done automatically.

Node address (gateway) (MAC):

08-00-06-01-02-03

PG/PC W S7 - 300

automatically !

cpl C
u |
O Qg ]
l — CE—
N
Attachment of gateway:
Industrial Ethernet / r=I \ o[ S7-300 "
Logpd / - cP | C i
Routing over other U :
gateways is done N~ 4

L

\
Node address:
PROFIBUS address 9

\ttachment of target

station: MPI/PROFIBUS/AUTO

S7 subnet ID of target network:

0001 0001

Rack / slot : 0/5

Figure 8-4

A-188
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8.3.5 Using the PC Station - Setting a Gateway with “PC internal”

There is a special situation when you use your PC/PG as a PC station and have
therefore set the interface to PC internal (local) in “Setting the PG/PC Interface”.
You must them set parameter values for the gateway, even when you do not need
to go through any other gateway to reach the target station.

Select the following settings:
» Gateway attachment: MPI/PROFIBUS/AUTO
¢ Node address (gateway)

Enter the index of the module here.

The index is the virtual slot address of the component (can be displayed using
the Station Configuration Editor). The index is identical to the slot number
selected during configuration of the PC station in STEP 7 HW Config!

e S7 subnet ID of destination network:
Follow the same steps as described for setting the gateway.
Tip:

You do not need to make these settings for the gateway if you select one of the
following options:

e Start NCM Diagnostics from the Properties dialog of the CP.

¢ When setting up your module, do not select the interface as PC internal (local)
in “Set PG/PC Interface”.

Node address (gateway) : 2
(here, the index of the module!)

N Rack / slot : 0/4
PSstation §7-300 =]~
_ |
| M| | OPCY\CP 2= ce |
== serv Q u |
oT ~_ Node address: PROFIBUS
l address 12
/ ttachment of target
Gateway attachment: station : MPI/PROFIBUS/AUTO
MPI/PROFIBUS/AUTO

S7 subnet ID of target network:
0001 0001

Figure 8-5  Example of Settings with “PC internal”
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8.3.6 Other Ways of Starting Diagnostics

Starting in the properties dialog of the connections:

1. Select the PLC>Activate Connection Status menu command to activate
online access.

2. Select the “Special Diagnostics” button in the “Status Information” tab.

Starting in the hardware configuration tool HW Config:
1. With the S7 station online, select the PLC>»Module Status menu command;

2. Select the “Special Diagnostics” button in the dialog that is opened.

Note

To operate several diagnostic connections at the same time, you can start NCM
S7 Diagnostics more than once.

You can also start NCM S7 Diagnostics twice with an online connection to the
same CP; this can, for example, be useful if you want to monitor the diagnostic
buffer at the same time as running diagnostic functions on a connection.

Requirement: You have an online connection available via the LAN (ISO or
TCP/IP) on the one hand and an online connection via the communication (K) bus
on the other (alternatively via the CPU or via PG channel routing via a further CP).
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8.4 Steps in Diagnostics

Procedure

To use diagnostics efficiently, particularly when working with the diagnostic tool for
the first time, the following procedure can be recommended.

1. Use the sequence shown below as a basis for using diagnostics:

Start NCM S7 Diagnostics:

- Establish the connection to the CP

- Set the options

- Identify the PROFIBUS C (select the “CP Information” diagnostic object)

v
Query the current status of the CP
(select the “operating mode” diagnostic object)
if the CP is not in the ring If the CP is not If the CP is in the RUN mode
(with active in the RUN mode
PROFIBUS nodes)
- PROFIBUS bus parameters
- Statistics functions
- Statistical functions
Stations
Y

Select the mode-specific diagnostic
objects:
- DP master
- DP slave
- FDL connection

- FMS connection (see Volume 2)

Y \

View / evaluate the diagnostic buffer to obtain an overview and detailed explanation of
diagnostic events.

Y

)
Overview of the PROFIBUS !

If necessary, correct configuration or programming. L.

2. Locate the problem, for example, based on the checklist in Section 8.6 the
diagnostic function you require based on the recommendation in the list.
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8.5

Calling Specific Diagnostic Functions

The following table shows the diagnostic options that exist in the available
functions.

Table 8-3 General Diagnostic and Statistical Functions

Diagnostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

CP information

The aim is to identify the CP to which
NCM S7 Diagnostics is connected and
to find out the current mode.

Mode

Here, the aim is to find out the current
operating mode of the PROFIBUS CP as
a module in the S7-300/400 and as a
node on PROFIBUS and, if necessary,
to modify the mode (menu command
Operating Mode > Stop CP/Start CP).

Device-Related
Diagnostics

To display and decode device
(vendor-specific) diagnostic data.

Diagnostic buffer

General Error Diagnostics Using
Diagnostic Buffers:

To display and decode event messages
recorded on the CP in detail. The
diagnostic buffer provides you with
detailed information about all the
communication services of the CP.

Event messages are recorded on the CP
in a ring buffer. The ring buffer can
contain up to 50 entries.

In NCM S7, on the other hand, up to 500
messages can be saved!

All the CP functions can generate event
messages. When you call the diagnostic
object, the messages are read out and
displayed. The latest message is
displayed in the top line with the highest
consecutive number.

If you double-click a previously selected
event message, you display a help text
explaining the message in greater detail.

Stations Overview of the Stations on PROFIBUS
To clarify which active and passive
stations exist on a PROFIBUS subnet
and are detected in the logical ring.
S7-CPs for PROFIBUS Configuring and Commissioning
A-192 Release 09/2011

C79000-G8976-C181-05



8 NCM S7 Diagnostics

Table 8-3 General Diagnostic and Statistical Functions, continued

Diagnostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

Bus Parameters

To display and check all the currently set
bus parameters.

Statistics

Station-Related Statistics:

To evaluate information on how
communication is handled by the
addressed PROFIBUS CP on
PROFIBUS.

Along with the status information the
number of events (counter) since the last
time the PROFIBUS CP was reset and
the number of events detected since the
last update job (difference) are also
displayed.

Table 8-4 Mode-Dependent Functions

Diagnostic Diagnostic Aims Special Features
Functions /

Diagnostic Object

DP Master DP master diagnostics provides the You can display DP master diagnostics

following functions:

¢ Display of the status of the
PROFIBUS CP configured as the DP
master.

* An overview of the DP slaves
attached to the DP master system.

* Slave diagnostics for one of the
attached DP slaves.

by selecting the diagnostic object “DP
Master” in the navigation area.

Select the “DP
Slave Adr. xx”
diagnostic object:

The DP slave diagnostics function is
used to display DP slave diagnostic
data. Depending on the operating mode
of the addressed PROFIBUS CP, this
involves the following:

* Inthe DP master mode, diagnostic
data of the attached DP slaves.

* Inthe DP slave mode, diagnostic
data of the local PROFIBUS CP.

Regardless of the mode, the DP
master belonging to the DP slave
provides additional diagnostic
information that can be used for
more detailed diagnostics.

The DP slave is displayed as follows

depending on the CP mode:

* Inthe DP slave mode: As a separate
diagnostic object at the first hierarchy
level.

* In the DP master mode: As a nested
diagnostic object of the DP master-

Module
Diagnostics.

Query the module states:

To decode the module error statuses in
detail.

Module diagnostics can only be called
when a module of the DP slave has
failed! If there is no module diagnostics,
the entry in the navigation area is shown
in light gray.
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Table 8-4 Mode-Dependent Functions, continued

Diagnostic
Functions /
Diagnostic Object

Diagnostic Aims

Special Features

Connections

Connections »
Type

Connections »
Type »
Type-connection-n

To display and monitor FDL communication connections. You obtain an overview or detailed information
in the contents area depending on the diagnostic object you select.

Overview of All Connection Types
Used

Overview of all the communication
connections of a particular type, for
example all FDL connections;

Information on the connection status

By double-clicking the objects in the
contents area, you can display detailed
information.

Detailed information about the status
of a communication connection.
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8 NCM S7 Diagnostics

8.6 Checklist for ‘Typical Problems‘ in a System

Meaning

The following lists contain several typical problems and their possible causes and
how you can use the NCM S7 diagnostics tool to remedy the situation.

The checklists deal with the following topics:
1. Checklist for General CP Functions

2. Checklist for DP Master Mode

3. Checklist for DP Slave Mode

4. Checklist for FDL Connections

You will find a similar checklist for FMS connections in Volume 2 of this manual.

Note

In the column “Identifying the Cause and Remedy”, you will see the diagnostic
function recommended for dealing with the problem shown in bold face.
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8.6.1

Checklist for General CP Functions

Table 8-5 Checklist for Typical Problems When Operating a CP in a System

Problem

Possible Cause

Identifying the Cause and Remedy

The PROFIBUS CP does
not change to the RUN
mode.

Invalid configuration
loaded on the PROFIBUS
CP.

Yellow STOP LED and red SF LED lit
continuously.

Call up the diagnostic buffer in NCM S7
PROFIBUS Diagnostics.

Example of an entry

Configure DP input data offset (offset=xxx, yy.
module) is not permitted (PROFIBUS address
z2).

Further entry:

CP STOP due to invalid CP parameter
assignment

What to do:
Correct the configuration of the PROFIBUS CP.

There is an active station
with a different
transmission rate or with
different bus parameters
before the PROFIBUS CP
on the bus.

STOP LED lit continuously, green RUN LED
flashing.

Query the operating mode in NCM S7
PROFIBUS diagnostics.

Operating mode: Startup, PROFIBUS status:
Station not in the ring.

What to do:
Correct the transmission rate.

A timeout has occurred in
an NCM online function.

Yellow STOP LED lit continuously. Green
RUN LED flashing.

The PBUS identification run with the S7 CPU
has not been made. The PROFIBUS CP waits
for transfer of the correct MPI parameters by
the S7 CPU.

Physical bus fault, for
example bus short circuit.

Query the operating mode in NCM S7
PROFIBUS diagnostics.

PROFIBUS status: Station not in ring,
Cause: Bus fault

What to do:
Eliminate the bus fault.

Switch set to STOP on the
PROFIBUS CP.

Query the operating mode in NCM S7
PROFIBUS diagnostics.

Operating mode: STOP, cause: Switch set to
STOP

What to do:
Change the switch to RUN on the PROFIBUS
CpP
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8 NCM S7 Diagnostics

8.6.2

Checklist for DP Master Mode

Table 8-6  Checklist for Typical Problems when Operating a DP Master in a System

Problem

Possible Cause

Identifying the Cause and Remedy

The CP does not change
to the DP master mode
(for example bus fault
LED on some or all
stations)

The DP master is not
configured.

Query the operating mode in detail in NCM
S7 PROFIBUS diagnostics.

Status information/DP master mode —> Status:
STOP, cause: Not configured

What to do:
Configure the DP master mode.

Wrong length specified in
the DP SEND call.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status: STOP, cause of DP status: Incorrect
send length in data transfer from PLC.

Call up the diagnostic buffer in NCM S7
PROFIBUS Diagnostics.

Entry “Output data length in the CPU (= xxx
bytes) is less than the total output data length
expected by the DP master (= yyy bytes)
What to do:

The correct length corresponds to the above
parameter yyy —> correct the S7 program.

The CPU is still in the
STOP mode or the blocks
DP-SEND/DP-RECV were
not yet run.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status STOP, cause of DP status no data
transfer from PLC (->no polling mode)

What to do:
Change the CPU to RUN.

DP mode STOP is
requested using the
DP-CTRL block.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status STOP, cause of DP status no polling
mode, status requested by user.

What to do:

Request RUN DP mode using the DP CTRL
function (FC).

DP mode offline
requested using the
DP-CTRL function (FC).

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status Offline, cause of DP status no polling
mode, status requested by user.

What to do:

Request RUN DP mode using the DP CTRL
function (FC).
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8 NCM S7 Diagnostics

Table 8-6  Checklist for Typical Problems when Operating a DP Master in a System

Problem

Possible Cause

Identifying the Cause and Remedy

Slave stations are in the
STOP mode (for example
switch setting on the
ET200U-DP).

PROFIBUS CP is acting
as master class 2 and
reads the input/output
data of the slave stations
cyclically.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status RUN, cause of DP status normal
polling mode (with CPU user data).

Select the corresponding slaves in the slave
list.

Data transfer: No

Call up DP slave diagnostics for the
corresponding slaves in the slave list.
Slave station diagnostics: StationNonExistent

What to do:
Set the DP slave switches to the RUN mode.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status RUN, cause of DP status normal
polling mode (with CPU user data).

Select the corresponding slave in the slave list
Data transfer: No

Call up DP slave diagnostics for the
corresponding slaves in the slave list.
Slave station diagnostics: StationNotReady,
ExtStatusMessage, ParameterRequest,
SlaveDeactivated, StatusFromSlave

What to do:

Switch off the read service and switch on the
normal data transfer;

In other words, change to master 1 mode.

Outputs of the DP slaves
are zero although the user
program requires output
data not equal to zero.

Error reaction
AUTOCLEAR has been
configured and at least
one configured DP slave
is not in the data transfer
phase.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status Clear, cause of DP status at least
one (act.) slave not in the data transfer phase.

Search for the slave(s) in the slave list with data
transfer: No

Call up DP slave diagnostics for the
corresponding slaves in the slave list.
Analyze the DP slave diagnostics.

What to do:

Change the slave that is not in the data transfer
phase to the data transfer phase, for example
by correcting the configuration, RUN switch,
physical connection to the bus etc.
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8 NCM S7 Diagnostics

Table 8-6  Checklist for Typical Problems when Operating a DP Master in a System

Problem

Possible Cause

Identifying the Cause and Remedy

DP mode CLEAR is
requested with the
DP-CTRL block.

Call up DP master diagnostics in NCM S7
PROFIBUS diagnostics.

DP status Clear, cause of DP status polling
mode (data=0), status requested by user.
What to do:

Request RUN DP mode using the DP CTRL
function (FC).

Input data are not arriving
at the required area in the
CPU.

The wrong output data are
output.

The wrong ANY pointer
area was specified for
DP-SEND or DP-RECV.

What to do:
Configure the ANY pointer area according to
the ANY pointer offset.

Although cyclic global
control jobs (SYNC and
FREEZE) were triggered,
only the last job is
processed.

Two separate global
control jobs were sent.

What to do:
Send the global control jobs SYNC and
FREEZE with one global control job.
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8.6.3 Checklist for DP Slave Mode

Table 8-7  Checklist for Typical Problems in the DP Slave Mode

Problem Possible Cause Identifying the Cause and Remedy

No DP data are arriving at | The DP master is not yet | Call up DP slave diagnostics in NCM S7
the slave PROFIBUS CP | in the data transfer phase | PROFIBUS Diagnostics.

from the DP master or the PROFIBUS address of the DP parameter
DP master is not receiving assignment master: None
data from the slave S| tation di tics:
PROFIBUS CP. ave station diagnostics:
StationNotReady
ExtDiagMessage
ParameterRequest

StatusFromSlave

Plain language message “Slave waits for
parameters and configuration from master”.

What to do:
Change the DP master to the data transfer
phase
DP slave mode not Query the operating mode in detail in NCM
configured on the S7 PROFIBUS diagnostics.
PROFIBUS CP. Status Information

DP slave mode->Status: STOP
Cause: not configured

What to do:
Correct the configuration of the PROFIBUS CP,
set mode DP slave active or DP slave passive.

The DP-RECV or Call up DP slave diagnostics in NCM S7
DP-SEND blocks for the PROFIBUS Diagnostics.
PROFIBUS CP as DP PROFIBUS address of the DP parameter
slave have not yet been | assignment master: None
run. . . i
Slave station diagnostics:
StationNotReady
ExtDiagMessage
ParameterRequest

StatusFromSlave

Plain language message “Slave determined
own I/O data length (configuration), At least one
DP block in the CPU is not run through”

What to do:

Call the DP-SEND and DP-RECYV blocks in the
CPU for the PROFIBUS CP as DP slave.
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8 NCM S7 Diagnostics

Table 8-7  Checklist for Typical Problems in the DP Slave Mode

Problem

Possible Cause

Identifying the Cause and Remedy

No DP data are arriving at
the slave PROFIBUS CP
from the DP master or the
DP master is not receiving
data from the slave
PROFIBUS CP.

The I/O length specified in
the slave when DP-SEND
or DP-RECYV is called
does not match the I/O
length configured on the
master.

Call up DP slave diagnostics in NCM S7
PROFIBUS Diagnostics.

PROFIBUS address of the DP parameter
assignment master: None

Slave station diagnostics:
StationNotReady
ExtDiagMessage
ParameterRequest
SlaveConfigCheckFault
StatusFromSlave

Plain language message “Slave waits for
parameters and configuration from master, Data
length changed.

Call up device-related diagnostics entry 02
XXYY

The entry 02 describes a configuration change
(see also Table LEERER MERKER on page
LEERER MERKER).

The entry XX indicates the currently specified
length (hexadecimal) of the DP-SEND for the
PROFIBUS CP as DP slave (corresponds to

the input data length to be configured for this

slave on the DP master).

The entry YY indicates the currently specified
length (hexadecimal) of the DP-RECYV for the
PROFIBUS CP as DP slave (corresponds to
the output data length to be configured for this
slave on the DP master).

There is also a corresponding entry in the
diagnostic buffer: “Configuration accepted.
Receive length: aaa, Send length: bbb” where
aaa and bbb correspond to the parameters xx
and yy above in hexadecimal.

What to do:

Correct the configuration on the DP master or
length for DP-SEND or DP-RECYV of the
PROFIBUS CP acting as DP slave.

The DP master is in the
CLEAR status

or

The error reaction
AUTOCLEAR is
configured on the DP
master and at least one of
the DP slaves configured
on the DP master is not in
the data transfer phase.

Call up DP slave diagnostics in NCM S7
PROFIBUS Diagnostics.

PROFIBUS address of the DP parameter
assignment master: XXX

Slave station diagnostics:
StatusFromSlave

Plain language message “DP master 1 is in the
CLEAR mode”.

What to do:
Change the DP master to the RUN mode and
eliminate the CLEAR mode.
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8 NCM S7 Diagnostics

Table 8-7  Checklist for Typical Problems in the DP Slave Mode

Problem

Possible Cause

Identifying the Cause and Remedy

No DP data are arriving at
the slave PROFIBUS CP
from the DP master or the
DP master is not receiving
data from the slave
PROFIBUS CP.

The DP master is no
longer polling the
PROFIBUS CP as DP
slave —> the watchdog
has expired.

Call up the diagnostic buffer in NCM S7
PROFIBUS Diagnostics.

The following entry is made in the diagnostic
buffer: “Timeout occurred. Watchdog time set
on slave: xxx * 10 msec”

The Factor XXX is configured on the DP master
and when multiplied by 10 msec produces the
watchdog time in ms.

What to do:

Change the DP master back to RUN or correct
the watchdog time in the configuration of the
DP master.

The DP master has
released the PROFIBUS
CP for other masters (for
example change to the
OFFLINE mode).

Call up the diagnostic buffer in NCM S7
PROFIBUS Diagnostics.

The following entry is made in the diagnostic
buffer: “Master (addr XXX) releases the slave
for other masters. Status byte of the parameter
assignment frame: YYY”

The entry XXX corresponds to the address of
the DP master that released the PROFIBUS CP
as DP slave. The entry YYY corresponds to the
first byte of the parameter assignment frame
(for example 64 dec. means UNLOCK)

What to do:
Change the DP master back to the RUN mode
or start data transfer with a different master.
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8 NCM S7 Diagnostics

Table 8-7  Checklist for Typical Problems in the DP Slave Mode

Problem

Possible Cause

Identifying the Cause and Remedy

No DP data are arriving at
the slave PROFIBUS CP
from the DP master or the
DP master is not receiving
data from the slave
PROFIBUS CP.

The CPU is still in the
STOP mode, the blocks
DP-SEND / DP-RECV
have not yet been run.

Call up DP slave diagnostics in NCM S7
PROFIBUS Diagnostics.

PROFIBUS address of the DP parameter
assignment master: None

Slave station diagnostics:
StationNotReady
ExtStatusMessage
ParameterRequest
StatusFromSlave

Plain language message “Slave determined
own I/O data length (configuration), CPU is in
the STOP mode”

Call up device-related diagnostics entry 04
The entry 04 indicates that the CPU is in the
STOP mode (see also Table

LEERER MERKER on page

LEERER MERKER).

What to do:
Change the CPU to the RUN mode.

The PROFIBUS CP as DP
slave is in the “switch
stop” status.

or

The PROFIBUS CP as DP
slave was stopped by
NCM S7 PROFIBUS or
NCM S7 PROFIBUS
Diagnostics.

Call up operating mode in NCM S7
PROFIBUS Diagnostics.

Operating mode: STOP
Cause: switch set to STOP
or

Cause: PG command STOP

What to do:

Change the PROFIBUS CP to the RUN mode
with the switch, or in NCM S7 PROFIBUS or
NCM S7 PROFIBUS Diagnostics.

S7-CPs for PROFIBUS Configuring and Commissioning

Release 09/2011
C79000-G8976-C181-05

A-203




8 NCM S7 Diagnostics

8.6.4

Checklist for FDL Connections

Table 8-8  Checklist for Typical Problems with FDL Connections

Problem

Possible Cause

Identifying the Cause and Remedy

No data transfer on an
FDL connection or only in
one direction.

AG-SEND and AG-RECV
are not called in the user
program.

or

Receive or send buffer too
small or incorrect.

Check the user program.

Evaluate status bytes in AG-SEND and
AG-RECV.

What to do:
If necessary, configure FC blocks.
If necessary, correct ANY pointer.

The LSAP assignment is
wrong.

Evaluate status bytes of the FC blocks or
evaluate diagnostic buffer.

What to do:
Change the SAPs according to the diagnostic
buffer entries.

PROFIBUS destination
address not obtainable.

Select PROFIBUS station overview.

Evaluate diagnostic buffer and check the
PROFIBUS addresses of the PROFIBUS
stations.

What to do:
Enter the correct destination address.

Jobs with a job header:
error in the job header of
AG_SEND.

The interface of AG_SEND signals “System
error”

The diagnostic buffer signals “Invalid
parameter”

What to do:

Check and correct the parameter in the job
header.

Data transfer too slow

Receiving device too slow

Evaluate diagnostic buffer.
Entry: “No receive resources on destination
station XX".

What to do:
Delay the send trigger or check the destination
station and optimize reception.

The complete data field is
not sent on an FDL
connection.

LEN parameter for
AG-SEND is set to the
wrong value.

What to do:
Set the LEN parameter to the required size.

For jobs with a job header, the parameter LEN
must include the job header and the user data.

The complete data field is
not sent on an FDL
connection.

The buffer specified with
the ANY pointer is too
small.

What to do:
Correct the LEN parameter and the ANY
pointer. ]
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9 Firmware Loader

This chapter will familiarize you with the uses and handling of the Firmware
Loader.

The firmware loader allows you to download more recent firmware versions to the
SIMATIC NET modules.

You will find more detailed information on the different loading variants in the
integrated onlne help.

S7-CPs for PROFIBUS Configuring and Commissioning
Release 09/2011 A-205

C79000-G8976-C181-05



9 Firmware Loader

9.1 Application

Firmware
Here, firmware means the system programs in the SIMATIC NET modules.

Uses of the Firmware Loader

The firmware loader allows you to download more recent firmware versions to the
SIMATIC NET modules. It is used on the following:

« PROFIBUS modules
¢ [ndustrial Ethernet modules

¢ Modules for gateways (for example, IE/PB Link)

Installation
The firmware loader is available when you have installed STEP 7 on your PG/PC.

Load Files
The firmware loader supports the following file types:
o <file>.FWL

A file form that that in addition to the actual firmware contains extra information
that is displayed by the firmware loader. Based on this information, the firmware
loader can check that the firmware is compatible with the device.

For detailed information, read the documentation, for example, the README file
shipped with the load file.

This information is displayed even after reading in the FWL file into the firmware
loader.

Working with the Firmware Loader

Depending on the module type, the downloading is prepared and executed in three
or four steps.

For more detailed information, refer to the next section and the dialog boxes
themselves.

This information is also displayed after reading in the FWL file into the firmware
loader.
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9 Firmware Loader

9.2 Loading Firmware

Loadable Firmware

The PROFIBUS CP supports updating of the firmware by the firmware loader. To
allow this, the CP remains in the "waiting for firmware update” state for 10 seconds
following power up when you keep the mode selector held on STOP at the same
time.

Following a firmware update, the rack must be turned off and on again before
normal operation is possible!

Starting the Download

Open the Windows Start menu and select the menu command SIMATIC » STEP 7
» NCM S7 Industrial Ethernet » Firmware Loader.

B SIMATIC NET Firmware - Lader M= B3

Der SIMATIC MET Firrware - Lader dient dazu die Firrmware von
SIMATIC MET CPs zu laden.

Daz Laden einer neuen Firmware izt nobwendig, wenn die Funktionalitat
der Firmware enweitert oder Fehler bezeitigt wurden. Um festzustellen ob
ein Update der Firmware notwendig ist, wenden Sie sich an lhre
SIEMEMS Miederlaszung

Um die Firmware zu laden, folgen Sie den nachfolgenden Schritten und
beachten Sie die Hinweize der Liesmich Datei.

czutick [{TWeETl Leden | Abbrechen | Hite |

Select the Next button and follow the instructions displayed in the dialog.

ij Caution
Make sure that the load file you are using is intended as an update for the version
of the firmware contained on your module. If you are in any doubt, contact your
local Siemens advisor.
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9 Firmware Loader

ij Caution
Remember that interrupting the download can lead to an inconsistent state on the
module!

Read the description of the relevant device in Part B of this manual

Further information

e For more detailed information on the various load options, refer to the
integrated help.

¢ You will find special features of loading described in the relevant device manual
13/

4
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A Pinout

A Pinout

Pinout - 9-Pin Sub-D Female Connector (PROFIBUS)

S7-CPs for PROFIBUS Configuring and Commissioning

Release 09/2011

Pin No. Signal Name PROFIBUS Used by
Designation | SIMATIC NET CPs
1 PE Protective earth yes
2 - - -
3 RxD/TxD-P Data line B yes
4 RTS (AG) Control-A -
5 M5V2 Data reference yes
potential
6 P5V2 Power supply yes
plus
BATT - -
RxD/TxD-N Data line-A yes

C79000-G8976-C181-05
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

B Standards, certificates and approvals of
SIMATIC NET S7-CPs

The approvals listed in this chapter apply to the following modules.

Notice

You will find the valid approvals on the type plate of the relevant product.

Product description:

CP 342-5

CP 342-5 FO

CP 343-5

CP 443-5 Basic

CP 443-5 Extended

Order no.:
Order no.:
Order no.:
Order no.:

Order no.:

6GK7 342-5DA03-0XEO0
6GK7 342-5DF00-0XEO
6GK7 343-5FA01-0XEO
6GK7 443-5FX02-0XEOQ
6GK7 443-5FDX04-0XEO

Note

You can find the current valid certificates and approvals on the type plate of the
respective product.

IEC 61131-2

The SIMATIC NET S7-CPs mentioned above fulfill the requirements and criteria of
IEC 61131-2 (programmable logic controllers, Part 2: equipment requirements and
tests).

CE Mark of Conformity

The SIMATIC NET S7-CPs mentioned above meet the requirements and
orotection objectives of the following EC directives and comply with the
harmonized European Standards (EN) for programmable logic controllers
published in the Official Gazettes of the European Community:

A-210

89/336/EEC “Electromagnetic Compatibility“ (EMC Directive)

94/9/EG ,Equipment and protective systems intended for use in potentially
explosive atmospheres® (Guidelines for Explosion Protection)
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

In accordance with EC directives the EC declarations of conformity are kept
available for the responsible authorities at the following address:

e Siemens Aktiengesellschaft
Industry Automation

Industrielle Kommunikation SIMATIC NET
Postfach 4848

D-90327 NurnbergGermany

The EC Declaration of Conformity is also available on the Internet at the following

address:

® http://support.automation.siemens.com/WW/view/en/16689636

EMC Directive

The SIMATIC NET S7-CPs mentioned above are designed for use in industrial

areas.

Area of application

Requirement for

Emitted interference

Interference immunity

Industry

EN 61000-6—4 : 2001

EN 61000-6-2 : 2001

Explosion protection directive

Complying with EN 60079 (Electrical apparatus for potentially explosive
atmospheres; Type of protection ,n)

EN 60079-15:2005, EN 60079-0:2006
13GExnAIlT3..T6

KEMA 07 ATEX 0145X

KEMA 03 ATEX 1229X

KEMA 03 ATEX 1228X

KEMA 03 ATEX 1125X

ii Warning

Requirements for the cabinet/enclosure

When used in hazardous environments corresponding to Class I, Division 2 or
Class |, Zone 2, the device must be installed in a cabinet or a suitable enclosure.

To comply with EU Directive 94/9 (ATEX95), this enclosure must meet the
requirements of at least IP54 in compliance with EN 60529.
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

ii Warning
Suitable cables for temperatures in excess of 70 °C

If the cable or conduit entry point exceeds 70°C or the branching point of
conductors exceeds 80°C, special precautions must be taken.

If the equipment is operated in an air ambient in excess of 50°C, only use cables
with admitted maximum operating temperature of at least 80 °C.

ii Warning
Protection against transient voltage surges

Provisions shall be made to prevent the rated voltage from being exceeded by
transient voltage surges of more than 40%. This criterion is fulfilled, if supplies are
derived from SELV (Safety Extra—Low Voltage) only.

Notice

When using (installing) SIMATIC NET products in hazardous area zone 2, make
absolutely sure that the associated conditions are adhered to!

You will find these conditions here:
¢ In the SIMATIC NET Manual Collection under

All Documents > “Approval of SIMATIC/SIMATIC NET Products for Direct
Installation in Ex-Zone 2”

You will find details of the SIMATIC products here:
¢ On the Internet at the address

http://support.automation.siemens.com/WW/view/en/13702947

Machinery Directive

The product continues to be a component according to article 4(2) of the EC
Machinery Directive 89/392/EEC.

In accordance with the Machinery Directive, we are obliged to indicate that the
described product is intended exclusively for installation in a machine. Before the
finished product is commissioned, it is important to ensure that it conforms with the
Directive 89/392EEC.
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

Adherence to Assembly Directives

The product meets the requirements if the assembly directives contained in this
technical manual and in the documentation LEERER MERKER are adhered to
during installation and operation.

ii Warning
Personal injury and material damage may be incurred.

The installation of expansions, which are not approved for SIMATIC S7-CPs or
their target systems, can violate the requirements and regulations for safety and
electromagnetic compatability.

Only use expansions that are approved for the system.

Note for Australia

The SIMATIC NET S7-CPs mentioned above fulfill the requirements of AS/NZS
2064 (Class A).

Note for Canada

This digital device Class A fulfills the requirements of the Canadian standard,
ICES-0083.

AVIS CANADIEN

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du
Canada.

UL and CSA Recognition

Note

You can find which of the following UL/CSA or cULus approvals was accorded to
your product from the inscriptions on the type plate.

UL Recognition
UL-Recognition-Mark Underwriters Laboratories (UL) in accordance with UL 508:
UL e Report E 85972

®
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

CSA Certification

CSA-Certification-Mark Canadian Standard Association (CSA) in accordance with
s ® C22.2No. 142

¢ Certification Record 063533—-C-000

cULus Approval, Hazardous Location

CULUS Listed 7RA9 IND. CONT. EQ. FOR HAZ. LOC.

CI.IS Underwriters Laboratories Inc. in accordance with

HAZ. LOC. * UL 508 (Industrial Control Equipment)

e CSA C22.2 No. 142 (Process Control Equipment)

e UL 1604 (Hazardous Location)

e« CSA-213 (Hazardous Location)

APPROVED for use in

e Class 1, Division 2, Group A, B, C, D T4A

e Class 1, Zone 2, Group IIC T4
e Class 1, Zone 2, AExnC IIC T4

Please note the following:

Note

The system must be installed in accordance with the specifications of the NEC
(National Electrical Code).

If you use the SIMATIC NET S7-CPs in environments that correspond to Class I,
Division 2 (see above), they must be installed in a housing that corresponds at
least to IP54 in accordance with EN 60529.

FM Approval

Factory Mutual Approval Standard Class Number 3611,
Class I, Division 2, Group A, B, C, D, T3...T6 or
Class I, Zone 2, Group IIC, T3...T6.

APPROVED

Refer to the type plate on the module for the temperature class.
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B Standards, certificates and approvals of SIMATIC NET S7-CPs

Warning
Personal injury and material damage may be incurred.

In potentially explosive atmospheres personal injury and material damage may be
incurred if an electrical circuit is connected or disconnected during operation of a
SIMATIC NET S7-CP (e.g. in the case of plug connections, fuses, switches).

Do not connect or disconnect live current circuits, unless it is certain that danger of
explosion has been excluded.

WARNING - EXPLOSION HAZARD: DO NOT DISCONNECT EQUIPMENT
WHEN A FLAMMABLE OR COMBUSTIBLE ATMOSPHERE IS PRESENT.

If you use SIMATIC NET S7-CPs under FM conditions, they must be installed in a
housing that corresponds at least to IP54 in accordance with EN 60529.

Warning
Risk of explosion when connecting or disconnecting the device
EXPLOSION HAZARD

DO NOT CONNECT OR DISCONNECT EQUIPMENT WHEN A FLAMMABLE
OR COMBUSTIBLE ATMOSPHERE IS PRESENT
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C References and Literature

Locating Siemens literature

s

The order numbers for Siemens documentation can be found in the catalogs
"SIMATIC NET Industrial Communication, catalog IK PI” and "SIMATIC Products
for Totally Integrated Automation and Micro Automation, catalog ST 70”.

You can obtain these catalogs and any further information you require from your
local SIEMENS office or national head office.

Some of the documents listed here are also in the SIMATIC NET Manual
Collection supplied with every S7 CP.

Many SIMATIC NET manuals are available on the Internet pages of Siemens
Customer Support for Automation:

http://support.automation.siemens.com/WW/view/en

Enter the ID of the relevant manual as a search key. The ID is shown below the
literature name in brackets.

Manuals that are installed with the online documentation of the STEP 7 installation
on your PG/PC, can be selected from the Start menu (Start > SIMATIC >
Documentation).

You fill find an overview of the SIMATIC documentation at:

http://support.automation.siemens.com/WW/view/en/10805878

Manuals and Further Information

n/

and

A-216

The following sources contain information on project engineering and operation:

For installation and commissioning of the CP

Automation system S7-300

- CPU 31xC and 31x Installation (ID: 13008499)
— Module data: reference manual (ID: 8859629)
Siemens AG

http://support.automation.siemens.com/WW/view/en/13008499

http://support.automation.siemens.com/WW/view/en/8859629
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SIMATIC S7

Automation system S7-400, M7-400

- Installation (ID: 1117849)

— Module data: reference manual (ID: 1117740)
Siemens AG

http://support.automation.siemens.com/WW/view/en/1117849

http://support.automation.siemens.com/WW/view/en/1117740

12/ On using and configuring the CP
Manual
S7 CPs for PROFIBUS - Configuring and Commissioning
Part of the online documentation of STEP 7
Siemens AG

http://support.automation.siemens.com/WW/view/en/1158693

13/ On using and commissioning the PROFIBUS-CP
Manual
S7 CPs for PROFIBUS
(SIMATIC NET Manual Collection)
Siemens AG

CP 342-5/342-5 FO:

http://support.automation.siemens.com/WW/view/en/8773570

CP 343-5:
http://support.automation.siemens.com/WW/view/en/8778841

CP 443-5 Basic:
http://support.automation.siemens.com/WW/view/en/8776422

CP 443-5 Extended:
http://support.automation.siemens.com/WW/view/en/8777196

14/ On using and configuring the CP with FMS services
Manual SIMATIC NET NCM S7 for PROFIBUS,
Volume 2
Part of the online documentation of STEP 7
Siemens AG

http://support.automation.siemens.com/WW/view/en¥158418

/5/ On using and configuring the CP
NCM S7 for SIMATIC NET CPs “Primer”
Part of the online documentation of STEP 7
Siemens AG

http://support.automation.siemens.com/WW/view/en/1157760
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6/ On programming the communications FCs and FBs
Functions (FC) and Function Blocks (FBs) for SIMATIC NET S7 CPs
Programming manual
Part of the onlne documentation of STEP 7
Siemens AG

http://support.automation.siemens.com/WW/view/en30564821

17/ SIMATIC NET , Instructions
Commissioning PC Stations
Part of the online documentation of STEP 7
Siemens AG

http://support.automation.siemens.com/WW/view/en/13542666

/8/ For installing and operating a SIMATIC NET PROFIBUS network
Industrial Communications Networks PROFIBUS Networks Manual
Siemens AG

19/ SIMATIC Configuring Hardware and Connections with STEP 7

Part of the STEP 7 documentation package STEP 7 Basic Knowledge
Part of the online documentation of STEP 7
Siemens AG

10/ SIMATIC - Programming with STEP 7
Part of the STEP 7 documentation package STEP 7 Basic Knowledge
Part of the online documentation of STEP 7
Siemens AG

A1/ SIMATIC STEP 7 reference manuals with manuals for
- LAD/CSF/STL
- System software for S7-300/400 System and Standard Functions
Part of the online documentation of STEP 7
Siemens AG

12/ On the topic of PROFIBUS:
SIMATIC NET Manual for PROFIBUS Networks
Release 02
Siemens AG

/13/ On the topic of PROFIBUS:
Decentralizing with PROFIBUS-DP
Structure, configuration and use of PROFIBUS DP with SIMATIC S7
Weigmann, J.; Kilian, G. / Publicis—-MCD-Verlag
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14/ PROFIBUS Standard EN 50170, Vol 2
Beuth Verlag, Berlin

15/ On the topic of PROFIBUS:
PROFIBUS-DP/DPV1
The new rapid way to Profibus DP
Popp, M.

/16/ On the topic of CiR:
Function Manual
SIMATIC Modifying the System during Operation via CiR
Siemens AG

nz7/ On the topic of programming:
Automation with STEP 7 in STL and SCL
User Manual, Programming Manual
Berger, H. / Publicis-MCD-Verlag, 2001

On using and configuring PROFINET CBA

/18/ On project engineering of PROFINET CBA components and systems:
Basic help in the SIMATIC iMap engineering tool
Siemens AG

/19/ On project engineering of PROFINET CBA components and systems:
Component based Automation — Configuring Plants with SIMATIC iMap
Manual
Siemens AG

On using and configuring PROFINET IO

/20/ SIMATIC
PROFINET System Description
System manual
Siemens AG
(part of the manual collection)

21/ SIMATIC
From PROFIBUS DP to PROFINET IO
Programming manual
Siemens AG
(part of the manual collection)
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Order Numbers

The order numbers for the SIEMENS documentation listed above can be found in the catalogs
“SIMATIC NET Industrial Communication, Catalog IK PI” and “SIMATIC Programmable Controllers
SIMATIC S7 /M7 [ C7”.

You can obtain these catalogs, further information you require and offers for courses from your local
SIEMENS office or national head office.
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D Document History

This section provides an overview of the previous releases of this manual and the
functional expansions in STEP 7 and NCM S7.

New in release 04 / as of STEP7 V5.4 (C79000-G8976-C181-04)

In this release of the manual, the manuals for the S7 CPs for PROFIBUS were
restructured:

¢ Removal and transfer of the block descriptions to the new manual “Functions
(FC) and Function Blocks (FB) for SIMATIC NET S7 CPs - programming
manual

e The printed version of the manuals is no longer available.

References to entries on the Internet were updated where necessary.

New in release 02 / as of STEP7 V5.3 (C79000-G8976-C181-02)
» Printed Version Release 06/2005

The descriptions of the following modules have been updated in Part B of this
manual:

- CP342-5
— CP 443-5 Extended

New in release 01 / as of STEP7 V5.3 (C79000-G8976-C181-01)

¢ New structure of the manual

In this release we have put together the previously separate manuals NCM S7
and S7 CPs in one manual.

This also takes into account that the NCM S7 configuration tool is no longer
installed separately for PROFIBUS and Industrial Ethernet. The functions of
NCM S7 are now installed automatically when STEP 7 is installed.
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New in release 05 / as of STEP7 V5.2 (C79000-G8976-C127-05)

Note

This is the last release before the two manuals “NCM S7 for PROFIBUS” and
“Device Manual S7-CPs for PROFIBUS” were merged into this manual.

This version of the manual includes information relating to new functions in STEP 7
and NCM S7 as of V5.2.

In the main, this involves the following topics:

e S7 communication over routers (single-ended client and server functionality) via
an IE/PB Link or CP (see Section 1.4)

e Multiprojects

With the new multiproject functionality, projects can be split up and distributed
for engineering and then merged again.

New in Release 04 / valid up to STEP 7 V5.1
The changes mainly involved the DP functionality of the PROFIBUS CPs.

\ 1, Since this functionality differs in some aspects from CP to CP, alternative features
-: "~ of newer modules were highlighted by this symbol throughout this release of the
*~ manual. Where this symbol appears, you should check the manual of your specific
PROFIBUS CP for further information (the symbol is also used there). You will also
find the symbol in the online help of STEP 7.

New in Release 03 / valid up to STEP 7 V5.0 SP3
* NCM S7 Diagnostics has a completely revised user interface. See Chapter 8

The description of NCM S7 Diagnostics has been restructured. While this
manual provides you with an overview and checklists, the online help provides
you with detailed information on the diagnostic events.

e There is additional information on the DP master mode in Section 4.9 Reading
Input/Output Data as a DP Master (Class 2) and in Section 4.10
Activating/Deactivating DP Slaves.
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Address parameters, A-165
broadcast, A-167
multicast, A-168
specified FDL connection, A-165
unspecified FDL connection, A-166

Bit time, A-63

Blocks, FC/FB, A-50

Broadcast, A-28, A-150, A-154

Bus parameters, A-63
calculation, A-63

Cc

Certification
CSA, A-214
UL, A-213
CLEAR, A-135
Combimaster, A-34
Commissioning, A-55
Configuration table master system, A-95,
A-137
Connection
FDL, A-76
S7 homogeneous, A-76
Consistency, A-131
CP
mode, A-68
moving, A-78
CPU cycle, A-88, A-131
in DP master mode, A-104
with FDL connections, A-176
CSA, Certification, A-214

D

Diagnostics, A-72

Download, A-77

DP cycle, A-88, A-131

DP data area, A-91
in the DP slave mode, A-131
total size, A-91

DP diagnostic list, A-120

DP diagnostics, A-112
in the user program, A-114
options, A-113

DP input area, A-91

DP master (class 2), reading input/output data,

A-110
DP master mode
data exchange, A-87
including in the user program, A-81
overview, A-85
synchronization of the data input, A-97,
A-99
DP mode, changing, A-107
DP monomaster, overview, A-32
DP multimaster, overview, A-33
DP output area, A-91
DP single diagnostics, A-122
DP slave, A-97
assigning the I/O address, A-94
configuration, A-133
parameter assignment, A-133
DP slave mode, A-126
configuration on the DP master, A-142
configuring, A-136
data exchange, A-130
data transfer, A-133
initialization, A-133
Overview, A-35
overview, A-128
programming, A-143
DP state, A-89
DP station list, A-117
DP status byte, A-114
DP/FMS mixed mode, A-34
DPSTATUS, A-144

E
ET 200, A-31

F

FDL connection, A-146
address parameters, A-162
characteristics, A-150
data exchange, A-173
free layer 2 access, A-153
overview, A-18, A-28
programming, A-174
specified, A-152
to SIMATIC S5, A-158
unspecified, A-150, A-153
with broadcast, A-150, A-154
with multicast, A-150, A-156
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FDL connection
unspecified, A-173
with broadcast, A-173
with multicast, A-173
FDL connections, data and connections,
A-150
Firmware, loading, A-207
Firmware Loader, A-205
application, A-206
loading firmware, A-207
FM, Approval, A-214
FMS master, A-34
Free layer 2 access, A-153
FREEZE, A-99, A-135
Functions
AG-RECV, A-173, A-174
AG-SEND, A-173, A-174
DP_CTRL, A-104
DP_DIAG, A-104
DP_RECV, A-104, A-143
DP_SEND, A-104, A-143
Functions (FCs)
DP-RECV, A-130
DP-SEND, A-130
DP-RECV, A-87
DP-SEND, A-87

G

Global control
FREEZE / UNFREEZE, A-97
in the slave mode of the PROFIBUS CP,
A-135
SYNC / UNSYNC, A-97

H

Hardware configuration, A-64
HSA, A-62

I/O device, A-31
Industrial Ethernet; user interface to, A-24
ISO transport connection
printing configured connections, A-170
save connection, A-170

A-224

J

Job buffer, A-153, A-154, A-156, A-173
Job header, A-153, A-154, A-156, A-173

Mode, DP, A-31
Multicast, A-28, A-150, A-156, A-168
Multicomputing, A-50
Multimaster mode. See DP/FMS mixed mode
Multiproject, A-36, A-41
configuring connections, A-148, A-161,
A-164

N

NCM S7 Diagnostics, A-178
procedure, A-191
NCM S7 diagnostics, overview, A-179
NCM S7 Diagnostics online path
examples of an online path with gateway,
A-187
Examples of an online path without
gateway, A-186
NCM S7 diagnostics online path, examples of
an online path with "PC internal”, A-189
NetPro, A-158
Network properties, A-61
Networking, A-36
with Netpro, A-36
with SIMATIC Manager, A-36
New connection, A-158
Node initialization, A-77
Non-SIMATIC devices, A-39

(o)

Order numbers, A-210
Other station, A-160

P

Parallel Operation of SIMATIC NET CPs
S7-300, A-50
S7-400, A-52

PC applications, A-24
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PC internal, A-189
PG communication

in configured mode, A-22

in PG operation, A-22

with STEP 7 on PROFIBUS, A-22
Pinout, A-209
Print, configuration, A-170
PROFIBUS CP. See CP
PROFIBUS; user interface to, A-24
PROFIBUS-DP, A-53
PROFIBUS/PROFIBUS FO, Overview, A-17
Profile, A-62

S

S7 communication, A-24

over router, A-27
S7 connection, A-51, A-53
SEND/RECEIVE interface, overview, A-28
Services, A-19
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SIMATIC S5, A-24, A-28, A-30, A-34, A-35,
A-39
FDL connection to, A-158
Slots, A-50, A-52
STEP 7, general information, A-56
Subnet
creating, A-58
displaying attachments, A-66
SYNC, A-97, A-135
Synchronization. See DP master mode

T

TD/OP, A-23
Token bus, A-17
Transmission rate, A-61, A-62

U
UL, Recognition, A-213
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